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1  Welcome to the IEEE 802.15.4 options
The R&S SMM-K149 is a firmware application that adds functionality to generate sig-
nals in accordance with the IEEE Standard for Low-Rate Wireless Networks IEEE Std
802.15.4™-2020 and IEEE Std 802.15.4z™‐2020.

The R&S SMM-K180, R&S SMM-K181 and R&S SMM-K182 add functionality in
accordance with the P802.15.4™ab/D02 standard.

This user manual contains a description of the functionality that the application pro-
vides, including remote control operation.

All functions not discussed in this manual are the same as in the base unit and are
described in the R&S SMM100A user manual. The latest version is available at:

www.rohde-schwarz.com/manual/SMM100A

Installation

You can find detailed installation instructions in the delivery of the option or in the
R&S SMM100A service manual.

● Key features..............................................................................................................7
● Accessing the IEEE 802.15.4 dialog.........................................................................8
● What's new................................................................................................................8
● Documentation overview...........................................................................................8
● Scope...................................................................................................................... 11
● Notes on screenshots..............................................................................................11

1.1  Key features

R&S SMM-K149 HRP UWB

● HRP UWB 802.15.4 signal generation compliant with HRP non-ERDEV mode
● HRP UWB 802.15.4z signal generation compliant with HRP-ERDEV base pulse

repetition frequency (BPRF) mode
● HRP UWB 802.15.4z signal generation compliant with HRP-ERDEV higher pulse

repetition frequency (HPRF) mode

R&S SMM-K180 IEEE 802.15.4 OQPSK

● 802.15.4 signal generation compliant with narrowband O-QPSK modulation mode

R&S SMM-K181 HRP UWB MMS

● HRP UWB 802.15.4ab signal generation compliant with HRP-ARDEV multi-milli-
second ranging (MMS) mode

● HRP UWB 802.15.4ab signal generation compliant with HRP-EMDEV enhanced
modulation and HRP-LLDDEV low latency data (EM+LLD) mode

Key features

https://www.rohde-schwarz.com/manual/smm100a
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R&S SMM-K182 HRP UWB SENSING

● HRP UWB 802.15.4ab signal generation compliant with HRP-SDEV sensing
(SENSING) mode

1.2  Accessing the IEEE 802.15.4 dialog

To open the dialog with IEEE 802.15.4 settings

► In the block diagram of the R&S SMM100A, select "Baseband > IEEE 802.15.4".

A dialog box opens that displays the provided general settings.

The signal generation is not started immediately. To start signal generation with the
default settings, select "State > On".

1.3  What's new

This manual describes firmware version FW 5.50.042.xy and later of the
R&S®SMM100A.

Compared to the previous version, it provides the new features listed below:
● Added 802.15.4 modes:

– Multi-millisecond ranging, see Section 5, "MMS ranging configuration settings",
on page 78.

– Sensing, see Section 4.4, "Sensing", on page 62.
– Enhanced modulation and low latency, see Section 4.3, "Enhanced modulation

and low latency", on page 50.
● Added configuration index for SFD pattern for 802.15.4 O-QPSK signal generation,

see Section 4.2.1, "SYNC settings", on page 42.
● Editorial changes

1.4  Documentation overview

This section provides an overview of the R&S SMM100A user documentation. Unless
specified otherwise, you find the documents at:

www.rohde-schwarz.com/manual/smm100a

Documentation overview

https://www.rohde-schwarz.com/manual/smm100a
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1.4.1  Getting started manual

Introduces the R&S SMM100A and describes how to set up and start working with the
product. Includes basic operations, typical measurement examples, and general infor-
mation, e.g. safety instructions, etc. A printed version is delivered with the instrument.

1.4.2  User manuals and help

Separate manuals for the base unit and the software options are provided for down-
load:
● Base unit manual

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.

● Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S SMM100A is not included.

The contents of the user manuals are available as help in the R&S SMM100A. The
help offers quick, context-sensitive access to the complete information for the base unit
and the software options.

All user manuals are also available for download or for immediate display on the inter-
net.

1.4.3  Service manual

Describes the performance test for checking compliance with rated specifications, firm-
ware update, troubleshooting, adjustments, installing options and maintenance.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

https://gloris.rohde-schwarz.com

1.4.4  Instrument security procedures

Deals with security issues when working with the R&S SMM100A in secure areas. It is
available for download on the internet.

1.4.5  Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

Documentation overview

https://gloris.rohde-schwarz.com
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1.4.6  Specifications and product brochures

The specifications document, also known as the data sheet, contains the technical
specifications of the R&S SMM100A. It also lists the firmware applications and their
order numbers, and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/smm100a

1.4.7  Calibration certificate

The document is available on https://gloris.rohde-schwarz.com/calcert. You need the
device ID of your instrument, which you can find on a label on the rear panel.

1.4.8  Release notes and open source acknowledgment

The release notes list new features, improvements and known issues of the current
software version, and describe the software installation.

The software uses several valuable open source software packages. An open source
acknowledgment document provides verbatim license texts of the used open source
software.

www.rohde-schwarz.com/firmware/smm100a

1.4.9  Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

For some application sheets, see also:

www.rohde-schwarz.com/application/smm100a

1.4.10  Videos

Find various videos on Rohde & Schwarz products and test and measurement topics
on YouTube: https://www.youtube.com/@Rohde-Schwarz

Documentation overview

https://www.rohde-schwarz.com/brochure-datasheet/smm100a
https://gloris.rohde-schwarz.com/calcert
https://www.rohde-schwarz.com/firmware/smm100a
https://www.rohde-schwarz.com/application/smm100a
https://www.youtube.com/@Rohde-Schwarz
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1.5  Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, it includes:
● Managing settings and data lists, like saving and loading settings, creating and

accessing data lists, or accessing files in a particular directory.
● Information on regular trigger, marker and clock signals and filter settings, if appro-

priate.
● General instrument configuration, such as checking the system configuration, con-

figuring networks and remote operation
● Using the common status registers

For a description of such tasks, see the R&S SMM100A user manual.

1.6  Notes on screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as many as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic usage scenarios.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

Notes on screenshots
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2  About the IEEE 802.15.4 options

2.1  Required options

The equipment layout for generating HRP UWB signals includes:
● Base unit
● Baseband Generator (R&S SMM-B9)
● Baseband real-time extension (R&S SMM-K520)
● Option HRP UWB (R&S SMM-K149)
● Option IEEE 802.15.4 OQPSK (R&S SMM-K180)
● Option HRP UWB MMS (R&S SMM-K181)
● Option HRP UWB SENSING (R&S SMM-K182)
● Option baseband extension to 240 MHz RF bandwidth (R&S SMM-K523)
● Option baseband extension to 500 MHz RF bandwidth (R&S SMM-K524)
● Option baseband extension to 1 GHz RF bandwidth (R&S SMM-K525)

You can generate signals via playback of waveform files at the signal generator. To cre-
ate the waveform file with R&S WinIQSIM2, you do not need a specific option.

To play back the waveform file at the signal generator, you have two options:
● Install the R&S WinIQSIM2 option of the digital standard, for example, R&S SMM-

K255 for playing LTE waveforms.
● If supported, install the real-time option of the digital standard, for example,

R&S SMM-K55 for playing LTE waveforms.

For more information, refer to the specifications document.

2.2  About HRP UWB

Option: R&S SMM-K149

HRP UWB PHY signals employ short, band-limited pulses sent at high rate pulse repe-
tition frequencies (HRP).

2.2.1  Frame structure

An HRP UWB PHY frame consists of a preamble part that contains the synchronization
header (SHR) and a data part that contains a PHY header (PHR) and a PHY payload.
The SHR in the preamble comprises the synchronization (SYNC) field and a start-of-
frame delimiter (SFD) field. The PHY payload is filled by the MAC layer with the PHY
service data unit (PSDU).

About HRP UWB
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SHR PHR PHY payload

SYNC SFD

Preamble

PHY protocol data unit (PPDU)

Data

Figure 2-1: HRP UWB PHY frame structure

HRP-ERDEV

IEEE Std 802.15.4z‐2020 introduced optional modes and a ciphered scramble time
stamp (STS) sequence into the PHY to improve timestamp robustness and security
and to increase the accuracy of ranging measurements.

A device incorporating these modes is referred to as a higher rate pulse repetition fre-
quency UWB PHY based enhanced ranging capable device (HRP-ERDEV) and
defined in IEEE Std 802.15.4z‐2020, section 15.1, "General".

Operation at the nominal 64 MHz pulse repetition frequency (PRF) is referred to as the
base pulse repetition frequency (BPRF) mode. Operation at a higher PRF than the
BPRF mode, is referred to as the higher pulse repetition frequency (HPRF) mode.

The frame structure of HRP-ERDEV is shown in the following figure, with the STS in
different positions. The arrow shows the RMARKER reference position for each config-
uration, which is the peak pulse location associated with the first chip following the
SFD.

SYNC SFD PHR PHY payload

SYNC SFD

SYNC SFD

SYNC SFD

STS PHR PHY payload

PHR PHY payload STS

STS

STS packet configuration zero

STS packet configuration one

STS packet configuration two

STS packet configuration three

Figure 2-2: HRP-ERDEV frame structures with RMARKER position

2.2.1.1  Preamble

The SYNC and SFD fields in the preamble consist of repetitions of a preamble symbol
Si. A preamble symbol is constructed from a ternary code sequence Ci = {–1,0,1} by
inserting several chip durations between code symbols. The supported code sequence
lengths are 31 and 127 as defined in IEEE Std 802.15.4-2020 section 15.2.5, "Pream-
ble timing parameters". In addition, code sequence length 91 is supported as defined in
IEEE Std 802.15.4z‐2020, section 15.2.6.2, "SYNC field". The number of inserted chip

About HRP UWB
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durations is also called delta length and depends on the length of the code sequence
and channel number.

The admissible values for the preamble timing parameters that result from the different
code lengths and pulse repetition frequencies are defined in IEEE Std 802.15.4-2020,
section 15.2.5, "Preamble timing parameters".

Si Si Si Si Si

Ci(0)

Si... 0 Si 0 -Si Si 0 0 -Si

0 ... 0 Ci(1) 0 ... 0 ... Ci(K-1) 0 ... 0

Delta length

SYNC SFD

Figure 2-3: Construction of preamble symbols from a code sequence

SYNC field

The SYNC field portion of the SHR contains simple repetitions of the preamble symbol.
The number of preamble symbol repetitions are 16, 64, 1024 and 4096 as defined in
IEEE Std 802.15.4-2020, section 15.2.5, "Preamble timing parameters". In HPRF
mode, the HRP-ERDEV supports 32 and 64 preamble symbol repetitions as defined in
IEEE Std 802.15.4z‐2020, section 15.2.6.2, "SYNC Field".

SFD field

The SFD field is spread by the preamble symbols. Each of the preamble symbols is
multiplied by a sequence of {-1, 0, 1}. The supported SFD lengths are 8 (short) and 64
(long) as defined in IEEE Std 802.15.4-2020, section 15.2.6.3, "SFD field". In addition,
the SFD sequences corresponding to the BPRF and HPRF modes are supported as
defined in IEEE Std 802.15.4z‐2020, section 15.2.6.3, "SFD Field".

2.2.1.2  Data

The PHR and PHY payload symbols are modulated using a combination of burst posi-
tion modulation (BPM) and binary phase shift keying (BPSK). Each symbol is com-
posed of an active burst of UWB pulses and can carry two bits of information. One bit
is used to determine the position of a burst of pulses, while an additional bit is used to
modulate the phase (polarity) of this same burst. The various data rates are supported
by using variable-length bursts.

PHR field

The PHR field conveys the information necessary to decode the packet to the receiver.

The PHR transports 19 bits:

About HRP UWB
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Data rate Payload length Ranging Reserved Preamble duration SECDED
Bit 0 to 1 2 to 8 9 10 11 to 12 13 to 18

Figure 2-4: PHR bits

Bit 0 to 1 = data rate used to transmit the PHY payload
Bit 2 to 8 = length of the PHY payload field in bytes
Bit 9 = ranging field, "1" indicates a ranging frame (RFRAME)
Bit 10 = reserved field
Bit 11 to 12 = number of symbols in the SYNC field of the preamble
Bit 13 to 18 = SECDED bits, for detection/correction of bit errors in the PHR

For HRP-ERDEV in HPRF mode, the PHR bit structure is different:

A1 A0 Payload length Ranging SECDED
Bit 0 1 2 to 11 12 13 to 18

Figure 2-5: PHR bits for HRP-ERDEV in HPRF mode

Bit 0 to 1 = A1 bit and A0 bit, indicate an additional gap between the payload and the STS, or extend the
payload length field

Bit 2 to 11 = length of the PHY payload field in bytes
Bit 12 = ranging field, "1" indicates a ranging frame (RFRAME)
Bit 13 to 18 = SECDED bits, for detection/correction of bit errors in the PHR

PHY payload field

The PHY payload field is sent at the data rate indicated in the PHR. Due to variable
code sequence lengths, and due to the different corresponding pulse repetition fre-
quencies (PRFs) in the preamble, there are several admissible data rates the UWB
PHY can support. The supported data rates are defined in IEEE Std 802.15.4-2020,
section 15.2.7, "PHR field" and IEEE Std 802.15.4z‐2020, section 15.2.7.2 "PHR field
for HRP-ERDEV in BPRF mode" or IEEE Std 802.15.4z‐2020, section 15.3.4 "HRP-
ERDEV modulation in HPRF mode".

2.2.2  Operating frequency bands

The carrier center frequencies for UWB signals are defined in IEEE Std 802.15.4-2020,
section 15.4.1, "Operating frequency bands". The table below provides an overview of
the supported channels by R&S SMM100A.

Table 2-1: HRP UWB PHY band allocation

Band group Channel Frequency / MHz Bandwidth / MHz Mandatory/optional

0 (sub-gigahertz) 0 499.2 499.2 Mandatory below 1 GHz

1 (low band) 1 3494.4 499.2 Optional

 2 3993.6 499.2 Optional

 3 4492.8 499.2 Mandatory in low band

 4 3993.6 1331.2 Optional

2 (high band) 5 6489.6 499.2 Optional

About HRP UWB
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Band group Channel Frequency / MHz Bandwidth / MHz Mandatory/optional

 6 6988.8 499.2 Optional

 7 6489.6 1081.6 Optional

 8 7488.0 499.2 Optional

 9 7987.2 499.2 Mandatory in high band

 10 8486.4 499.2 Optional

 11 7987.2 1331.2 Optional

 12 8985.6 499.2 Optional

 13 9484.8 499.2 Optional

 14 9984.0 499.2 Optional

 15 9484.8 1354.97 Optional

2.3  About 802.15.4 O-QPSK

Option: R&S SMM-K180

See the following IEEE 802.15.4 standards for detailed information:
● IEEE Std 802.15.4-2020, section 12, "O-QPSK PHY"
● P802.15.4ab/D02, section 13, "O-QPSK PHY"

2.3.1  802.15.4 O-QPSK signals

With 802.15.4ab, new operating bands and modulation modes were introduced to sup-
port advanced ranging with a narrowband signal.

Offset Quadrature Phase Shift Keying (O-QPSK) modulation provides a robust and
spectrally efficient transmission scheme. In O-QPSK, the data is modulated onto the
carrier wave using two orthogonal carriers, which are offset in phase by 90 degrees.
This offset phase shift helps to reduce the peak-to-average power ratio of the transmit-
ted signal, resulting in a more efficient use of the available transmit power. Compared
to other modulation schemes, O-QPSK modulation also provides a higher spectral effi-
ciency, which is important for low rate wireless networks that require high data rates
over short distances. 802.15.4 with O-QPSK modulation is used, for example, in high-
speed, short-range wireless communication applications.

Modulation and spreading

For encoding, the binary data from the PPDU are mapped and modulated to create the
modulated signal. With the R&S SMM100A in "802.15.4-O-QPSK/ab-NB" mode, the
following concept is used for O-QPSK PHY modulation and spreading functions:

About 802.15.4 O-QPSK
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Binary Data 
(from PPDU)

Mapping:
Bit-to-symbol

Mapping:
Symbol-to-chip

O-QPSK
Modulator

Modulated 
Signal

Figure 2-6: 802.15.4-O-QPSK/ab-NB mode: Modulation and spreading concept

Mapping

The binary data from the PPDU are mapped in two steps before being modulated.

● Bit-to-symbol mapping:
Each octet of data from the PPDU is mapped into two data symbols. The four LSBs
of each octet are mapped into one data symbol and the four MSBs of each octet
are mapped into the next data symbol.

● Symbol-to-chip mapping:
Each data symbol is mapped into a 16- or 32-chip pseudo-random noise (PN)
sequence, depending on the operating band.

The concatenated PN sequences for data symbols are aggregated to a chip sequence.

O-QPSK modulation

The chip sequences are modulated onto a carrier via O-QPSK modulation with half-
sine pulse shaping.

● I: In-phase carrier with modulated even-indexed chips
● Q: Quadrature-phase carrier with modulated odd-indexed chips

t

C0 C2 C4 C30...

C1 C3 C5 C31...

Phase

I

Q

Td

Tsym

Figure 2-7: Example: Offset in O-QPSK modulation of a data symbol with a 32-chip sequence

C0 to C31 = Chip number
Tsym = Symbol time
Td = Delay time of Q-phase chips in relation to the I-phase chips (Td = 0.5xTsym)

About 802.15.4 O-QPSK
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2.3.2  Operating frequency bands

For 802.15.4 O-QPSK the following operating frequency bands are available:
Table 2-2: 802.15.4 O-QPSK: operating frequency bands

Band designation (MHz) Frequency band (MHz)

"780" 779 to 787

"868" 868.0 to 868.6

"915" 902 to 928

"2380" 2360 to 2400

"2450" 2400.0 to 2483.5

"5800" 5725 to 5850

"6200" 5925 to 6425

2.4  About enhanced modulation and low latency

Option: R&S SMM-K181

See the following IEEE 802.15.4 standard for detailed information:
● P802.15.4ab/D02

Enhanced modulations can improve the link budget for UWB-driven advanced ranging.

Enhanced modulation and low latency data mode provide the support of HRP
enhanced modulation devices (HRP-EMDEV) and HRP low latency data devices
(HRP-LLDDEV). The mode includes an optional dynamic data mode with special PHR
arrangement for dynamic selection between modulation rates and coding schemes
from packet to packet. Encoding is done either by convolutional encoding or low-den-
sity parity-check (LDPC) advanced encoding.

LDCP encoding

Low-density parity-check (LDPC) advanced encoding is done in the following way:

Data 
Bits

Shortened
Bits

Parity
Bits

Data 
Bits

Data 
Bits

Shortened
Bits

Data 
Bits

Parity
Bits

1 2 3

Figure 2-8: 

1 = Padding
2 = LDPC encoding (adds parity)
3 = Discard shortened bits

About enhanced modulation and low latency
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Dynamic PHR

The dynamic PHY header (PHR) consists of PHR1 and PHR2, separated by a silent
gap interval. PHR1 indicates the data rate and coding for the PHY service data unit
(PDSU) and for PHR2.

PHR2PHR1 Gap

1

Figure 2-9: Dynamic data mode PHY header

1 = Dynamic rate PHR

Example: 
The dynamic rate PHR is part of the packet configuration. LDPC coding requires the
PHR data rate mode "DRMDR" (dynamic rate modulation). For STS packet configura-
tion "1", the frame looks as follows:

Figure 2-10: Example: PHR data rate mode DRMDR and STS Packet Configuration=1

2.5  About multi-millisecond ranging

Option: R&S SMM-K181

See the following IEEE 802.15.4 standard for detailed information:
● P802.15.4ab/D02

Multi-millisecond ranging (MMS) provides the support of advanced ranging devices
(ARDEV). MMS ranging offers improved UWB ranging sensitivity, which provides, for
example, accurate location tracking in buildings, secure payments or secure hands-
free access. The improvements are based on the fact that the ranging packets are divi-
ded into 1 ms timeslots and thus more power can be transmitted. MMS ranging is
either narrowband assisted (via O-QPSK PHY) or UWB driven (via HRP UWB PHY). In
both cases, the respective PHY is employed, for example, for control and result report-
ing.

About multi-millisecond ranging
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Control phase Ranging phase Report phaseInitialization

1

Figure 2-11: MMS ranging phases

1 = Ranging round

The MMS UWB packet configuration 1 (UWB driven) consists of:
● SYNC+SFD fragment
● Ranging sequence fragments (RSF)
● Ranging integrity fragments (RIF)

The MMS UWB packet configuration 2 (narrowband assisted) consists of:
● Ranging sequence fragments (RSF)
● Ranging integrity fragments (RIF)

Ranging sequence fragments

A ranging sequence fragment is a structured set of data elements that are used during
the ranging process to measure distances between devices. Ranging sequence frag-
ments include information such as preamble, ranging request/response, timestamp
information and distance measurement.

The RSF consists of a repetition of a selected multi-millisecond ranging sequence
(MMRS) symbol. The MMRS symbol is a sequence of length 128, treated as two
halves of length 64. An optional gap of equal size up to 64 zeros is inserted after both
A and B to generate the symbol. The same MMRS is used for all ranging sequence
fragments in the MMS packet.

Ranging integrity fragments

A ranging integrity fragment consists of a sequence of active scrambled timestamp pul-
ses. Ranging integrity fragments include information such as timestamp data, signal
quality indicators, error estimates and redundancy information.

The deterministic random bit generator (DRBG) generates a non-repeating sequence
across all ranging integrity fragments of the packet and spreads the pulses. Each RIF
in the packet has the same length from one of the permitted lengths.

Ranging measurement cycle

The ranging measurement cycle consists of the control phase, the ranging measure-
ment phase with all ranging fragments and the optional report phase. The fragment
consisting of SYNC and SFD is used to obtain initial timing/frequency synchronization.

About multi-millisecond ranging
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SYNC+
SFD RSF 1 RIF 1RSF 2 ….. …..

STSMMRS MMRS MMRS…..

RSF x RIF 2 RIF y

t

Report

1 2 3

UWB 
packet

Figure 2-12: MMS packet configuration 1 (UWB driven)

1 = Control phase
2 = Ranging measurement phase
3 = Report phase

RSF 1 RIF 1RSF 2 ….. …..

STSMMRS MMRS MMRS…..

RSF x RIF 2 RIF y

t

Report

1 2 3

NB 
packet

Figure 2-13: MMS packet configuration 2 (narrowband assisted)

1 = Control phase
2 = Ranging measurement phase
3 = Report phase

Example: 
The following example shows a narrowband-assisted MMS ranging phase, including
the timing between initiator and responder. The initiator controls the ranging process
between the devices, the responder is the complementary role to the initiator in the
ranging process.

2.6  About sensing

Option: R&S SMM-K182

See the following IEEE 802.15.4 standard for detailed information:
● P802.15.4ab/D02

About sensing
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Sensing provides the support of sensing-capable devices (SDEV). You can use the
sensing functionality, for example, to estimate the range or velocity of objects. Sensing
also enables applications like, for example presence detection.

Sensing procedure

The sensing procedure defines sensing packet exchange sequences for each sensing
mode. For measurement, a sensing session consists of one or more sensing rounds.

... ...

...1 1

2

345

Figure 2-14: Example: Phases in a sensing round

1 = Sensing slot
2 = Sensing round
3 = Sensing measurement report phase
4 = Sensing phase
5 = Sensing control phase

Sensing packet configuration

In the sensing phase, the PHY protocol data units (PPDU) support all sensing packet
formats according to P802.15.4ab/D02.

1

2

3

Figure 2-15: 

1 = SENS packet configuration 0
2 = SENS packet configuration 1
3 = SENS packet configuration 2

Sensing sequence field

In addition to the SENS packet configurations 0, 1 and 2, the R&S SMM-K182 provides
the "User-SENSactive" package format.

About sensing
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This packet configuration allows intra-packet frequency stitching, which offers flexibility
with different gap sizes and different numbers of SENS active segments.

The sensing sequence (SENS) field uses preamble symbols using the same preamble
code as for SYNC and SFD in the packet. The symbols are arranged in up to four
blocks of active segments in between silent gap intervals.

Example: 

Figure 2-16: SENS packet configuration User-SENSactive: Single segment SENS

Figure 2-17: SENS packet configuration User-SENSactive: Two-segment SENS

About sensing
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3  IEEE 802.15.4 common settings
Access:

► Select "Baseband" > "IEEE 802.15.4".

The remote commands required to define these settings are described in Section 7,
"Remote control commands", on page 103.

Settings:

● General settings......................................................................................................24
● Impairments settings...............................................................................................29

3.1  General settings

Access:

► Select "Baseband" > "IEEE 802.15.4".

The dialog provides the standard general settings, the default and the "Save/
Recall" settings. Also, it provides access to dialogs with further settings.

Settings:

State..............................................................................................................................25
Set to Default................................................................................................................ 25
Save/Recall................................................................................................................... 25
Generate Waveform File............................................................................................... 26
Mode............................................................................................................................. 26
Set RF according to Channel number...........................................................................27
Channel Number........................................................................................................... 27
Bandwidth..................................................................................................................... 28
Fixed 2 ms Frame Length............................................................................................. 28

General settings
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Operating Band............................................................................................................. 28
Idle Interval....................................................................................................................28
Filter/Clipping/ARB........................................................................................................29

State
Enables the IEEE 802.15.4 standard.
Enabling this standard disables all the other digital standards and digital modulation
modes in the same baseband.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:STATe on page 105

Set to Default
Calls the default settings. The table below lists the default values of the main parame-
ters.

Parameter Value

"State" Not affected by the "Set to Default"

HRP UWB "Mode" "802.15.4(HRP UWB)"

"Channel Num" "0"

"Bandwidth" "499.20 MHz"

"Fixed 2 ms Frame Length" Not activated

"Idle Interval" "50.0 µs"

"Filter" "802.15.4z"

Clipping "State" "Off"

ARB "Sequence Length" "1 Frames"

"Trigger" "Auto"

"Marker" "Restart(ARB)"

"Clock" "Internal"

Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:PRESet on page 105

Save/Recall
Opens the "Save/Recall" dialog that is the standard instrument function for saving and
recalling the complete dialog-related settings in a file. The provided navigation possibil-
ities in the dialog are self-explanatory.
The settings are saved in a file with a predefined extension. You can define the file-
name and the directory, in that you want to save the file.
See also section "Saving and recalling settings" in the R&S SMM100A user manual.

General settings
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Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:SETTing:CATalog
on page 105
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:SETTing:
DELete on page 106
[:SOURce<hw>]:BB:LRWPan|HUWB:SETTing:LOAD on page 106
[:SOURce<hw>]:BB:LRWPan|HUWB:SETTing:STORe on page 106

Generate Waveform File
With enabled signal generation, triggers the instrument to save the current settings of
an arbitrary waveform signal in a waveform file with predefined extension *.wv. You
can define the filename and the directory, in that you want to save the file.
Using the ARB modulation source, you can play back waveform files or process the file
to generate multicarrier or multi-segment signals.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:WAVeform:CREate on page 107

Mode
Sets the 802.15.4 mode.
"802.15.4(HRP UWB)"

Requires R&S SMM-K149.
Enables HRP non-ERDEV mode.

"802.15.4z-BPRF"
Requires R&S SMM-K149.
Enables HRP-ERDEV base pulse repetition frequency (BPRF) mode.

"802.15.4z-HPRF"
Requires R&S SMM-K149.
Enables HRP-ERDEV higher pulse repetition frequency (HPRF)
mode.

"802.15.4-O-QPSK/ab-NB"
Requires R&S SMM-K180.
Enables 802.15.4 with O-QPSK modulation mode.

"802.15.4ab-HRP-UWB-MMS"
Requires R&S SMM-K181.
Enables multi-millisecond advanced ranging (MMS) mode.

"802.15.4ab-HRP-UWB-EM+LLD"
Requires R&S SMM-K181.
Enables enhanced modulation and low latency (EM+LLD) mode.

"802.15.4ab-HRP-UWB-SENSING"
Requires R&S SMM-K182.
Enables sensing mode.

"802.15.4z-HRP-UWB-SYNC+SFD"
Requires R&S SMM-K149.
Enables SYN+SFD mode. The SYN packet and the SFD packet with-
out the DATA part is sent.

General settings
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Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:STD on page 108

Set RF according to Channel number
Sets the RF output frequency automatically to the value of the channel center fre-
quency according to the selected "Channel Number".
You can still adjust the RF frequency afterwards.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:HUWB|MMS|EMLLd|SENS:SRF on page 134

Channel Number
Requires R&S SMM-B9.
Requires R&S SMM-K149/-K181/-K182.
Sets the channel number that is a 4-bit value in decimal representation.
The channel number determines the bandwidth and the code index.
Table 3-1: R&S SMM-K149/R&S SMM-K181: Channel number and code index

Channel number Bandwidth / MHz Code index1)

0, 1, 8, 12 499.2 1, 2, 9 to 16, 21 to 32

2, 5, 9, 13 499.2 3, 4, 9 to 16, 21 to 32

3, 6, 10, 14 499.2 5, 6, 9 to 16, 21 to 32

4, 11 1331.2 7, 8, 13 to 32

7 1081.6 7, 8, 13 to 32

15 1354.97 7, 8, 13 to 32

1) Code indexes 25 to 32 require "Mode" > "802.15.4z-HPRF".
Table 3-2: R&S SMM-K182: Channel number and code index

Channel number Bandwidth / MHz Code index1)

0, 1, 8, 12 499.2 9 to 16, 21 to 32

2, 5, 9, 13 499.2 9 to 16, 21 to 32

3, 6, 10, 14 499.2 9 to 16, 21 to 32

4, 11 1331.2 13 to 32

7 1081.6 13 to 32

15 1354.97 13 to 32

1) Code indexes 9 to 24: "SENS Packet Configuration" values are "0" / "User-SENSac-
tive".
1) Code indexes 25 to 32: "SENS Packet Configuration" values are "0" / "1" / "2" /
"User-SENSactive".

General settings
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Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:CNUMber
on page 107

Bandwidth
Requires R&S SMM-B9.
Requires R&S SMM-K149/-K181/-K182.
Displays the bandwidth of the HRP UWB signal.
The bandwidth depends on the channel number, see "Channel Number" on page 27.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:BWIDth?
on page 107

Fixed 2 ms Frame Length
Requires R&S SMM-B9.
Requires R&S SMM-K149/-K181/-K182.
Requires "Mode" > "802.15.4(HRP UWB)" / "802.15.4z-BPRF" / "802.15.4z-HPRF" /
"802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-HRP-UWB-SENSING" / "802.15.4z-
HRP-UWB-SYNC+SFD".
Sets the frame length of a generated waveform shorter than 2 ms to a fixed value of 2
ms.
If activated, the "Idle Interval" is set to 0.0 µs by default that means the frames are sent
successively without separation.
Generated waveforms longer than 2 ms remain unaffected.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:F2MS
on page 107

Operating Band
Requires R&S SMM-K180.
Selects the operating band for 802.15.4 with O-QPSK modulation.
For selectable operating bands, see Section 2.3.2, "Operating frequency bands",
on page 18.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:OBANd on page 109

Idle Interval
Sets the time of the interval separating the two frames.
For "Mode" > "802.15.4ab-HRP-UWB-MMS", the idle interval is fixed to 50 µs.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:IINTerval
on page 108

General settings
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Filter/Clipping/ARB
Accesses a dialog to set baseband filtering, clipping and the sequence length of the
arbitrary waveform component, see Section 6.1, "Filter/Clipping/ARB settings",
on page 87.

3.2  Impairments settings

Access:

► Select "Baseband" > "IEEE 802.15.4" > "Impairments".

The tab provides settings to configure impairing of the signal.

Settings:

State..............................................................................................................................29
Chip Clock Error............................................................................................................29
Frequency Offset...........................................................................................................29

State
Activates adding impairments to the signal.
Impairments change the signal to simulate a non-ideal transmitter.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:IMPairments:STATe on page 151

Chip Clock Error
Sets the chip clock error.
The set error corresponds to applying a deviation to the transmitter chip clock.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:IMPairments:CCERror on page 150

Frequency Offset
Sets the carrier frequency offset.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:IMPairments:FOFFset on page 150

Impairments settings
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4  Frame configuration settings
Access:

1. Select "Baseband" > "IEEE 802.15.4".

2. Select the "Mode".

3. Select the tab "Frame Configuration".

Each mode provides frame configuration settings according to the selected stan-
dard.

● HRP UWB............................................................................................................... 30
● 802.15.4 O-QPSK................................................................................................... 42
● Enhanced modulation and low latency....................................................................50
● Sensing................................................................................................................... 62
● MAC header configuration settings.........................................................................73

4.1  HRP UWB

Option: R&S SMM-K149

Access:

1. Select "Mode" > "802.15.4(HRP UWB)" / "802.15.4z-BPRF" / "802.15.4z-HPRF".

2. Select the tab "Frame Configuration".

The dialog provides settings to configure HRP UWB frames.

● General settings......................................................................................................31
● SYNC settings.........................................................................................................32
● Data settings........................................................................................................... 34
● STS settings............................................................................................................39

HRP UWB
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4.1.1  General settings

Access:

► Select "Frame Configuration" > "General".

The tab provides settings to configure the code index and the scrambled time-
stamp sequence (STS) packets of HRP UWB frames.

Settings:

Code Index....................................................................................................................31
STS Packet Configuration.............................................................................................31

Code Index
Sets the code index that determines the code sequence.
Available code indexes depend on the channel number and mode, see "Channel Num-
ber" on page 27.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:CINDex
on page 117

STS Packet Configuration
Requires "Mode" > "802.15.4z-BPRF" / "802.15.4z-HPRF" / "802.15.4ab-HRP-UWB-
EM+LLD".
Sets the scrambled timestamp sequence (STS) packet configuration. If "STS Packet
Configuration > 1/2/3", you can configure additional STS settings, see Section 4.1.4,
"STS settings", on page 39.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|EMLLd:STS:PC on page 132

HRP UWB
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4.1.2  SYNC settings

Access:

► Select "Frame Configuration" > "SYNC".

The tab provides settings to configure SYNC settings.

Settings:

Sync Length.................................................................................................................. 32
Delta Length..................................................................................................................32
SFD Length................................................................................................................... 33
SFD............................................................................................................................... 33

Sync Length
Sets the length of the SYNC field.
In the mode "802.15.4-O-QPSK/ab-NB" the sync length is set automatically, depending
on the selected operating band and SFD.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
SYNLength on page 126

Delta Length
Sets the delta length. The length depends on the HRP UWB mode and bandwidth.

HRP UWB mode Bandwidth / MHz Delta length

802.15.4(HRP UWB) 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16

802.15.4z-BPRF 499.2

1081.6

1331.2

1354.97

4

HRP UWB
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HRP UWB mode Bandwidth / MHz Delta length

802.15.4z-HPRF 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16

802.15.4ab-HRP-UWB-MMS 499.2

1081.6

1331.2

1354.97

4

4

4

4

802.15.4ab-HRP-UWB-EM+LLD 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16

802.15.4ab-HRP-UWB-SENSING 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
DLENgth on page 120

SFD Length
Displays the symbol length of the start-of-frame delimiter (SFD). The length depends
on the 802.15.4 mode, see Table 4-1.
In the mode "802.15.4-O-QPSK/ab-NB" the SFD length is 2.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
SFDLength? on page 125

SFD
Sets the start-of-frame delimiter (SFD) symbol sequence.
Availability of the SFD sequence and the corresponding SFD length depends on the
802.15.4 mode, see Table 4-1.
Table 4-1: SFD, SFD length and HRP UWB mode

SFD SFD length 802.15.4(HRP UWB) 802.15.4z-BPRF 802.15.4z-HPRF

0 8 - Supported Supported

1 4 - Supported Supported

2 8 - Supported Supported

3 16 - Supported Supported

4 32 - Supported Supported

Legacy 8 Supported - -

HRP UWB



Frame configuration settingsR&S®SMM-K149/-K180/-K181/-K182

34User Manual 1179.2083.02 ─ 11

Additional to standard-compliant SFD sequences, "802.15.4(HRP UWB)" mode also
supports a legacy sequence.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB:SFD on page 129

4.1.3  Data settings

Access:

► Select "Frame Configuration > Data".

The tab provides settings to configure physical data and physical header settings.
For "STS Packet Configuration" = 3, you cannot configure the "Data" settings.

PHY header and PHY payload coding

The data for the physical payload is segmented into code blocks for coding via the
Reed-Solomon coder. The PHY payload is split into four blocks according to the 330-
bits block length.
Table 4-2: PHY data length and code block segmentation

Frame Code block b

Number Length [byte] Length [bit] Number b1 [bit] b2 [bit] b3 [bit] b4 [bit]

1 1

to

41

8

to

328

1 8

to

328

0 0 0

2 42

to

82

336

to

656

2 330 6

to

326

0 0

HRP UWB
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Frame Code block b

Number Length [byte] Length [bit] Number b1 [bit] b2 [bit] b3 [bit] b4 [bit]

3 83

to

123

664

to

984

3 330 330 4

to

324

0

4 124

to

127

992

to

1016

4 330 330 330 2

to

26

Settings:

Physical Data................................................................................................................ 35
└ Data Source....................................................................................................35
└ Viterbi Rate..................................................................................................... 36
└ Convolutional Code Constraint Length........................................................... 36
└ Hop Bursts...................................................................................................... 36
└ Chips Per Burst...............................................................................................37
└ MAC FCS........................................................................................................37
└ MAC FCS Length............................................................................................37
└ MAC Header................................................................................................... 37
└ Mean PRF.......................................................................................................37
└ Data Rate........................................................................................................37
└ PHR Data Rate Mode..................................................................................... 38

PHR (Physical Header)................................................................................................. 38
└ PHR Bit Rate...................................................................................................38
└ Data Length.................................................................................................... 38
└ Maximum Data Length....................................................................................39

Frame............................................................................................................................39
└ Frame Length..................................................................................................39

Physical Data
Provides settings to configure physical data.

Data Source ← Physical Data
Selects the data source.
Note: The bit order of the output data bits is least significant bit (LSB) first and most
significant bit (MSB) last.
The following standard data sources are available:
● "All 0"/"All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to set the bit pattern.

● "Data List"/"Select Data List"
Binary data from a list file, internally or externally generated.

HRP UWB



Frame configuration settingsR&S®SMM-K149/-K180/-K181/-K182

36User Manual 1179.2083.02 ─ 11

Select "Select Data List" to open the standard "Select List" dialog. The dialog lists
file with file extension *.dm_iqd if existing.
– Navigate to the list file and tap "Select" to select the file.
– Use the "New" and "Edit" functions to create a data list internally or to edit an

existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also:
● Section "About data signals" in the R&S SMM100A user manual.
● Section "File and data management" in the R&S SMM100A user manual.
● Section "Data list editor" in the R&S SMM100A user manual.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA
on page 118
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA:
DSELection on page 118
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA:
PATTern on page 119

Viterbi Rate ← Physical Data
For "Mode" > "802.15.4(HRP UWB)" / "802.15.4z-BPRF" / "802.15.4z-HPRF":
Displays the Viterbi rate for convolutional coding.
The rate is fixed to 0.5, except for "Chips Per Burst" > 1 it is 1.0.
For "Mode" > "802.15.4ab-HRP-UWB-EM+LLD":
Displays the Viterbi rate for the channel code type.
The rate is fixed to 0.5. For "Channel Code Type" > "LDPC", no Viterbi rate is dis-
played.
For "Mode" > "802.15.4ab-HRP-UWB-SENSING":
The rate is fixed to 0.5 for "Channel Code Type" > "CL3" / "CL7" (convolutional coding).
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:VRATe?
on page 127

Convolutional Code Constraint Length ← Physical Data
Requires "Mode" > "802.15.4z-HPRF".
Sets the constraint length of the convolutional code.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:CCCL on page 116

Hop Bursts ← Physical Data
Requires "Mode" > "802.15.4(HRP UWB)" / "802.15.4z-BPRF".
Sets the number of hop bursts.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB:FCONfig:HOPBurst on page 122
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Chips Per Burst ← Physical Data
Sets the number of chips per burst.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB:FCONfig:CPBurst on page 117

MAC FCS ← Physical Data
Activates the MAC frame check sequence (FCS) field.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MCS:
STATe on page 122

MAC FCS Length ← Physical Data
Requires "MAC FCS > On".
Sets the length of the MAC frame check sequence (FCS) field.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MFL
on page 123

MAC Header ← Physical Data
Accesses the "MAC Header Configuration" dialog to configure MAC header parame-
ters.
See Section 4.5, "MAC header configuration settings", on page 73.
If the MAC header is active, the button displays the length of the MAC header and the
MAC address.

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
STRing? on page 150

Mean PRF ← Physical Data
Displays the mean pulse repetition frequency (PRF).
For "Mode" > "802.15.4(HRP UWB)" / "802.15.4z-BPRF":
The value depends on the hop bursts and the "PHR Data Rate Mode".
For "Mode" > "802.15.4z-HPRF":
The value depends on the "PHR Data Rate Mode".
For "Mode" > "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-HRP-UWB-SENSING":
The value depends on the "PHR Bit Rate" and the "PHR Data Rate Mode".
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MPRF?
on page 123

Data Rate ← Physical Data
Displays the data rate.
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In the mode "802.15.4-O-QPSK/ab-NB" the data rate is set automatically, depending
on the selected operating band and SFD.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DR?
on page 119

PHR Data Rate Mode ← Physical Data
Requires "Mode" > "802.15.4z-BPRF" / "802.15.4z-HPRF".
Sets the data rate mode of the physical header.
"DRBM_LP/DRBM_HP"

Requires "Mode" > "802.15.4z-BPRF".
"DRHM_LR/DRHM_HR"

Requires "Mode" > "802.15.4z-HPRF".
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:PHR:DRM on page 127

PHR (Physical Header)
Provides settings to configure the PHY header and PHY payload.

PHR Bit Rate ← PHR (Physical Header)
Displays the bit rate of the physical header.
For "Mode" > "802.15.4(HRP UWB)" / "802.15.4z-BPRF", the value depends on the
chips per burst.
For "Mode" > "802.15.4-O-QPSK/ab-NB" the "PHR Bit Rate" equals the "Data Rate".
For "Mode" > "802.15.4z-HPRF" / "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-
HRP-UWB-SENSING"the "PHR Bit Rate" depends on the "PHR Data Rate Mode".
For "Mode" > "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-HRP-UWB-SENSING"
and "PHR Data Rate Mode" > "DRMDR", the "PHR Bit Rate" is not displayed.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:
PHRBrate? on page 124

Data Length ← PHR (Physical Header)
Sets the data length of the PHY header and PHY payload in octets.
PHY header and PHY payload data are segmented into code blocks for Reed-Solomon
encoding, see Table 4-2.
Table 4-3: Mode and maximum data length

Mode Maximum data length

"802.15.4(HRP UWB)" 127 octets

"802.15.4z-BPRF" 127 octets

"802.15.4z-HPRF" 4095 octets

"802.15.4-O-QPSK/ab-NB" 127 octets
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Mode Maximum data length

"802.15.4ab-HRP-UWB-EM+LLD" 4095 octets

"802.15.4ab-HRP-UWB-SENSING" 4095 octets

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DALEngth
on page 119

Maximum Data Length ← PHR (Physical Header)
Requires "Mode" > "802.15.4z-HPRF" / "802.15.4ab-HRP-UWB-EM+LLD" /
"802.15.4ab-HRP-UWB-SENSING".
Sets the maximum data length of the physical header.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MDL
on page 122

Frame
Provides information on the frame length.

Frame Length ← Frame
Displays the frame length.
The frame length is the sum of the MAC header length, the MAC frame check
sequence (FCS) field length and the data length of the physical header.

Example: Frame lengths with enabled and disabled MAC parameters
By default, the frame length is 20 octets that are the data length of the physical header.
If you activate the MAC frame check sequence (FCS) field, the frame length increases.
Using the default "MAC FCS Length > 2 Octets", the frame length is 22 octets.
If you further activate the MAC header, the frame length increases. Using the default
"MAC Header > 11 Octets", the frame length is 33 octets.

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:FLENgth?
on page 120

4.1.4  STS settings

Access:

1. Select the HRP UWB mode:

● "General" > "Mode" > "802.15.4z-BPRF"
● "General" > "Mode" > "802.15.4z-HPRF"

2. Select "Frame Configuration"> "General" > "STS Packet Configuration" >"1/2/3".
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3. Select "Frame Configuration" > "STS".

The tab provides settings to configure the scrambled timestamp sequence (STS).

To select and import an STS data list

To import a binary data from an STS data list, internally or externally generated:

1. Activate "STS Source (MSB is Transmitted First)".

"Select STS Data List" is displayed.

2. Click "Select STS Data List" to access the standard "User Files" dialog.

a) Navigate to the list file (*.dm_iqd) and click "Select" to select an existing data
list.

b) Use the "New" and "Edit" functions to create internally a new data list or to edit
an existing one.

c) Use the standard "File Manager" function to transfer external data lists to the
instrument.

Settings:

STS Source (MSB is Transmitted First)........................................................................ 40
VUpper96(hex)..............................................................................................................41
VCounter(hex)...............................................................................................................41
Key(hex)........................................................................................................................41
Delta Length..................................................................................................................41
Active Segment Length................................................................................................. 41
Number of Active Segments......................................................................................... 41
Additional Gap between Payload and STS................................................................... 42

STS Source (MSB is Transmitted First)
Activates the scrambled timestamp sequence (STS) source. If activated, you can
select an STS data list from a designated folder to import a user-defined STS
sequence.
The bit order of the imported data is the most significant bit (MSB) first.

HRP UWB
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How to: "To select and import an STS data list" on page 40
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:DLS on page 130
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:DATA:DSELection
on page 131

VUpper96(hex)
Sets the upper part of the V value. The value is a 96-bit value in hexadecimal repre-
sentation.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:UPARt on page 132

VCounter(hex)
Sets the counter part of the V value. The value is a 32-bit value in hexadecimal repre-
sentation.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:CPARt on page 131

Key(hex)
Sets the key value. The value is a 128-bit value in hexadecimal representation.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:KEY on page 132

Delta Length
Displays the delta length of the scrambled timestamp sequence (STS). The delta
length depends on the HRP UWB mode.

HRP UWB "Mode" "Delta length"

"802.15.4z-BPRF" "8"

"802.15.4z-HPRF" "4"

"802.15.4ab-HRP-UWB-MMS" "4"

"802.15.4ab-HRP-UWB-EM+LLD" "4"

"802.15.4ab-HRP-UWB-SENSING" "4"

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:STS:DLEN?
on page 131

Active Segment Length
Sets the active segment length in units of 512 chips (1 µs).
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:ASL on page 115

Number of Active Segments
Requires "Mode" > "802.15.4z-BPRF" / "802.15.4z-HPRF" / "802.15.4ab-HRP-UWB-
MMS" / "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-HRP-UWB-SENSING".
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Sets the number of up to four active segments.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:ASN on page 116

Additional Gap between Payload and STS
Requires "Mode" > "802.15.4z-HPRF" / "802.15.4ab-HRP-UWB-EM+LLD" and "STS
Packet Configuration" > "2".
Sets an additional gap between payload and STS.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd:FCONfig:ADDGap
on page 116

4.2  802.15.4 O-QPSK

Option: R&S SMM-K180

Access:

1. Select "802.15.4-O-QPSK/ab-NB".

2. Select the tab "Frame Configuration".

The dialog provides settings to configure 802.15.4 frames with O-QPSK modula-
tion.

● SYNC settings.........................................................................................................42
● Data settings........................................................................................................... 45

4.2.1  SYNC settings

Access:

► Select "Frame Configuration" > "SYNC".

802.15.4 O-QPSK
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The tab provides settings to configure SYNC settings.

Settings:

Sync Length.................................................................................................................. 43
SFD Length................................................................................................................... 43
SFD............................................................................................................................... 43
Config Index.................................................................................................................. 44
PHR Length...................................................................................................................44
Spreading factor in SHR............................................................................................... 44
FEC in PHR...................................................................................................................44

Sync Length
Sets the length of the SYNC field.
In the mode "802.15.4-O-QPSK/ab-NB" the sync length is set automatically, depending
on the selected operating band and SFD.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
SYNLength on page 126

SFD Length
Displays the symbol length of the start-of-frame delimiter (SFD). The length depends
on the 802.15.4 mode, see Table 4-1.
In the mode "802.15.4-O-QPSK/ab-NB" the SFD length is 2.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
SFDLength? on page 125

SFD
Sets the start-of-frame delimiter (SFD) symbol sequence.
In the mode "802.15.4-O-QPSK/ab-NB" the available SFD sequences depend on the
selected operating band.
Table 4-4: 802.15.4 O-QPSK: operating band and available SFD sequences

Operating band SFD

780 MHz 0

868 MHz 0

915 MHz 0

2380 MHz 0

2450 MHz 0

5800 MHz 0/1/2/3/4

6200 MHz 0/1/2/3/4

Remote command: 
[:SOURce<hw>]:BB:LRWPan:OQPSk:SFD on page 128
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Config Index
Requires "Operating Band" > "5800 MHz" / "6200 MHz".
Selects the configuration index, which determines for example the SYNC length and
SFD length for symbol-to-chip mapping in the selected operating band.
You can select a configuration index in the range from 1 to 8.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:OQPSk:CINDex on page 130

PHR Length
Displays the length of the PHY header.
The length of the PHY header depends on the selected operating band and SFD.

"Operating Band" "SFD" "PHR Length"

780 MHz, 868 MHz, 915 MHz, 2380 MHz, 2450 MHz 0 2

5800 MHz, 6200 MHz 0 2

5800 MHz, 6200 MHz 1/2/3/4 7

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:PHRLength?
on page 124

Spreading factor in SHR
Displays the spreading factor (number of chips per symbol) in the synchronization
header.
The spreading factor depends on the selected operating band.

"Operating Band" "Spreading factor in SHR"

780 MHz, 868 MHz, 915 MHz 16

2380 MHz, 2450 MHz, 5800 MHz, 6200 MHz 32

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:SFShr? on page 126

FEC in PHR
Displays the state of the forward error correction in the PHY header.
Enables or disables the forward error correction in the PHY header automatically,
depending on the selected operating band and SFD.

"Operating Band" "SFD" "FEC in PHR"

780 MHz, 868 MHz, 915 MHz, 2380 MHz, 2450 MHz 0 Disabled

5800 MHz, 6200 MHz 0 Disabled

5800 MHz, 6200 MHz 1/2/3/4 Enabled
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Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:FPhr:STATe?
on page 121

4.2.2  Data settings

Access:

► Select "Frame Configuration" > "Data".

The tab provides settings to configure physical data and physical header settings.

Settings:

Physical Data................................................................................................................ 46
└ Data Source....................................................................................................46
└ Viterbi Rate..................................................................................................... 46
└ MAC FCS........................................................................................................47
└ MAC FCS Length............................................................................................47
└ MAC Header................................................................................................... 47
└ Spreading factor in PHR and Payload............................................................ 47
└ FEC in Payload...............................................................................................48
└ Data Rate........................................................................................................48
└ Symbol Rate................................................................................................... 48

PHR (Physical Header)................................................................................................. 49
└ PHR Bit Rate...................................................................................................49
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└ Data Length.................................................................................................... 49
Frame............................................................................................................................49

└ Frame Length..................................................................................................49

Physical Data
Provides settings to configure physical data.

Data Source ← Physical Data
Selects the data source.
Note: The bit order of the output data bits is least significant bit (LSB) first and most
significant bit (MSB) last.
The following standard data sources are available:
● "All 0"/"All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to set the bit pattern.

● "Data List"/"Select Data List"
Binary data from a list file, internally or externally generated.
Select "Select Data List" to open the standard "Select List" dialog. The dialog lists
file with file extension *.dm_iqd if existing.
– Navigate to the list file and tap "Select" to select the file.
– Use the "New" and "Edit" functions to create a data list internally or to edit an

existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also:
● Section "About data signals" in the R&S SMM100A user manual.
● Section "File and data management" in the R&S SMM100A user manual.
● Section "Data list editor" in the R&S SMM100A user manual.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA
on page 118
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA:
DSELection on page 118
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA:
PATTern on page 119

Viterbi Rate ← Physical Data
For "Mode" > "802.15.4(HRP UWB)" / "802.15.4z-BPRF" / "802.15.4z-HPRF":
Displays the Viterbi rate for convolutional coding.
The rate is fixed to 0.5, except for "Chips Per Burst" > 1 it is 1.0.
For "Mode" > "802.15.4ab-HRP-UWB-EM+LLD":
Displays the Viterbi rate for the channel code type.
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The rate is fixed to 0.5. For "Channel Code Type" > "LDPC", no Viterbi rate is dis-
played.
For "Mode" > "802.15.4ab-HRP-UWB-SENSING":
The rate is fixed to 0.5 for "Channel Code Type" > "CL3" / "CL7" (convolutional coding).
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:VRATe?
on page 127

MAC FCS ← Physical Data
Activates the MAC frame check sequence (FCS) field.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MCS:
STATe on page 122

MAC FCS Length ← Physical Data
Requires "MAC FCS > On".
Sets the length of the MAC frame check sequence (FCS) field.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MFL
on page 123

MAC Header ← Physical Data
Accesses the "MAC Header Configuration" dialog to configure MAC header parame-
ters.
See Section 4.5, "MAC header configuration settings", on page 73.
If the MAC header is active, the button displays the length of the MAC header and the
MAC address.

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
STRing? on page 150

Spreading factor in PHR and Payload ← Physical Data
Displays the spreading factor (number of chips per symbol) in PHY header and pay-
load.
The spreading factor depends on the selected operating band and SFD.

"Operating Band" "SFD" "Spreading factor in PHR and Payload"

780 MHz, 868 MHz, 915 MHz 0 16

2380 MHz, 2450 MHz 0 32

5800 MHz, 6200 MHz 0 32

5800 MHz, 6200 MHz 1/2 8
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"Operating Band" "SFD" "Spreading factor in PHR and Payload"

5800 MHz, 6200 MHz 3 16

5800 MHz, 6200 MHz 4 4

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:SFPAYLoad?
on page 125

FEC in Payload ← Physical Data
Displays the state of the forward error correction in payload.
The FEC in payload is enabled or disabled automatically, depending on the selected
operating band and SFD.

"Operating Band" "SFD" "FEC in Payload"

780 MHz, 868 MHz, 915 MHz, 2380 MHz, 2450 MHz 0 Disabled

5800 MHz, 6200 MHz 0/2 Disabled

5800 MHz, 6200 MHz 1/3/4 Enabled

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:FPAYload:STATe?
on page 121

Data Rate ← Physical Data
Displays the data rate.
In the mode "802.15.4-O-QPSK/ab-NB" the data rate is set automatically, depending
on the selected operating band and SFD.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DR?
on page 119

Symbol Rate ← Physical Data
Displays the symbol rate of the O-QPSK modulated signal.
The symbol rate depends on the selected operating band and SFD.

"Operating Band" "SFD" "Symbol Rate"

780 MHz, 915 MHz, 2380 MHz, 2450 MHz 0 62.5 KSymbol/s

868 MHz 0 25 KSymbol/s

5800 MHz, 6200 MHz 0/3 62.5 KSymbol/s

5800 MHz, 6200 MHz 1 125 KSymbol/s

5800 MHz, 6200 MHz 2/4 250 KSymbol/s

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:SYMRate? on page 126
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PHR (Physical Header)
Provides settings to configure the PHY header and PHY payload.

PHR Bit Rate ← PHR (Physical Header)
Displays the bit rate of the physical header.
For "Mode" > "802.15.4(HRP UWB)" / "802.15.4z-BPRF", the value depends on the
chips per burst.
For "Mode" > "802.15.4-O-QPSK/ab-NB" the "PHR Bit Rate" equals the "Data Rate".
For "Mode" > "802.15.4z-HPRF" / "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-
HRP-UWB-SENSING"the "PHR Bit Rate" depends on the "PHR Data Rate Mode".
For "Mode" > "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-HRP-UWB-SENSING"
and "PHR Data Rate Mode" > "DRMDR", the "PHR Bit Rate" is not displayed.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:
PHRBrate? on page 124

Data Length ← PHR (Physical Header)
Sets the data length of the PHY header and PHY payload in octets.
PHY header and PHY payload data are segmented into code blocks for Reed-Solomon
encoding, see Table 4-2.
Table 4-5: Mode and maximum data length

Mode Maximum data length

"802.15.4(HRP UWB)" 127 octets

"802.15.4z-BPRF" 127 octets

"802.15.4z-HPRF" 4095 octets

"802.15.4-O-QPSK/ab-NB" 127 octets

"802.15.4ab-HRP-UWB-EM+LLD" 4095 octets

"802.15.4ab-HRP-UWB-SENSING" 4095 octets

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DALEngth
on page 119

Frame
Provides information on the frame length.

Frame Length ← Frame
Displays the frame length.
The frame length is the sum of the MAC header length, the MAC frame check
sequence (FCS) field length and the data length of the physical header.

802.15.4 O-QPSK
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Example: Frame lengths with enabled and disabled MAC parameters
By default, the frame length is 20 octets that are the data length of the physical header.
If you activate the MAC frame check sequence (FCS) field, the frame length increases.
Using the default "MAC FCS Length > 2 Octets", the frame length is 22 octets.
If you further activate the MAC header, the frame length increases. Using the default
"MAC Header > 11 Octets", the frame length is 33 octets.

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:FLENgth?
on page 120

4.3  Enhanced modulation and low latency

Option: R&S SMM-K181

Access:

1. Select "Mode" > "802.15.4ab-HRP-UWB-EM+LLD".

2. Select the tab "Frame Configuration".

● General settings......................................................................................................50
● SYNC settings.........................................................................................................51
● Data settings........................................................................................................... 54
● STS settings............................................................................................................59

4.3.1  General settings

Access:

► Select "Frame Configuration" > "General".

Enhanced modulation and low latency
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The tab provides settings to configure the code index and the scrambled time-
stamp sequence (STS) packets of HRP UWB frames.

Settings:

Code Index....................................................................................................................51
STS Packet Configuration.............................................................................................51

Code Index
Sets the code index that determines the code sequence.
Available code indexes depend on the channel number and mode, see "Channel Num-
ber" on page 27.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:CINDex
on page 117

STS Packet Configuration
Requires "Mode" > "802.15.4z-BPRF" / "802.15.4z-HPRF" / "802.15.4ab-HRP-UWB-
EM+LLD".
Sets the scrambled timestamp sequence (STS) packet configuration. If "STS Packet
Configuration > 1/2/3", you can configure additional STS settings, see Section 4.1.4,
"STS settings", on page 39.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|EMLLd:STS:PC on page 132

4.3.2  SYNC settings

Access:

► Select "Frame Configuration" > "SYNC".

The tab provides settings to configure SYNC settings.
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Settings:

Sync Length.................................................................................................................. 52
Delta Length..................................................................................................................52
SFD Length................................................................................................................... 53
SFD............................................................................................................................... 53

Sync Length
Sets the length of the SYNC field.
In the mode "802.15.4-O-QPSK/ab-NB" the sync length is set automatically, depending
on the selected operating band and SFD.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
SYNLength on page 126

Delta Length
Sets the delta length. The length depends on the HRP UWB mode and bandwidth.

HRP UWB mode Bandwidth / MHz Delta length

802.15.4(HRP UWB) 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16

802.15.4z-BPRF 499.2

1081.6

1331.2

1354.97

4

802.15.4z-HPRF 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16

802.15.4ab-HRP-UWB-MMS 499.2

1081.6

1331.2

1354.97

4

4

4

4

802.15.4ab-HRP-UWB-EM+LLD 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16

802.15.4ab-HRP-UWB-SENSING 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16
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Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
DLENgth on page 120

SFD Length
Displays the symbol length of the start-of-frame delimiter (SFD). The length depends
on the 802.15.4 mode, see Table 4-1.
In the mode "802.15.4-O-QPSK/ab-NB" the SFD length is 2.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
SFDLength? on page 125

SFD
Sets the start-of-frame delimiter (SFD) symbol sequence.
Table 4-6: SFD and SFD length

SFD SFD length

1 4

2 8

3 16

4 32

Remote command: 
[:SOURce<hw>]:BB:LRWPan:EMLLd:SFD on page 128
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4.3.3  Data settings

Access:

► Select "Frame Configuration" > "Data".

The tab provides settings to configure physical data and physical header settings.
For "STS Packet Configuration" = 3, you cannot configure the "Data" settings.

PHY header and PHY payload coding

The data for the physical payload is segmented into code blocks for coding via the
Reed-Solomon coder. The PHY payload is split into four blocks according to the 330-
bits block length.
Table 4-7: PHY data length and code block segmentation

Frame Code block b

Number Length [byte] Length [bit] Number b1 [bit] b2 [bit] b3 [bit] b4 [bit]

1 1

to

41

8

to

328

1 8

to

328

0 0 0

2 42

to

82

336

to

656

2 330 6

to

326

0 0
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Frame Code block b

Number Length [byte] Length [bit] Number b1 [bit] b2 [bit] b3 [bit] b4 [bit]

3 83

to

123

664

to

984

3 330 330 4

to

324

0

4 124

to

127

992

to

1016

4 330 330 330 2

to

26

Settings:

Data Source.................................................................................................................. 55
Viterbi Rate....................................................................................................................56
Channel Code Type...................................................................................................... 56
MAC FCS...................................................................................................................... 57
MAC FCS Length.......................................................................................................... 57
MAC Header................................................................................................................. 57
Mean PRF..................................................................................................................... 57
Data Rate...................................................................................................................... 57
PHR Data Rate Mode................................................................................................... 58
PHR Bit Rate.................................................................................................................58
Data Length...................................................................................................................58
Maximum Data Length.................................................................................................. 58
PHR1 Codeword(hex)................................................................................................... 59
PHR2 Bit Rate...............................................................................................................59
Frame Length................................................................................................................59

Data Source
Selects the data source.
Note: The bit order of the output data bits is least significant bit (LSB) first and most
significant bit (MSB) last.
The following standard data sources are available:
● "All 0"/"All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to set the bit pattern.

● "Data List"/"Select Data List"
Binary data from a list file, internally or externally generated.
Select "Select Data List" to open the standard "Select List" dialog. The dialog lists
file with file extension *.dm_iqd if existing.
– Navigate to the list file and tap "Select" to select the file.
– Use the "New" and "Edit" functions to create a data list internally or to edit an

existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
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See also:
● Section "About data signals" in the R&S SMM100A user manual.
● Section "File and data management" in the R&S SMM100A user manual.
● Section "Data list editor" in the R&S SMM100A user manual.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA
on page 118
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA:
DSELection on page 118
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA:
PATTern on page 119

Viterbi Rate
For "Mode" > "802.15.4(HRP UWB)" / "802.15.4z-BPRF" / "802.15.4z-HPRF":
Displays the Viterbi rate for convolutional coding.
The rate is fixed to 0.5, except for "Chips Per Burst" > 1 it is 1.0.
For "Mode" > "802.15.4ab-HRP-UWB-EM+LLD":
Displays the Viterbi rate for the channel code type.
The rate is fixed to 0.5. For "Channel Code Type" > "LDPC", no Viterbi rate is dis-
played.
For "Mode" > "802.15.4ab-HRP-UWB-SENSING":
The rate is fixed to 0.5 for "Channel Code Type" > "CL3" / "CL7" (convolutional coding).
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:VRATe?
on page 127

Channel Code Type
Requires "Mode" > "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-HRP-UWB-SENS-
ING".
Sets the channel code type.
The channel code type depends on the selected "PHR Data Rate Mode".

"PHR Data Rate Mode" "Channel Code Type"

"DRMDR" "CL7"

"LDPC"

"DRHM_7p8"

"DRHM_31p2"

"CL3"

"CL7"

"DRHM_1p95"

"DRHM_62p4"

"DRHM_124p8"

"CL7"

Remote command: 
[:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:CCT on page 133
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MAC FCS
Activates the MAC frame check sequence (FCS) field.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MCS:
STATe on page 122

MAC FCS Length
Requires "MAC FCS > On".
Sets the length of the MAC frame check sequence (FCS) field.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MFL
on page 123

MAC Header
Accesses the "MAC Header Configuration" dialog to configure MAC header parame-
ters.
See Section 4.5, "MAC header configuration settings", on page 73.
If the MAC header is active, the button displays the length of the MAC header and the
MAC address.

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
STRing? on page 150

Mean PRF
Displays the mean pulse repetition frequency (PRF).
For "Mode" > "802.15.4(HRP UWB)" / "802.15.4z-BPRF":
The value depends on the hop bursts and the "PHR Data Rate Mode".
For "Mode" > "802.15.4z-HPRF":
The value depends on the "PHR Data Rate Mode".
For "Mode" > "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-HRP-UWB-SENSING":
The value depends on the "PHR Bit Rate" and the "PHR Data Rate Mode".
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MPRF?
on page 123

Data Rate
Displays the data rate.
In the mode "802.15.4-O-QPSK/ab-NB" the data rate is set automatically, depending
on the selected operating band and SFD.
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Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DR?
on page 119

PHR Data Rate Mode
Sets the data rate mode of the physical header.
Values: "DRHM_1p95" / "DRHM_7p8" / "DRHM_31p2" / "DRHM_62p4" /
"DRHM_124p8" / "DRMDR".
Remote command: 
[:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:PHR:DRM on page 133

PHR Bit Rate
Displays the bit rate of the physical header.
For "Mode" > "802.15.4(HRP UWB)" / "802.15.4z-BPRF", the value depends on the
chips per burst.
For "Mode" > "802.15.4-O-QPSK/ab-NB" the "PHR Bit Rate" equals the "Data Rate".
For "Mode" > "802.15.4z-HPRF" / "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-
HRP-UWB-SENSING"the "PHR Bit Rate" depends on the "PHR Data Rate Mode".
For "Mode" > "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-HRP-UWB-SENSING"
and "PHR Data Rate Mode" > "DRMDR", the "PHR Bit Rate" is not displayed.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:
PHRBrate? on page 124

Data Length
Sets the data length of the PHY header and PHY payload in octets.
PHY header and PHY payload data are segmented into code blocks for Reed-Solomon
encoding, see Table 4-2.
Table 4-8: Mode and maximum data length

Mode Maximum data length

"802.15.4(HRP UWB)" 127 octets

"802.15.4z-BPRF" 127 octets

"802.15.4z-HPRF" 4095 octets

"802.15.4-O-QPSK/ab-NB" 127 octets

"802.15.4ab-HRP-UWB-EM+LLD" 4095 octets

"802.15.4ab-HRP-UWB-SENSING" 4095 octets

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DALEngth
on page 119

Maximum Data Length
Requires "Mode" > "802.15.4z-HPRF" / "802.15.4ab-HRP-UWB-EM+LLD" /
"802.15.4ab-HRP-UWB-SENSING".
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Sets the maximum data length of the physical header.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MDL
on page 122

PHR1 Codeword(hex)
Requires "PHR Data Rate Mode" > "DRMDR".
Displays the PHR1 codeword in hexadecimal.
PHR1 encodes the PSDU coding type and the data rate of PHR2 and the PSDU.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:FCONfig:PHRO:CWORd? on page 133

PHR2 Bit Rate
Requires "PHR Data Rate Mode" > "DRMDR".
Selects the PHR2 bit rate depending on the PHR1 codeword.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:FCONfig:PHRT:BITRate
on page 133

Frame Length
Displays the frame length.
The frame length is the sum of the MAC header length, the MAC frame check
sequence (FCS) field length and the data length of the physical header.

Example: Frame lengths with enabled and disabled MAC parameters
By default, the frame length is 20 octets that are the data length of the physical header.
If you activate the MAC frame check sequence (FCS) field, the frame length increases.
Using the default "MAC FCS Length > 2 Octets", the frame length is 22 octets.
If you further activate the MAC header, the frame length increases. Using the default
"MAC Header > 11 Octets", the frame length is 33 octets.

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:FLENgth?
on page 120

4.3.4  STS settings

Access:

1. Select "Frame Configuration" > "General" > "STS Packet Configuration" >
"1"/"2"/"3".
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2. Select "Frame Configuration" > "STS".

The tab provides settings to configure the scrambled timestamp sequence (STS).

To select and import an STS data list

To import a binary data from an STS data list, internally or externally generated:

1. Activate "STS Source (MSB is Transmitted First)".

"Select STS Data List" is displayed.

2. Click "Select STS Data List" to access the standard "User Files" dialog.

a) Navigate to the list file (*.dm_iqd) and click "Select" to select an existing data
list.

b) Use the "New" and "Edit" functions to create internally a new data list or to edit
an existing one.

c) Use the standard "File Manager" function to transfer external data lists to the
instrument.

Settings:

STS Source (MSB is Transmitted First)........................................................................ 60
VUpper96(hex)..............................................................................................................61
VCounter(hex)...............................................................................................................61
Key(hex)........................................................................................................................61
Delta Length..................................................................................................................61
Active Segment Length................................................................................................. 61
Number of Active Segments......................................................................................... 61
Additional Gap between Payload and STS................................................................... 62

STS Source (MSB is Transmitted First)
Activates the scrambled timestamp sequence (STS) source. If activated, you can
select an STS data list from a designated folder to import a user-defined STS
sequence.
The bit order of the imported data is the most significant bit (MSB) first.
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How to: "To select and import an STS data list" on page 40
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:DLS on page 130
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:DATA:DSELection
on page 131

VUpper96(hex)
Sets the upper part of the V value. The value is a 96-bit value in hexadecimal repre-
sentation.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:UPARt on page 132

VCounter(hex)
Sets the counter part of the V value. The value is a 32-bit value in hexadecimal repre-
sentation.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:CPARt on page 131

Key(hex)
Sets the key value. The value is a 128-bit value in hexadecimal representation.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:KEY on page 132

Delta Length
Displays the delta length of the scrambled timestamp sequence (STS). The delta
length depends on the HRP UWB mode.

HRP UWB "Mode" "Delta length"

"802.15.4z-BPRF" "8"

"802.15.4z-HPRF" "4"

"802.15.4ab-HRP-UWB-MMS" "4"

"802.15.4ab-HRP-UWB-EM+LLD" "4"

"802.15.4ab-HRP-UWB-SENSING" "4"

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:STS:DLEN?
on page 131

Active Segment Length
Sets the active segment length in units of 512 chips (1 µs).
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:ASL on page 115

Number of Active Segments
Requires "Mode" > "802.15.4z-BPRF" / "802.15.4z-HPRF" / "802.15.4ab-HRP-UWB-
MMS" / "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-HRP-UWB-SENSING".
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Sets the number of up to four active segments.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:ASN on page 116

Additional Gap between Payload and STS
Requires "Mode" > "802.15.4z-HPRF" / "802.15.4ab-HRP-UWB-EM+LLD" and "STS
Packet Configuration" > "2".
Sets an additional gap between payload and STS.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd:FCONfig:ADDGap
on page 116

4.4  Sensing

Option: R&S SMM-K182

Access:

1. Select "Mode" > "802.15.4ab-HRP-UWB-SENSING".

2. Select the tab "Frame Configuration".

● General settings......................................................................................................62
● SYNC settings.........................................................................................................64
● Data settings........................................................................................................... 66
● SENS settings.........................................................................................................72

4.4.1  General settings

Access:

► Select "Frame Configuration" > "General".

Sensing
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The tab provides settings to configure the code index and the sensing (SENS)
packets of HRP UWB frames.

Settings:

Code Index....................................................................................................................63
SENS Packet Configuration.......................................................................................... 63
SENS Phase Duration...................................................................................................63
SENS Slot Duration.......................................................................................................63
SENS Start Offset......................................................................................................... 63
RSTU............................................................................................................................ 63

Code Index
Sets the code index that determines the code sequence.
Available code indexes depend on the channel number and mode, see "Channel Num-
ber" on page 27.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:CINDex
on page 117

SENS Packet Configuration
Selects the sensing packet configuration.
The sensing packets "0", "1", and "2" provide the sensing packet format according to
P802.15.4ab/D02.
The sensing packet "User-SENSactive" format provides no SYNC and no SFD field.
The format provides the SENS active packet in between two silent gaps.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:SENS:SPC on page 138

SENS Phase Duration
Sets the sensing phase duration.
You can configure how many sensing slots define a sensing phase.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:SENS:SPDuration on page 139

SENS Slot Duration
Sets the duration of a sensing slot in RSTU (ranging scheduling time unit).
Remote command: 
[:SOURce<hw>]:BB:LRWPan:SENS:SSDuration on page 139

SENS Start Offset
Sets an offset of a defined number of slots before the sensing phase starts.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:SENS:SSOFfset on page 139

RSTU
Displays the size of the ranging scheduling time unit.

Sensing
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The default value is 416 chips.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:SENS:RSTU? on page 138

4.4.2  SYNC settings

Access:

► Select "Frame Configuration" > "SYNC".

The tab provides settings to configure SYNC settings.

Settings:

Sync Length.................................................................................................................. 64
Delta Length..................................................................................................................64
SFD Length................................................................................................................... 65
SFD............................................................................................................................... 65

Sync Length
Sets the length of the SYNC field.
In the mode "802.15.4-O-QPSK/ab-NB" the sync length is set automatically, depending
on the selected operating band and SFD.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
SYNLength on page 126

Delta Length
Sets the delta length. The length depends on the HRP UWB mode and bandwidth.
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HRP UWB mode Bandwidth / MHz Delta length

802.15.4(HRP UWB) 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16

802.15.4z-BPRF 499.2

1081.6

1331.2

1354.97

4

802.15.4z-HPRF 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16

802.15.4ab-HRP-UWB-MMS 499.2

1081.6

1331.2

1354.97

4

4

4

4

802.15.4ab-HRP-UWB-EM+LLD 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16

802.15.4ab-HRP-UWB-SENSING 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
DLENgth on page 120

SFD Length
Displays the symbol length of the start-of-frame delimiter (SFD). The length depends
on the 802.15.4 mode, see Table 4-1.
In the mode "802.15.4-O-QPSK/ab-NB" the SFD length is 2.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
SFDLength? on page 125

SFD
Sets the start-of-frame delimiter (SFD) symbol sequence.
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Table 4-9: SFD and SFD length

SFD SFD length

1 4

2 8

3 16

4 32

Remote command: 
[:SOURce<hw>]:BB:LRWPan:SENS:SFD on page 129

4.4.3  Data settings

Requires: "Code Index" > "25" to "32" and "SENS Packet Configuration" > "1" / "2"

Access:

► Select "Frame Configuration" > "Data".

The tab provides settings to configure physical data and physical header settings.
For "STS Packet Configuration" = 3, you cannot configure the "Data" settings.
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PHY header and PHY payload coding

The data for the physical payload is segmented into code blocks for coding via the
Reed-Solomon coder. The PHY payload is split into four blocks according to the 330-
bits block length.
Table 4-10: PHY data length and code block segmentation

Frame Code block b

Number Length [byte] Length [bit] Number b1 [bit] b2 [bit] b3 [bit] b4 [bit]

1 1

to

41

8

to

328

1 8

to

328

0 0 0

2 42

to

82

336

to

656

2 330 6

to

326

0 0

3 83

to

123

664

to

984

3 330 330 4

to

324

0

4 124

to

127

992

to

1016

4 330 330 330 2

to

26

Settings:

Data Source.................................................................................................................. 67
Viterbi Rate....................................................................................................................68
Channel Code Type...................................................................................................... 68
MAC FCS...................................................................................................................... 69
MAC FCS Length.......................................................................................................... 69
MAC Header................................................................................................................. 69
Mean PRF..................................................................................................................... 69
Data Rate...................................................................................................................... 70
PHR Data Rate Mode................................................................................................... 70
PHR Bit Rate.................................................................................................................70
Data Length...................................................................................................................70
Maximum Data Length.................................................................................................. 71
PHR2 Bit Rate...............................................................................................................71
Frame Length................................................................................................................71

Data Source
Selects the data source.
Note: The bit order of the output data bits is least significant bit (LSB) first and most
significant bit (MSB) last.
The following standard data sources are available:
● "All 0"/"All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

Sensing
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An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to set the bit pattern.

● "Data List"/"Select Data List"
Binary data from a list file, internally or externally generated.
Select "Select Data List" to open the standard "Select List" dialog. The dialog lists
file with file extension *.dm_iqd if existing.
– Navigate to the list file and tap "Select" to select the file.
– Use the "New" and "Edit" functions to create a data list internally or to edit an

existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also:
● Section "About data signals" in the R&S SMM100A user manual.
● Section "File and data management" in the R&S SMM100A user manual.
● Section "Data list editor" in the R&S SMM100A user manual.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA
on page 118
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA:
DSELection on page 118
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA:
PATTern on page 119

Viterbi Rate
For "Mode" > "802.15.4(HRP UWB)" / "802.15.4z-BPRF" / "802.15.4z-HPRF":
Displays the Viterbi rate for convolutional coding.
The rate is fixed to 0.5, except for "Chips Per Burst" > 1 it is 1.0.
For "Mode" > "802.15.4ab-HRP-UWB-EM+LLD":
Displays the Viterbi rate for the channel code type.
The rate is fixed to 0.5. For "Channel Code Type" > "LDPC", no Viterbi rate is dis-
played.
For "Mode" > "802.15.4ab-HRP-UWB-SENSING":
The rate is fixed to 0.5 for "Channel Code Type" > "CL3" / "CL7" (convolutional coding).
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:VRATe?
on page 127

Channel Code Type
Requires "Mode" > "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-HRP-UWB-SENS-
ING".
Sets the channel code type.
The channel code type depends on the selected "PHR Data Rate Mode".

Sensing
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"PHR Data Rate Mode" "Channel Code Type"

"DRMDR" "CL7"

"LDPC"

"DRHM_7p8"

"DRHM_31p2"

"CL3"

"CL7"

"DRHM_1p95"

"DRHM_62p4"

"DRHM_124p8"

"CL7"

Remote command: 
[:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:CCT on page 133

MAC FCS
Activates the MAC frame check sequence (FCS) field.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MCS:
STATe on page 122

MAC FCS Length
Requires "MAC FCS > On".
Sets the length of the MAC frame check sequence (FCS) field.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MFL
on page 123

MAC Header
Accesses the "MAC Header Configuration" dialog to configure MAC header parame-
ters.
See Section 4.5, "MAC header configuration settings", on page 73.
If the MAC header is active, the button displays the length of the MAC header and the
MAC address.

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
STRing? on page 150

Mean PRF
Displays the mean pulse repetition frequency (PRF).
For "Mode" > "802.15.4(HRP UWB)" / "802.15.4z-BPRF":
The value depends on the hop bursts and the "PHR Data Rate Mode".
For "Mode" > "802.15.4z-HPRF":
The value depends on the "PHR Data Rate Mode".

Sensing
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For "Mode" > "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-HRP-UWB-SENSING":
The value depends on the "PHR Bit Rate" and the "PHR Data Rate Mode".
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MPRF?
on page 123

Data Rate
Displays the data rate.
In the mode "802.15.4-O-QPSK/ab-NB" the data rate is set automatically, depending
on the selected operating band and SFD.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DR?
on page 119

PHR Data Rate Mode
Sets the data rate mode of the physical header.
Values: "DRHM_1p95" / "DRHM_7p8" / "DRHM_31p2" / "DRHM_62p4" /
"DRHM_124p8" / "DRMDR".
Remote command: 
[:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:PHR:DRM on page 133

PHR Bit Rate
Displays the bit rate of the physical header.
For "Mode" > "802.15.4(HRP UWB)" / "802.15.4z-BPRF", the value depends on the
chips per burst.
For "Mode" > "802.15.4-O-QPSK/ab-NB" the "PHR Bit Rate" equals the "Data Rate".
For "Mode" > "802.15.4z-HPRF" / "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-
HRP-UWB-SENSING"the "PHR Bit Rate" depends on the "PHR Data Rate Mode".
For "Mode" > "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-HRP-UWB-SENSING"
and "PHR Data Rate Mode" > "DRMDR", the "PHR Bit Rate" is not displayed.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:
PHRBrate? on page 124

Data Length
Sets the data length of the PHY header and PHY payload in octets.
PHY header and PHY payload data are segmented into code blocks for Reed-Solomon
encoding, see Table 4-2.
Table 4-11: Mode and maximum data length

Mode Maximum data length

"802.15.4(HRP UWB)" 127 octets

"802.15.4z-BPRF" 127 octets

"802.15.4z-HPRF" 4095 octets
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Mode Maximum data length

"802.15.4-O-QPSK/ab-NB" 127 octets

"802.15.4ab-HRP-UWB-EM+LLD" 4095 octets

"802.15.4ab-HRP-UWB-SENSING" 4095 octets

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DALEngth
on page 119

Maximum Data Length
Requires "Mode" > "802.15.4z-HPRF" / "802.15.4ab-HRP-UWB-EM+LLD" /
"802.15.4ab-HRP-UWB-SENSING".
Sets the maximum data length of the physical header.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MDL
on page 122

PHR2 Bit Rate
Requires "PHR Data Rate Mode" > "DRMDR".
Selects the PHR2 bit rate depending on the PHR1 codeword.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:FCONfig:PHRT:BITRate
on page 133

Frame Length
Displays the frame length.
The frame length is the sum of the MAC header length, the MAC frame check
sequence (FCS) field length and the data length of the physical header.

Example: Frame lengths with enabled and disabled MAC parameters
By default, the frame length is 20 octets that are the data length of the physical header.
If you activate the MAC frame check sequence (FCS) field, the frame length increases.
Using the default "MAC FCS Length > 2 Octets", the frame length is 22 octets.
If you further activate the MAC header, the frame length increases. Using the default
"MAC Header > 11 Octets", the frame length is 33 octets.

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:FLENgth?
on page 120
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4.4.4  SENS settings

Access:

► Select "Frame Configuration" > "SENS".

The tab provides settings to configure the segments for sensing.

Settings:

Delta Length..................................................................................................................72
Active Segment Length................................................................................................. 72
Number of Active Segments......................................................................................... 73
Silent Gap..................................................................................................................... 73

Delta Length
Displays the delta length of the scrambled timestamp sequence (STS). The delta
length depends on the HRP UWB mode.

HRP UWB "Mode" "Delta length"

"802.15.4z-BPRF" "8"

"802.15.4z-HPRF" "4"

"802.15.4ab-HRP-UWB-MMS" "4"

"802.15.4ab-HRP-UWB-EM+LLD" "4"

"802.15.4ab-HRP-UWB-SENSING" "4"

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:STS:DLEN?
on page 131

Active Segment Length
Sets the active segment length in units of 512 chips (1 µs).
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:ASL on page 115

Sensing



Frame configuration settingsR&S®SMM-K149/-K180/-K181/-K182

73User Manual 1179.2083.02 ─ 11

Number of Active Segments
Requires "Mode" > "802.15.4z-BPRF" / "802.15.4z-HPRF" / "802.15.4ab-HRP-UWB-
MMS" / "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-HRP-UWB-SENSING".
Sets the number of up to four active segments.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:ASN on page 116

Silent Gap
Displays or sets the value of the gap before and after the SENS part in the sensing
package.
Setting the value requires "SENS Packet Configuration" > "User-SENSactive".
Remote command: 
[:SOURce<hw>]:BB:LRWPan:SENS:SGAP on page 138

4.5  MAC header configuration settings

Access:

► Select "Frame Configuration > Data > MAC Header".

The tab provides settings to configure the MAC header bits.

MAC Header................................................................................................................. 74
Frame Control............................................................................................................... 74

└ Frame Type.....................................................................................................74
└ Security Enabled.............................................................................................75
└ Frame Pending............................................................................................... 75
└ AR...................................................................................................................75
└ PAN ID Compression...................................................................................... 75
└ Reserved.........................................................................................................75
└ Sequence Number Suppression.....................................................................75
└ IE Present....................................................................................................... 75
└ Destination Addressing Mode.........................................................................76

MAC header configuration settings
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└ Frame Version.................................................................................................76
└ Source Addressing Mode................................................................................76

Sequence Number........................................................................................................ 76
Destination PAN ID........................................................................................................76
Destination Address...................................................................................................... 77
Source PAN ID.............................................................................................................. 77
Source Address.............................................................................................................77

MAC Header
Activates MAC header information.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:STATe
on page 149

Frame Control
Sets the length and the input value of the frame control field.
You can set lengths of 1 octet or 2 octets. The single bit field below ranges from least
significant bit (LSB) to most significant bit (MSB):
● 1 octet (8-bit): Set bits for fields "Frame Type" to "Reserved".
● 2 octets (16-bit): Set bits for fields "Frame Type" to "Source Addressing Mode".
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
LFRControl on page 145
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:CTRL
on page 142

Frame Type ← Frame Control
Sets the bits in the frame type field. The value is a 3-bit value, the field is the LSB part
of the frame control field.
Table 4-12: Frame type settings

Decimal value Binary values b2, b1, b0 Description

0 000 Beacon

1 001 Data

2 010 Acknowledgment

3 011 MAC command

4 100 Reserved

5 101 Multipurpose

6 110 Fragment or Frak

7 111 Extended

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:FTYPe
on page 143

MAC header configuration settings



Frame configuration settingsR&S®SMM-K149/-K180/-K181/-K182

75User Manual 1179.2083.02 ─ 11

Security Enabled ← Frame Control
Sets the bit in the security enabled field.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
SEENabled on page 148

Frame Pending ← Frame Control
Sets the bit in the frame pending field.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
FPENding on page 143

AR ← Frame Control
Sets the bit in the AR field. It specifies if an acknowledgment is required from the recip-
ient device on receipt of a data frame or MAC command.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:AR
on page 141

PAN ID Compression ← Frame Control
Sets the bit in the PAN ID compression field.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
PIDComp on page 147

Reserved ← Frame Control
Sets a reserved bit for future use.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
REServed on page 147

Sequence Number Suppression ← Frame Control
Requires frame control length of two octets.
Sets the bit in the sequence number suppression field.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
SENSupp on page 148

IE Present ← Frame Control
Requires frame control length of two octets.
Sets the bit in the information element (IE) present field.
The value is one, if the frame contains IEs and it is zero otherwise.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
IEPResent on page 144
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Destination Addressing Mode ← Frame Control
Requires frame control length of two octets.
Sets the bits in the destination addressing mode. The value is a 2-bit value.
Table 4-13: Destination/Source Addressing Mode field

Decimal value Binary values b1, b0 Description

0 00 PAN ID and address fields are not present

1 01 Reserved

2 10 Address field contains a short address (16 bit).

3 11 Address field contains an extended address (64 bit).

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
DADMode on page 142

Frame Version ← Frame Control
Requires frame control length of two octets.
Sets the bits in the frame version field. The value is a 2-bit value.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
FVERsion on page 144

Source Addressing Mode ← Frame Control
Requires frame control length of two octets.
Sets the bits in the source addressing mode field. The value is a 2-bit value.
For valid values to enter, see "Destination Addressing Mode" on page 76.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
SADMode on page 148

Sequence Number
Sets the length and the input value of the sequence number field. The value is in hexa-
decimal representation.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
LSEQnumber on page 146
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
SEQNumber on page 149

Destination PAN ID
Sets the length and the input value of the destination PAN ID field. The value is in hex-
adecimal representation.

MAC header configuration settings
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Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
LDEPanid on page 145
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DPANid
on page 143

Destination Address
Sets the length and the input values of the destination address field. The value is in
hexadecimal representation.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
LDADdress on page 144
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DADD
on page 142
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DAD2
on page 142
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DAD3
on page 142
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DAD4
on page 142

Source PAN ID
Sets the length and the input value of the source PAN ID field. The value is in hexadec-
imal representation.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
LSOPanid on page 146
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SPANid
on page 149

Source Address
Sets the length and the input values of the source address field. The value is in hexa-
decimal representation.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
LSADdress on page 145
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SADD
on page 147
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SAD2
on page 147
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SAD3
on page 147
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SAD4
on page 147

MAC header configuration settings
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5  MMS ranging configuration settings
Option: R&S SMM-K181

Access:

1. Select "Baseband" > "IEEE 802.15.4".

2. Select "Mode" > "802.15.4ab-HRP-UWB-MMS".

3. Select the tab "Ranging Configuration".

The dialog provides the settings for multi-millisecond ranging (MMS) configuration.

● General settings......................................................................................................78
● SYNC settings.........................................................................................................81
● STS settings............................................................................................................83
● RSF settings............................................................................................................85

5.1  General settings

Access:

► Select "Ranging Configuration" > "General".

The tab provides the settings to configure ranging phase and ranging packages.

General settings
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Settings:

Role...............................................................................................................................79
Ranging Phase Duration............................................................................................... 79
MMS Packet Format..................................................................................................... 79
Ranging Slot Duration................................................................................................... 80
Number of RSF Fragment.............................................................................................80
RSF Offset.....................................................................................................................80
Number of RIF Fragment.............................................................................................. 80
RIF Offset......................................................................................................................80
Timing/Frequency Synchronization...............................................................................80
RSTU............................................................................................................................ 80
Sync Sequence Code Index..........................................................................................80

Role
Sets the role for the MMS ranging round.
"Initiator" The initiator controls the ranging process between the devices. For

example, the initiator is responsible for the initiation of ranging, timing
control, message exchange and distance calculation.

"Responder" The responder is the complementary role to the initiator in the ranging
process. For example, the responder is responsible for receiving
requests, timing synchronization and generating and sending respon-
ses.

Remote command: 
[:SOURce<hw>]:BB:LRWPan:MMS:ROLE on page 135

Ranging Phase Duration
Sets the number of slots within the MMS ranging phase.
The available range of the ranging phase duration depends on the selected "MMS
Packet Format".
Remote command: 
[:SOURce<hw>]:BB:LRWPan:MMS:RPDuration on page 135

MMS Packet Format
Selects the packet format for multi-millisecond ranging.
"RSF" The MMS packet composed of ranging sequence fragments (RSF),

consisting of a repetition of a selected multi-millisecond ranging
sequence (MMRS) symbol.

"RIF" The MMS packet composed of ranging integrity fragments (RIF), con-
sisting of a sequence of active scrambled timestamp sequence (STS)
pulses.

"RSF+RIF" The MMS packet composed of both ranging sequence fragments and
ranging integrity fragments.

Remote command: 
[:SOURce<hw>]:BB:LRWPan:MMS:MPFormat on page 134

General settings
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Ranging Slot Duration
Selects the duration of each ranging slot in RSTU (ranging scheduling time unit).
A ranging slot refers to a specific time interval allocated for the transmission and recep-
tion of ranging messages between devices.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:MMS:RSDuration on page 136

Number of RSF Fragment
Sets the number of RSF fragments in the MMS ranging phase.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:MMS:NRSF on page 134

RSF Offset
Sets the number of slots after which the initiator starts to transmit the first RSF frag-
ment into the MMS ranging phase.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:MMS:RSOFfset on page 137

Number of RIF Fragment
Sets the number of RIF fragments in the MMS ranging phase.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:MMS:NRIF on page 134

RIF Offset
Requires "MMS Packet Format" > "RSF+RIF".
Displays the number of RSTU from the start of the last RSF fragment in the MMS rang-
ing phase after which the initiator starts to transmit the first RIF fragment into the MMS
ranging phase.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:MMS:RIOFfset? on page 135

Timing/Frequency Synchronization
Enables a fragment consisting of SYNC and SFD preceding the MMS ranging phase
for initial timing and frequency synchronization.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:MMS:TFSYnc on page 138

RSTU
Displays the size of the ranging scheduling time unit.
The default value is 416 chips.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:MMS:RSTU? on page 137

Sync Sequence Code Index
Requires "Time/Frequency Synchronization" is enabled.

General settings
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Displays or sets the code index used for the SYNC and SFD in the MMS packet,
depending on the "MMS Packet Format".
Remote command: 
[:SOURce<hw>]:BB:LRWPan:MMS:SSCI on page 137

5.2  SYNC settings

Requires "Time/Frequency Synchronization" is enabled.

Access:

► Select "Ranging Configuration" > "SYNC".

The tab provides settings to configure SYNC settings.

Settings:

Sync Length.................................................................................................................. 81
Delta Length..................................................................................................................81
SFD Length................................................................................................................... 82
SFD............................................................................................................................... 82

Sync Length
Sets the length of the SYNC field.
In the mode "802.15.4-O-QPSK/ab-NB" the sync length is set automatically, depending
on the selected operating band and SFD.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
SYNLength on page 126

Delta Length
Sets the delta length. The length depends on the HRP UWB mode and bandwidth.

SYNC settings
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HRP UWB mode Bandwidth / MHz Delta length

802.15.4(HRP UWB) 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16

802.15.4z-BPRF 499.2

1081.6

1331.2

1354.97

4

802.15.4z-HPRF 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16

802.15.4ab-HRP-UWB-MMS 499.2

1081.6

1331.2

1354.97

4

4

4

4

802.15.4ab-HRP-UWB-EM+LLD 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16

802.15.4ab-HRP-UWB-SENSING 499.2

1081.6

1331.2

1354.97

4, 16, 64

4, 16

4, 16

4, 16

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
DLENgth on page 120

SFD Length
Displays the symbol length of the start-of-frame delimiter (SFD). The length depends
on the 802.15.4 mode, see Table 4-1.
In the mode "802.15.4-O-QPSK/ab-NB" the SFD length is 2.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
SFDLength? on page 125

SFD
Sets the start-of-frame delimiter (SFD) symbol sequence.

SYNC settings
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Table 5-1: SFD and SFD length

SFD SFD length

0 8

1 4

2 8

3 16

4 32

Remote command: 
[:SOURce<hw>]:BB:LRWPan:MMS:SFD on page 128

5.3  STS settings

Requires: "MMS Packet Format" > "RIF" / "RSF+RIF".

Access:

► Select "Ranging Configuration" > "STS".

The tab provides settings to configure the scrambled timestamp sequence (STS).

To select and import an STS data list

To import a binary data from an STS data list, internally or externally generated:

1. Activate "STS Source (MSB is Transmitted First)".

"Select STS Data List" is displayed.

2. Click "Select STS Data List" to access the standard "User Files" dialog.

a) Navigate to the list file (*.dm_iqd) and click "Select" to select an existing data
list.

b) Use the "New" and "Edit" functions to create internally a new data list or to edit
an existing one.

STS settings
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c) Use the standard "File Manager" function to transfer external data lists to the
instrument.

Settings:

STS Source (MSB is Transmitted First)........................................................................ 84
VUpper96(hex)..............................................................................................................84
VCounter(hex)...............................................................................................................84
Key(hex)........................................................................................................................84
Delta Length..................................................................................................................84
Active Segment Length................................................................................................. 85
Number of Active Segments......................................................................................... 85

STS Source (MSB is Transmitted First)
Activates the scrambled timestamp sequence (STS) source. If activated, you can
select an STS data list from a designated folder to import a user-defined STS
sequence.
The bit order of the imported data is the most significant bit (MSB) first.
How to: "To select and import an STS data list" on page 40
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:DLS on page 130
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:DATA:DSELection
on page 131

VUpper96(hex)
Sets the upper part of the V value. The value is a 96-bit value in hexadecimal repre-
sentation.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:UPARt on page 132

VCounter(hex)
Sets the counter part of the V value. The value is a 32-bit value in hexadecimal repre-
sentation.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:CPARt on page 131

Key(hex)
Sets the key value. The value is a 128-bit value in hexadecimal representation.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:KEY on page 132

Delta Length
Displays the delta length of the scrambled timestamp sequence (STS). The delta
length depends on the HRP UWB mode.

STS settings
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HRP UWB "Mode" "Delta length"

"802.15.4z-BPRF" "8"

"802.15.4z-HPRF" "4"

"802.15.4ab-HRP-UWB-MMS" "4"

"802.15.4ab-HRP-UWB-EM+LLD" "4"

"802.15.4ab-HRP-UWB-SENSING" "4"

Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:STS:DLEN?
on page 131

Active Segment Length
Sets the active segment length in units of 512 chips (1 µs).
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:ASL on page 115

Number of Active Segments
Requires "Mode" > "802.15.4z-BPRF" / "802.15.4z-HPRF" / "802.15.4ab-HRP-UWB-
MMS" / "802.15.4ab-HRP-UWB-EM+LLD" / "802.15.4ab-HRP-UWB-SENSING".
Sets the number of up to four active segments.
Remote command: 
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:ASN on page 116

5.4  RSF settings

Access:

► Select "Ranging Configuration" > "RSF".

The tab provides settings to configure multi-millisecond ranging sequence (MMRS)
symbols in the ranging sequence fragment (RSF).

RSF settings
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Settings:

MMRS Code Index........................................................................................................86
MMRS Symbol Repetition............................................................................................. 86
MMRS Complementary Set Zeros................................................................................ 86

MMRS Code Index
Sets the code index that determines the multi-millisecond ranging sequence.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:MMS:RSF:MCINdex on page 136

MMRS Symbol Repetition
Sets the number for repetitions of the MMRS symbol in the ranging sequence frag-
ment.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:MMS:RSF:MSRepetition on page 137

MMRS Complementary Set Zeros
Requires "MMRS Code Index" > "33" or higher.
Sets the number of zeros for the optional gap in the complementary set of the MMRS
symbol.
Remote command: 
[:SOURce<hw>]:BB:LRWPan:MMS:RSF:MCSZeros on page 136

RSF settings
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6  Signal generation control

6.1  Filter/Clipping/ARB settings

Access:

► Select "General" > "Filter/Clipping/ARB".

The dialog provides settings to configure the baseband filter, to enable clipping and
adjust the sequence length of the arbitrary waveform component.

Settings:

● Filter settings...........................................................................................................87
● Clipping settings......................................................................................................92
● ARB settings........................................................................................................... 93

6.1.1  Filter settings

Access:

► Select "General" > "Filter/Clipping/ARB" >"Filter".

The tab provides settings to configure the baseband filter.

Settings:

Filter.............................................................................................................................. 88
Optimization.................................................................................................................. 88
Load User Filter.............................................................................................................89
Roll Off Factor or BxT....................................................................................................90
Cut Off Frequency Shift.................................................................................................91
Cut Off Frequency Factor..............................................................................................91
Oversampling................................................................................................................ 92
Sample Rate Variation...................................................................................................92
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Filter
Selects the baseband filter.
Additional to the built-in filters for custom digital modulation, you can select the default
filter type "802.15.4z". This filter is a root-raised cosine filter that is optimized for
"802.15.4z-BPRF" and "802.15.4z-HPRF" mode.
With option R&S SMM-K180 installed:
In "802.15.4-O-QPSK/ab-NB" mode, you can select the default filter type "O-QPSK",
which is a root-raised cosine filter that is optimized for this mode.
With option R&S SMM-K182 installed:
In "802.15.4ab-HRP-UWB-SENSING" mode, you can select the default filter type
"IEEE 802.15.4ab-SENS", which is a root-raised cosine filter that is optimized for this
mode.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:TYPE on page 154

Optimization
Selects one of the provided EUTRA/LTE filters.
Each filter is designed for a different application field and optimized for a particular per-
formance. Depending on the filter implementation, these filters require different calcula-
tion time. The applied upsampling factor also influences the size of the calculated out-
put waveform file.
Waveforms can be calculated in the following ways:
● With the "Generate Waveform File" function
● With the signal generation software R&S WinIQSIM2
The following table outlines the difference between the provided EUTRA/LTE filters by
comparing their major specifications.

Table 6-1: Overview of the EUTRA/LTE filters

Characteristic "Best EVM" "Best ACP"
"Best ACP (Narrow)"

"Best EVM (no upsampling)"

Design goal An excellent EVM perfor-
mance while ignoring the
effects on ACP

A combination of an excellent ACP
performance and a good EVM perfor-
mance

"Best ACP (Narrow)" features also a
smoother shape in frequency domain

A combination of an excellent
ACP performance and a good
EVM performance

Small output waveform file size

Calculation time (in
real-time processing)

By real-time processing,
short calculation time

Long calculation time: the filtered sig-
nal is precalculated because of the fil-
ter complexity

Long calculation time: the fil-
tered signal is precalculated
because of the filter complexity

Upsampling Upsampling with factor 2

The sample rate of the output
waveform is twice the LTE
sample rate

Upsampling with factor 2

The sample rate of the output wave-
form is twice the LTE sample rate

The signal processing requires twice
as much internal memory. The availa-
ble memory on the instrument is suffi-
cient for the simulation of half as many
frames compared to filter "Best EVM"

Upsampling is not applied

The sample rate of the output
waveform is not changed

Filter/Clipping/ARB settings
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Characteristic "Best EVM" "Best ACP"
"Best ACP (Narrow)"

"Best EVM (no upsampling)"

Output waveform file
size

Increased file size Increased file size File size is maintained

The resulting file size is smaller
than in the other cases

Recommended appli-
cation field

Receiver and performance
tests with internal real-time
generation, where BLER is
analyzed

Transmitter and components tests
where excellent ACP is required

Receiver and performance tests
with pre-generated waveform
files, where BLER is analyzed

In specific configurations, an internal ("Auto") filter is applied automatically. This filter is
designed for the best possible optimization in configurations, like the carrier aggrega-
tion with carriers that span different bandwidths.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:LTE:OPTimization
on page 156

Load User Filter
If Filter > "User" is selected, it opens the standard dialog "Select List File" for loading a
user-defined filter file.
User filters are used as offline filters. The following types are supported:
● Files with predefined file format and extensions *.vaf

For information, refer to the description "Introduction to "filtwiz" Filter Editor" on the
Rohde & Schwarz webpage.

● ASCII files with simple format and file extension *.dat
These files describe filters as a sequence of normalized filter coefficients. Each
coefficient is defined as a pair of I and Q samples. The I and Q components alter-
nate at each file line. The I and Q values vary between - 1 and + 1.
A user filter can contain up to 2560 coefficients.
The user filter must be real-valued. For both I and Q components of the coeffi-
cients, only real coefficients different than 0 are allowed.
You can create user filter files for example with MATLAB, see Example "Script that
generates a user filter file" on page 89.

Example: Script that generates a user filter file
This MATLAB script creates a user filter file that fits the LTE default settings: "Channel
Bandwidth = 10 MHz", "Number of Resource Blocks = 50", "FFT Size = 1024".

n_fft = 1048; %10MHz 
n_scs = 50*12; %50RBs*12 subcarriers per RB

trans_region = 0.02 * n_fft/2; %in %, controls steepness of filter slopes, 
relative to nyquist frequency

%cutoff frequencies
f = [n_scs/2 n_scs/2+trans_region];

%ripples in dB

Filter/Clipping/ARB settings
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rp = 0.01; %passband
rs = 80; %stopband
dev = [(10^(rp/20)-1)/(10^(rp/20)+1) 10^(-rs/20)];

%estimate filter order
[n,fo,ao,w] = firpmord(f,[1 0],dev,n_fft);

%generate filter coefficients
b = firpm(n,fo,ao,w);

fvtool(b); %displays filter response

%write filter out into .dat filter coefficient file
coeffs_out = zeros(2*length(b),1);
coeffs_out(1:2:end) = real(b);
coeffs_out(2:2:end) = imag(b);

dlmwrite(['smw_user_filter_' num2str(n) 'coeffs_' num2str(n_scs) 
'scs_' num2str(n_fft) 'fft.dat'],coeffs_out);

Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:USER on page 156

Roll Off Factor or BxT
Sets the rolloff factor or bandwidth time product ("B*T") for the filter type that supports
this parameter.
For supporting predefined filters, this parameter can have a different default value for
each of the predefined filters.

Figure 6-1: Example of the frequency response of a filter with different rolloff factors

For the default cosine filter, a rolloff factor of 0.10 is used.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:APCo25 on page 154
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:COSine on page 154
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:GAUSs on page 155
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:PGAuss on page 155
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:RCOSine on page 155
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[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:SPHase on page 155
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:LTE:ROFactor
on page 156

Cut Off Frequency Shift
Requires "Filter > Cosine" or "Filter > EUTRA/LTE" and "Optimization > Best EVM".
The cutoff frequency is a filter characteristic that defines the frequency at the 3 dB
down point. The "Cut Off Frequency Shift" affects this frequency in the way that the fil-
ter flanks are "moved" and the transition band increases by "Cut Off Frequency
Shift"*"Sample Rate".
● A "Cut Off Frequency Shift" = -1 results in a very narrow-band filter
● Increasing the value up to 1 makes the filter more broad-band
● By "Cut Off Frequency Shift" = 0, the -3 dB point is at the frequency determined by

the half of the selected "Sample Rate".
Tip: Use this parameter to adjust the cutoff frequency and reach spectrum mask
requirements.

Figure 6-2: Example of the frequency response of a filter with different cutoff frequency shift

Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:COSine:COFS
on page 156
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:LTE:COFS on page 156

Cut Off Frequency Factor
Requires "Filter > Lowpass" or "Filter > EUTRA/LTE" and "Optimization > Best ACP/
Best ACP (Narrow)".
Sets the value for the cutoff frequency factor. The cutoff frequency of the filter can be
adjusted to reach spectrum mask requirements.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:LPASs on page 155
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:LPASsevm on page 155
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:LTE:COFFactor
on page 155
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Oversampling
Sets the oversampling factor of the generated waveform.
A reduced sample rate saves significantly the amount of memory or allows an
increased signal cycle time, and vice versa.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:OSAMpling on page 154

Sample Rate Variation
Sets the sample rate of the signal.
A variation of this parameter only affects the ARB clock rate; all other signal parame-
ters remain unchanged. If the sampling rate in the frame configuration menu is
changed, this parameter is reset to the chosen sampling rate.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:SRATe:VARiation on page 157

6.1.2  Clipping settings

Access:

► Select "General > Filter/Clipping/ARB > Clipping".

The tab provides settings to configure clipping.

Settings:

Clipping State................................................................................................................92
Clipping Level................................................................................................................93
Clipping Mode............................................................................................................... 93

Clipping State
Switches baseband clipping on and off.
Baseband clipping is a simple and effective way of reducing the crest factor of the sig-
nal. Since clipping is done before to filtering, the procedure does not influence the
spectrum. The EVM however increases.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:CLIPping:STATe on page 158

Filter/Clipping/ARB settings



Signal generation controlR&S®SMM-K149/-K180/-K181/-K182

93User Manual 1179.2083.02 ─ 11

Clipping Level
Sets the limit for clipping.
This value indicates at what point the signal is clipped. It is specified as a percentage,
relative to the highest level. 100% indicates that clipping does not take place.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:CLIPping:LEVel on page 157

Clipping Mode
Selects the clipping method. The dialog displays a graphical illustration on how this two
methods work.
● "Vector | i + jq |"

The limit is related to the amplitude | i + q |. The I and Q components are mapped
together, the angle is retained.

● "Scalar | i | , | q |"
The limit is related to the absolute maximum of all the I and Q values | i | + | q |.
The I and Q components are mapped separately, the angle changes.

Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:CLIPping:MODE on page 158

6.1.3  ARB settings

Access:

► Select "General > Filter/Clipping/ARB > ARB".

The tab provides settings to configure the arbitrary waveform.

Settings:

Sequence Length
Changes the sequence length of the arbitrary waveform component of the signal. This
component is calculated in advance and output in the arbitrary waveform generator. It
is added to the real-time signal components.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:SLENgth on page 106
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6.2  Trigger settings

Access:

► Select "Baseband > HRP UWB > Trigger In".

The dialog provides settings to select and configure the trigger, like trigger source,
trigger delay, and to arm or trigger an internal trigger manually. The current signal
generation status is displayed in the header of the tab together with information on
the enabled trigger mode.

As in the "Marker" and "Clock" tabs, the tab also provides access to the settings of the
related connectors.

This section focuses on the available settings.
For detailed information, see section "Common characteristics of the baseband
domain" in the R&S SMM100A user manual.

The provided trigger signals are not dedicated to a particular connector. Trigger signals
can be mapped to one or more User x or T/M connectors.
Use the Local and global connectors settings to configure the signal mapping, the
polarity, the trigger threshold and the input impedance of the input connectors.
To route and enable a trigger signal, proceed as follows:
● Define the signal source and the effect of a trigger event.

Select "Trigger In" > "Mode" and "Trigger In" > "Source".
● Define the connector where the selected signal is provided.

Use the "Global Connectors" settings.

Settings:

Trigger Mode.................................................................................................................95
Time Based Trigger.......................................................................................................95
Trigger Time.................................................................................................................. 95
Signal Duration Unit...................................................................................................... 96
Signal Duration..............................................................................................................96
Running/Stopped.......................................................................................................... 96
Arm................................................................................................................................96
Execute Trigger.............................................................................................................96
Trigger Source...............................................................................................................96
Sync. Output to External Trigger/Sync. Output to Trigger.............................................97
External / Trigger Inhibit................................................................................................ 98

Trigger settings
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(External) Delay Unit..................................................................................................... 98
(Specified) External Delay/(Specified) Trigger Delay....................................................98
Actual Trigger Delay/Actual External Delay.................................................................. 98

Trigger Mode
Selects the trigger mode. The mode determines the effect of a trigger event on the sig-
nal generation.
For more information, see section "About trigger signals" in the R&S SMM100A user
manual.
● "Auto"

The signal is generated continuously.
● "Retrigger"

The signal is generated continuously. A trigger event (internal or external) causes a
restart.

● "Armed Auto"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously.
An "Arm" stops the signal generation. A subsequent trigger event (internal or exter-
nal) causes a restart.

● "Armed Retrigger"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously. Every subsequent trigger event causes a restart.
An "Arm" stops signal generation. A subsequent trigger event (internal or external)
causes a restart.

● "Single"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated once to the length specified at "Signal Duration".
Every subsequent trigger event (internal or external) causes a restart.

Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB[:TRIGger]:SEQuence on page 165

Time Based Trigger
Requires trigger "Mode" > "Armed Auto"/"Single".
Enables time-based triggering with a fixed time reference.
The R&S SMM100A triggers signal generation when its operating system time ("Cur-
rent Time") matches a specified time trigger ("Trigger Time"). As a trigger source, you
can use an internal trigger or an external global trigger.
How to: See section "Time-based triggering" in the R&S SMM100A user manual.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:TIME[:STATe] on page 160

Trigger Time
Requires trigger "Mode" > "Armed Auto"/"Single".
Sets date and time for a time-based trigger signal.
Set a trigger time that is later than the "Current Time". The current time is the operating
system time of the R&S SMM100A. If you set an earlier trigger time than the current
time, time-based triggering is not possible.

Trigger settings
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How to: See section "Time-based triggering" in the R&S SMM100A user manual.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:TIME:DATE on page 160
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:TIME:TIME on page 161

Signal Duration Unit
Defines the unit for describing the length of the signal sequence to be output in the
"Single" trigger mode.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:SLUNit on page 164

Signal Duration
Requires trigger "Mode" > "Single".
Enters the length of the trigger signal sequence.
Use this parameter, for example, for the following applications:
● To output the trigger signal partly.
● To output a predefined sequence of the trigger signal.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:SLENgth on page 164

Running/Stopped
With enabled modulation, displays the status of signal generation for all trigger modes.
● "Running"

The signal is generated; a trigger was (internally or externally) initiated in triggered
mode.

● "Stopped"
The signal is not generated and the instrument waits for a trigger event.

Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:RMODe? on page 163

Arm
Stops the signal generation until a subsequent trigger event occurs.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:ARM:EXECute on page 160

Execute Trigger
For internal trigger source, executes the trigger manually.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:EXECute on page 161

Trigger Source
The following sources of the trigger signal are available:
● "Internal"

The trigger event is internal. Tap "Execute Trigger" to trigger signal generation
manually.

● "External Global Trigger"

Trigger settings
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The trigger event is the active edge of an external trigger signal provided and con-
figured at the User x connectors.

● "Baseband Sync In"
Requires "Multi Instrument Trigger" > "Secondary" for primary-secondary instru-
ment mode.
Triggers signal generation at the secondary instrument by the active edge of the
baseband synchronization signal of the primary instrument.

Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:SOURce on page 164

Sync. Output to External Trigger/Sync. Output to Trigger
Requires the input of an external trigger signal.
Enables the baseband signal output that is synchronous to the trigger event. This func-
tion is enabled by default.
● "On"

The signal calculation starts simultaneously with the trigger event. Because of the
processing time of the instrument, the first samples are cut off and no signal is out-
put. After elapsing of the internal processing time, the output signal is synchronous
to the trigger event.

● "Off"
The signal output begins after elapsing of the processing time. Signal output starts
with sample 0. The complete signal is output.
This mode is recommended for triggering of short signal sequences. Short sequen-
ces are sequences with signal duration comparable with the processing time of the
instrument.

Trigger settings
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In primary-secondary instrument mode, this setting ensures that once achieved, syn-
chronization is not lost if the baseband signal sampling rate changes.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger[:EXTernal]:SYNC:OUTPut
on page 165

External / Trigger Inhibit
Requires an external trigger signal.
Sets a time period to suppress trigger events. A trigger event within this period does
not start or restart the signal generation.
After the time period expires, occurring trigger events start or restart the signal genera-
tion again.
For more information, see section "About common baseband characteristics" in the
user manual.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger[:EXTernal]:INHibit
on page 165

(External) Delay Unit
Determine whether the trigger delay is expressed in samples or directly defined as a
time period (seconds).
To specify the delay, use the parameter "(External) Trigger Delay/Specified Trigger
Delay".
The parameter Actual Trigger Delay/Actual External Delay displays the delay conver-
ted in time.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:DELay:UNIT on page 160

(Specified) External Delay/(Specified) Trigger Delay
The name of the parameter and the units the delay is expressed in, changes depend-
ing on the parameter "External Delay Unit".
Delays the trigger event of the signal from:
● The external trigger source
Use this setting to:
● Synchronize the instrument with the device under test (DUT) or other external devi-

ces.
The parameter "Actual Trigger Delay" displays the delay converted in time.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger[:EXTernal]:DELay on page 165
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:EXTernal:TDELay on page 162

Actual Trigger Delay/Actual External Delay
Displays the time (in seconds) an external trigger event or a trigger event from the
other path is delayed with.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:EXTernal:RDELay? on page 162

Trigger settings
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6.3  Marker settings

Access:

► Select "Baseband > HRP UWB > Marker".

The dialog provides settings to select and configure the marker output signal, like
marker mode and the marker delay.

This section focuses on the available settings.
For detailed information, see section "Common characteristics of the baseband
domain" in the R&S SMM100A user manual.

Routing and enabling a marker
The provided marker signals are not dedicated to a particular connector. They can be
mapped to one or more User x or T/M connectors.
To route and enable a marker signal, perform the following general steps:
● Define the shape of the generated marker, i.e. select the "Marker > Mode".
● Define the connector where the selected signal is provided.

Use the Local and global connectors settings.

Settings:

Marker Mode................................................................................................................. 99
Rise/Fall Offset............................................................................................................100
Marker x Delay............................................................................................................ 100

Marker Mode
Sets the marker mode that defines the shape and periodicity of the marker signal.
You can configure individual marker modes for each marker signal. The number of
available markers is 3. The marker configuration changes with the selected marker
mode.
"Restart(ARB)" A marker signal is generated at the start of each ARB sequence.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OUTPut<ch>:MODE on page 166

Marker settings
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Rise/Fall Offset
Requires "Marker Mode > Restart(ARB)".
Sets the value for the rise/fall offset.
The ramps of the marker signal are shifted by the specified number of samples. Posi-
tive values delay the rising ramp; negative values - shift it back.

1 = Positive rise offset
2 = Positive fall offset

Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OUTPut<ch>:ROFFset
on page 167
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OUTPut<ch>:FOFFset
on page 167

Marker x Delay
Delays the marker signal at the marker output relative to the signal generation start.
Variation of the parameter "Marker x" > "Delay" causes signal recalculation.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OUTPut<ch>:DELay on page 166

6.4  Clock settings

Access:

► Select "Baseband > HRP UWB > Clock".

Clock settings
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The tab provides settings necessary to select and configure the clock signal, like the
clock source and clock mode.

This section focuses on the available settings.
For detailed information, see section "Common characteristics of the baseband
domain" in the R&S SMM100A user manual.

Defining the clock
The provided clock signals are not dedicated to a particular connector. They can be
mapped to one or more User x and T/M/C connectors.
Use the Local and global connectors settings to configure the signal mapping, the
polarity, the trigger threshold, and the input impedance of the input connectors.
To route and enable a trigger signal, perform the following general steps:
● Define the signal source, that is select the "Clock > Source".
● Define the connector where the selected signal is provided.

Use the Local and global connectors settings.

Settings:

Clock Source...............................................................................................................101
Clock Mode................................................................................................................. 101

Clock Source
Selects the clock source.
● "Internal"

The instrument uses its internal clock reference.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:CLOCk:SOURce on page 168

Clock Mode
Sets the type of externally supplied clock.
Remote command: 
[:SOURce<hw>]:BB:LRWPan|HUWB:CLOCk:MODE on page 167

6.5  Local and global connectors settings

Opens a dialog to configure local connectors or global connectors.

The button is available in the following dialogs or tabs:
● "Trigger / Marker / Clock" dialog that is accessible via the "TMC" block in the block

diagram.
● "Trigger In", "Marker" and "Clock" tabs of baseband signal configuration dialogs

that you can open via the "Baseband" block in the block diagram. These tabs are
available, for example, for "ARB" baseband signals.

Local and global connectors settings
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See also section "Local and global connectors settings" in the user manual.

Local and global connectors settings
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7  Remote control commands
The following commands are required to generate signals with the HRP UWB option in
a remote environment. We assume that the R&S SMM100A has already been set up
for remote operation in a network as described in the R&S SMM100A documentation.
A knowledge about the remote control operation and the SCPI command syntax is
assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see
section "Remote-Control Commands" in the R&S SMM100A user manual.

Common suffixes

The following common suffixes are used in the remote commands:

Suffix Value range Description

SOURce<hw> 1 Available baseband signals

OUTPut<ch> 1 to 3 Available markers

Programming examples

This section provides simple programming examples. The purpose of the examples is
to present all commands for a given task. In real applications, you typically use an
appropriate subset of these commands.

For verification and testing purposes, a software tool executed these programming
examples. To keep the example as simple as possible, the examples report clean SCPI
syntax elements. Non-executable command lines, for example comments, start with
two characters //.

Before executing a SCPI sequence, most remote control programs reset or preset the
instrument to a definite state. The commands *RST and SYSTem:PRESet are equiva-
lent for this purpose. The command *CLS also resets the status registers and clears
the output buffer.

The following commands specific to the HRP UWB are described here:

● General commands...............................................................................................104
● Frame configuration commands............................................................................109
● MAC header commands....................................................................................... 140
● Impairments commands........................................................................................150
● Filter commands....................................................................................................151
● Clipping commands...............................................................................................157
● Trigger commands................................................................................................ 158
● Marker commands................................................................................................ 166
● Clock commands...................................................................................................167
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7.1  General commands

Example: To save the current configuration
SOURce1:BB:HUWB:SETTing:STORe "/var/user/my_settings"
*RST
SOURce1:BB:HUWB:SETTing:CATalog?
// Response: my_HUWB, HUWB
SOURce1:BB:HUWB:SETTing:LOAD "/var/user/HUWB"
SOURce1:BB:HUWB:STATe 1
SOURce1:BB:HUWB:SETTing:DEL "my_HUWB"
SOURce1:BB:HUWB:WAVeform:CREate "/var/user/my_HUWB_wv"

Example: To generate an HRP UWB signal
SOURce1:BB:HUWB:PRESet

SOURce1:BB:HUWB:STD HPRF
SOURce1:BB:HUWB:CNUMber 3
SOURce1:BB:HUWB:BWIDth?
// Response in MHz: 499.2
SOURce1:BB:HUWB:IINTerval 50
SOURce1:BB:HUWB:SLENgth 1
SOURce1:BB:HUWB:OSAMpling 4
SOURce1:BB:HUWB:SRATe:VARiation 500000
SOURce1:BB:HUWB:STATe 1
SOURce1:FREQuency:CW 4492800000
SOURce1:POWer:POWer -30
OUTPut1:STATe 1

Example: To generate a waveform
SOURce1:BB:HUWB:PRESet

SOURce1:BB:HUWB:STD HPRF
SOURce1:BB:HUWB:CNUMber 3
SOURce1:BB:HUWB:BWIDth?
// Response in MHz: 499.2
// To generate a waveform with fixed frame length of 2 ms.
SOURce:BB:HUWB:F2MS 1
// Sets the frame length to 2 ms 
// Idle interval = 0µs is the default value if frame length 2 ms is activated
SOURce1:BB:HUWB:IINTerval?
// Response is 0
SOURce1:BB:HUWB:SLENgth 1
SOURce1:BB:HUWB:FILTer:OSAMpling OS_4
SOURce1:BB:HUWB:SRATe:VARiation 500000
SOURce1:BB:HUWB:STATe 1
SOURce1:FREQuency:CW 4492800000

General commands
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SOURce1:POWer:POWer -30
OUTPut1:STATe 1

[:SOURce<hw>]:BB:LRWPan|HUWB:PRESet...................................................................105
[:SOURce<hw>]:BB:LRWPan|HUWB:STATe.....................................................................105
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:SETTing:CATalog.................. 105
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:SETTing:DELete........... 106
[:SOURce<hw>]:BB:LRWPan|HUWB:SETTing:LOAD........................................................106
[:SOURce<hw>]:BB:LRWPan|HUWB:SETTing:STORe...................................................... 106
[:SOURce<hw>]:BB:LRWPan|HUWB:SLENgth................................................................. 106
[:SOURce<hw>]:BB:LRWPan|HUWB:WAVeform:CREate...................................................107
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:BWIDth?...................... 107
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:CNUMber.....................107
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:F2MS...........................107
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:IINTerval.......................108
[:SOURce<hw>]:BB:LRWPan|HUWB:STD........................................................................108
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:OBANd......................................................109

[:SOURce<hw>]:BB:LRWPan|HUWB:PRESet

Sets all parameters of the application to their default values. These values are the
*RST values of the commands of the application.

Example: See Example "To generate an HRP UWB signal" on page 104.

Usage: Event

Manual operation: See "Set to Default" on page 25

[:SOURce<hw>]:BB:LRWPan|HUWB:STATe <HrpUwbState>

Enables the baseband signal application and disables all the other baseband signal
applications in the same signal path.

Parameters:
<HrpUwbState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "To generate an HRP UWB signal" on page 104.

Manual operation: See "State" on page 25

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:SETTing:CATalog

Queries the files with settings in the default directory. Listed are files with the file exten-
sion *.hrpuwb.

Example: See Example "To save the current configuration" on page 104.

Manual operation: See "Save/Recall" on page 25

General commands
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[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:SETTing:
DELete <Filename>

Deletes the selected file from the default or the specified directory. Deleted are files
with extension *.hrpuwb.

Parameters:
<Filename> string

Example: See Example "To save the current configuration" on page 104.

Manual operation: See "Save/Recall" on page 25

[:SOURce<hw>]:BB:LRWPan|HUWB:SETTing:LOAD <Filename>

Loads the selected file from the default or the specified directory. Loaded are files with
extension *.hrpuwb.

Parameters:
<Filename> string

Example: See Example "To save the current configuration" on page 104.

Manual operation: See "Save/Recall" on page 25

[:SOURce<hw>]:BB:LRWPan|HUWB:SETTing:STORe <Filename>

Saves the current settings into the selected file; the file extension (*.hrpuwb) is
assigned automatically.

Parameters:
<Filename> string

Example: See Example "To save the current configuration" on page 104.

Manual operation: See "Save/Recall" on page 25

[:SOURce<hw>]:BB:LRWPan|HUWB:SLENgth <SLength>

Sets the sequence length of the signal in number of frames. The signal is calculated in
advance and output in the arbitrary waveform generator. The maximum number of
frames is calculated as follows:

Max. No. of Frames = Arbitrary waveform memory size/(sampling rate x 10 ms).

Parameters:
<SLength> integer

Range: 1  to  1024
*RST: 1

Example: SOURce1:BB:HUWB:SLENgth 4
Selects the generation of 4 frames.

Manual operation: See "Sequence Length" on page 93

General commands
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[:SOURce<hw>]:BB:LRWPan|HUWB:WAVeform:CREate <Filename>

Saves the current settings as an ARB signal in a waveform file (*.wv).

Parameters:
<Filename> string

Example: See Example "To save the current configuration" on page 104.

Manual operation: See "Generate Waveform File" on page 26

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:BWIDth?

Queries the channel bandwidth.

The bandwidth depends on the channel number.

Example: See Example "To generate an HRP UWB signal" on page 104.

Usage: Query only

Manual operation: See "Bandwidth" on page 28

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:CNUMber
<ChannelNumber>

Sets the channel number that is a 4-bit value in decimal representation.

The channel number determines the bandwidth and the code index.

Parameters:
<ChannelNumber> integer

Range: 0  to  15
*RST: 0

Example: See Example "To configure non-HRP UWB frames"
on page 109.

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Manual operation: See "Channel Number" on page 27

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:F2MS
<Fixed2msFrame>

Sets the frame length of a generated waveform shorter than 2 ms to a fixed value of 2
ms.

If activated, the idle interval is set to 0.0 µs by default. Generated waveforms longer
than 2 ms remain unaffected.

General commands
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Parameters:
<Fixed2msFrame> 1 | ON | 0 | OFF

*RST: 0

Example: Example "To generate a waveform" on page 104

Manual operation: See "Fixed 2 ms Frame Length" on page 28

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:IINTerval
<IInterval>

Sets the time of the interval separating two frames.

Parameters:
<IInterval> float

Range: 0  to  1000000
Increment: 0.1
*RST: 50
Default unit: µs

Example: See Example "To generate an HRP UWB signal" on page 104.

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Manual operation: See "Idle Interval" on page 28

[:SOURce<hw>]:BB:LRWPan|HUWB:STD <Mode>

Sets the 802.15.4 mode.

Parameters:
<Mode> | NONHRP | BPRF | HPRF | OQPSK | MMS | EHPRF | SENS |

SYNSFD
NONHRP
Enables HRP non-ERDEV mode.
BPRF
Enables HRP-ERDEV base pulse repetition frequency (BPRF)
mode.
HPRF
Enables HRP-ERDEV higher pulse repetition frequency (HPRF)
mode.
OQPSK
Requires R&S SMM-K180.
Enables 802.15.4 with O-QPSK modulation mode.
MMS
Requires R&S SMM-K181.
Enables multi-millisecond advanced ranging (MMS) mode.

General commands



Remote control commandsR&S®SMM-K149/-K180/-K181/-K182

109User Manual 1179.2083.02 ─ 11

EHPRF
Requires R&S SMM-K181.
Enables enhanced modulation and low latency (EM+LLD) mode
SENS
Requires R&S SMM-K182.
Enables sensing mode.
SYNSFD
Enables SYN+SFD mode. The SYN packet and the SFD packet
without the DATA part is sent.
*RST: NONHRP

Example: See Example "To generate an HRP UWB signal" on page 104.

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Manual operation: See "Mode" on page 26

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:OBANd <OperBand>

Requires R&S SMM-K180.

Sets the operating band for 802.15.4 with O-QPSK modulation.

Parameters:
<OperBand> OB780 | OB868 | OB915 | OB2380 | OB2450 | OB5800 |

OB6200
*RST: OB780

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Manual operation: See "Operating Band" on page 28

7.2  Frame configuration commands

Example: To configure non-HRP UWB frames
SOURce1:BB:HUWB:PRESet
SOURce1:BB:HUWB:STD NONHRP
SOURce1:BB:HUWB:CNUMber 4
SOURce1:BB:HUWB:BWIDth?
// Response in MHz: 1331.2
SOURce1:BB:HUWB:FCONfig:CINDex CI_7

// Configure SYNC parameters.
SOURce1:BB:HUWB:FCONfig:SYNLength SL_16
SOURce1:BB:HUWB:FCONfig:DLENgth DL_16
SOURce1:BB:HUWB:FCONfig:SFDLength?
// Response: SFDL_8

Frame configuration commands
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// Configure physical data and physical header parameters.
SOURce1:BB:HUWB:FCONfig:DATA PN9
SOURce1:BB:HUWB:FCONfig:HOPBurst HB_8
SOURce1:BB:HUWB:FCONfig:CPBurst CPB_2
SOURce1:BB:HUWB:FCONfig:VRATe?
// Response: 0.5
SOURce1:BB:HUWB:FCONfig:CPBurst CPB_1
SOURce1:BB:HUWB:FCONfig:VRATe?
// Response: 1.0
SOURce1:BB:HUWB:FCONfig:MCS:STATe 1
SOURce1:BB:HUWB:FCONfig:MFL MFL_2
// Sets a MAC FCS length of two octets.
SOURce1:BB:HUWB:FCONfig:MPRF?
// Response in MHz: 15.6
SOURce1:BB:HUWB:FCONfig:DR?
// Response in Mb/s: 27.24
SOURce1:BB:HUWB:FCONfig:PHRBrate?
// Response in Mb/s: 0.85
SOURce1:BB:HUWB:FCONfig:DALEngth 127

Example: To configure HRP UWB 802.15.4z-BPRF frames
SOURce1:BB:HUWB:PRESet
SOURce1:BB:HUWB:STD BPRF
SOURce1:BB:HUWB:CNUMber 3
SOURce1:BB:HUWB:BWIDth?
// Response in MHz: 499.2
SOURce1:BB:HUWB:FCONfig:CINDex CI_7

// Configure SYNC parameters.
SOURce1:BB:HUWB:FCONfig:SYNLength SL_64
SOURce1:BB:HUWB:FCONfig:DLENgth DL_4
SOURce1:BB:HUWB:SFD SFD_2
SOURce1:BB:HUWB:FCONfig:SFDLength?
// Response: SFDL_8

// Configure physical data and physical header parameters.
SOURce1:BB:HUWB:FCONfig:DATA PN9
SOURce1:BB:HUWB:FCONfig:HOPBurst HB_2
SOURce1:BB:HUWB:FCONfig:CPBurst CPB_8
SOURce1:BB:HUWB:FCONfig:VRATe?
// Response: 0.5
SOURce1:BB:HUWB:FCONfig:MCS:STATe 1
SOURce1:BB:HUWB:FCONfig:MFL MFL_2
// Sets a MAC FCS length of two octets.
SOURce1:BB:HUWB:FCONfig:MPRF?
// Response in MHz: 62.4
SOURce1:BB:HUWB:FCONfig:DR?
// Response in Mb/s: 6.81
SOURce1:BB:HUWB:FCONfig:PHRBrate?

Frame configuration commands
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// Response in Mb/s: 7.8
SOURce1:BB:HUWB:FCONfig:DALEngth 1

// Configure scrambled timestamp sequence (STS) parameters.
SOURce1:BB:HUWB:STS:PC SPC_3
SOURce1:BB:HUWB:STS:UPARt #H362EEB34C44FA8FBD37EC3CA,96
SOURce1:BB:HUWB:STS:CPARt #H1F9A3DE4,32
SOURce1:BB:HUWB:STS:KEY #H14148674D1D336AAF86050A814EB220F,128
SOURce1:BB:HUWB:STS:DLEN
// Response: DL_8
SOURce1:BB:HUWB:ASL ASL_64
SOURce1:BB:HUWB:ASN ASN_1

Example: To configure HRP UWB 802.15.4z-HPRF frames
SOURce1:BB:HUWB:PRESet
SOURce1:BB:HUWB:STD HPRF
SOURce1:BB:HUWB:CNUMber 7
SOURce1:BB:HUWB:BWIDth?
// Response in MHz: 1081.6
SOURce1:BB:HUWB:FCONfig:CINDex CI_8

// Configure SYNC parameters.
SOURce1:BB:HUWB:FCONfig:SYNLength SL_16
SOURce1:BB:HUWB:FCONfig:DLENgth DL_16
SOURce1:BB:HUWB:SFD SFD_4
SOURce1:BB:HUWB:FCONfig:SFDLength?
// Response: SFDL_32

// Configure physical data and physical header parameters.
SOURce1:BB:HUWB:FCONfig:DATA PN9
SOURce1:BB:HUWB:FCONfig:VRATe?
// Response: 0.5
SOURce1:BB:HUWB:CCCL CL7
SOURce1:BB:HUWB:FCONfig:MCS:STATe 1
SOURce1:BB:HUWB:FCONfig:MFL MFL_2
// Sets a MAC FCS length of two octets.
SOURce1:BB:HUWB:FCONfig:MPRF?
// Response in MHz: 15.6
SOURce1:BB:HUWB:FCONfig:DR?
// Response in Mb/s: 31.2
SOURce1:BB:HUWB:FCONfig:PHRBrate?
// Response in Mb/s: 31.2
SOURce1:BB:HUWB:FCONfig:DALEngth 20

// Configure scrambled timestamp sequence (STS) parameters.
SOURce1:BB:HUWB:STS:PC SPC_3
SOURce1:BB:HUWB:STS:UPARt #H362EEB34C44FA8FBD37EC3CA,96
SOURce1:BB:HUWB:STS:CPARt #H1F9A3DE4,32
SOURce1:BB:HUWB:STS:KEY #H14148674D1D336AAF86050A814EB220F,128
SOURce1:BB:HUWB:STS:DLEN
// Response: DL_4

Frame configuration commands
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SOURce1:BB:HUWB:ASL ASL_256
SOURce1:BB:HUWB:ASN ASN_4

SOURce1:BB:HUWB:FCONfig:DALength?
// Response: 1023
// The data length is 1023 octets.
SOURce1:BB:HUWB:STS:PC SPC_2
SOURce1:BB:HUWB:FCONfig:ADDGap?
// Response: 0
// Set an additional gap of one octet.
SOURce1:BB:HUWB:FCONfig:ADDGap 1
// The maximum data length decreases to 1023 octets.
SOURce1:BB:HUWB:FCONfig:DALEngth?
// Response: 1022

Frame configuration commands
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Example: To configure and monitor 802.15.4-O-QPSK/ab-NB frames
Option: R&S SMM-K180

// Set the mode to O-QPSK and set the operating band
SOURce1:BB:HUWB:STD OQPSK
SOURce1:BB:HUWB:OBANd OB2380
// Check the idle interval
SOURce1:BB:HUWB:IINTerval?
// Response in µs: 50

// Configure and check the SYNC parameters
SOURce1:BB:HUWB:SFD SFD_0
SOURce1:BB:HUWB:FCONfig:SYNLength?
// Response: SL_8
SOURce1:BB:HUWB:FCONfig:SFDLength?
// Response: SFDL_2
SOURce1:BB:HUWB:FCONfig:PHRLength?
// Response: PHL_2 
SOURce1:BB:HUWB:FCONfig:SFShr?
// Response: SFA_32
SOURce1:BB:HUWB:FCONfig:FPhr:STATe?
// Response: 0

// Configure and check the Data parameters

// Configure and check the physical data parameters
SOURce1:BB:HUWB:FCONfig:DATA DLIS
SOURce1:BB:HUWB:FCONfig:DATA:DSELection "/var/user/test"
SOURce1:BB:HUWB:FCONfig:MCS:STATe 1
SOURce1:BB:HUWB:FCONfig:MFL MFL_4
SOURce1:BB:HUWB:MACHeader:STATe 1
SOURce1:BB:HUWB:FCONfig:SFPAYLoad?
// Response: SFA_32
SOURce1:BB:HUWB:FCONfig:FPAYload:STATe?
// Response: 0
SOURce1:BB:HUWB:FCONfig:DR?
// Response in MBit/s: 0.25
SOURce1:BB:HUWB:FCONfig:SYMRate?
// Response in KSymbol/s: 62.5

// Configure and check the physical header parameters
SOURce1:BB:HUWB:FCONfig:DALEngth 20
SOURce1:BB:HUWB:FCONfig:PHRBrate?
// Response in MBit/s: 0.25

// Check the frame parameters
SOURce1:BB:HUWB:FCONfig:FLENgth?
// Response in octets: 35

// Example to set data source "pattern":
SOURce1:BB:HUWB:FCONfig:DATA PATT
SOURce1:BB:HUWB:FCONfig:DATA:PATTern #H8F,8

Frame configuration commands
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Example: To modify and monitor frame lengths
SOURce1:BB:HUWB:STD NONHRP
SOURce1:BB:HUWB:FCONfig:DALength?
// Response in octets: "20"
SOURce1:BB:HUWB:FCONfig:FLENgth?
// Response in octets: "20"
// The frame length equals the data length of the physical header.

// Activate MAC frame check sequence field and set a length of four octets.
SOURce1:BB:HUWB:FCONfig:MCS:STATe 1
SOURce1:BB:HUWB:FCONfig:MFL MFL_4
SOURce1:BB:HUWB:FCONfig:FLENgth?
// Response in octets: "24"
Activate MAC header and use the default length of 11 octets.
SOURce1:BB:HUWB:MACHeader:STATe 1
SOURce1:BB:HUWB:FCONfig:FLENgth?
// Response in octets: "35"

// You can further increase the frame length in mode 802.15.4z-HPRF.
SOURce1:BB:HUWB:STD HPRF
// Set the maximum data length to 1023 octets.
SOURce1:BB:HUWB:FCONfig:MDL MDL_1023
SOURce1:BB:HUWB:FCONfig:DALEngth 1023
SOURce1:BB:HUWB:FCONfig:FLENgth?
// Response in octets: "1038"
// Comprising 1023 octets data length, four octets FCS length and 
// 11 octets MAC header length.

[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:ASL......................................... 115
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:ASN.........................................116
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:CCCL........................................................116
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd:FCONfig:ADDGap........................... 116
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:CINDex................... 117
[:SOURce<hw>]:BB[:LRWPan]:HUWB:FCONfig:CPBurst................................................... 117
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA...................... 118
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA:DSELection.... 118
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA:PATTern......... 119
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DR?........................ 119
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DALEngth................119
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:DLENgth.........120
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:FLENgth?................120
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:FPAYload:STATe?.........................121
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:FPhr:STATe?................................ 121
[:SOURce<hw>]:BB[:LRWPan]:HUWB:FCONfig:HOPBurst................................................ 122
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MCS:STATe.............122
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MDL....................... 122
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MFL........................123
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MPRF?................... 123
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:PHRBrate?..............124
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:PHRLength?................................ 124
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:SFDLength?....125
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[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:SFPAYLoad?................................125
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:SFShr?........................................ 126
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:SYMRate?................................... 126
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:SYNLength..... 126
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:VRATe?...................127
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:PHR:DRM................................................. 127
[:SOURce<hw>]:BB:LRWPan:EMLLd:SFD....................................................................... 128
[:SOURce<hw>]:BB:LRWPan:MMS:SFD..........................................................................128
[:SOURce<hw>]:BB:LRWPan:OQPSk:SFD.......................................................................128
[:SOURce<hw>]:BB:LRWPan:SENS:SFD.........................................................................129
[:SOURce<hw>]:BB[:LRWPan]:HUWB:SFD......................................................................129
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:SFD:USRState..............130
[:SOURce<hw>]:BB:LRWPan:OQPSk:CINDex..................................................................130
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:DLS........................................... 130
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:DATA:DSELection....................... 131
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:CPARt........................................131
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:STS:DLEN?..............................131
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:KEY........................................... 132
[:SOURce<hw>]:BB[:LRWPan]:HUWB|EMLLd:STS:PC......................................................132
[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:UPARt........................................132
[:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:CCT............................................................. 133
[:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:FCONfig:PHRO:CWORd?.............................. 133
[:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:FCONfig:PHRT:BITRate................................. 133
[:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:PHR:DRM.....................................................133
[:SOURce<hw>]:BB:LRWPan:HUWB|MMS|EMLLd|SENS:SRF.......................................... 134
[:SOURce<hw>]:BB:LRWPan:MMS:MPFormat................................................................. 134
[:SOURce<hw>]:BB:LRWPan:MMS:NRIF.........................................................................134
[:SOURce<hw>]:BB:LRWPan:MMS:NRSF........................................................................134
[:SOURce<hw>]:BB:LRWPan:MMS:RIOFfset?..................................................................135
[:SOURce<hw>]:BB:LRWPan:MMS:ROLE........................................................................135
[:SOURce<hw>]:BB:LRWPan:MMS:RPDuration................................................................135
[:SOURce<hw>]:BB:LRWPan:MMS:RSDuration................................................................136
[:SOURce<hw>]:BB:LRWPan:MMS:RSF:MCINdex............................................................136
[:SOURce<hw>]:BB:LRWPan:MMS:RSF:MCSZeros..........................................................136
[:SOURce<hw>]:BB:LRWPan:MMS:RSF:MSRepetition......................................................137
[:SOURce<hw>]:BB:LRWPan:MMS:RSOFfset.................................................................. 137
[:SOURce<hw>]:BB:LRWPan:MMS:RSTU?......................................................................137
[:SOURce<hw>]:BB:LRWPan:MMS:SSCI.........................................................................137
[:SOURce<hw>]:BB:LRWPan:MMS:TFSYnc.....................................................................138
[:SOURce<hw>]:BB:LRWPan:SENS:RSTU?.....................................................................138
[:SOURce<hw>]:BB:LRWPan:SENS:SGAP...................................................................... 138
[:SOURce<hw>]:BB:LRWPan:SENS:SPC.........................................................................138
[:SOURce<hw>]:BB:LRWPan:SENS:SPDuration...............................................................139
[:SOURce<hw>]:BB:LRWPan:SENS:SSDuration...............................................................139
[:SOURce<hw>]:BB:LRWPan:SENS:SSOFfset................................................................. 139

[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:ASL <ActSegLength>

Sets the active segment length.
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Parameters:
<ActSegLength> ASL_16 | ASL_32 | ASL_64 | ASL_128 | ASL_256 | ASL_512 |

ASL_1024 | ASL_2048
*RST: ASL_32

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Manual operation: See "Active Segment Length" on page 41

[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:ASN <AcgSegNumber>

Requires [:SOURce<hw>]:BB:LRWPan|HUWB:STD BPRF|HPRF|EHPRF|SENS.

Sets the number of active segments.

Parameters:
<AcgSegNumber> ASN_1 | ASN_2 | ASN_3 | ASN_4

*RST: ASN_1

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Manual operation: See "Number of Active Segments" on page 41

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:CCCL <CCCL>

Sets the constraint length of the convolutional code.

Parameters:
<CCCL> CL3 | CL7

*RST: CL3

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Manual operation: See "Convolutional Code Constraint Length" on page 36

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd:FCONfig:ADDGap
<AdditionalGap>

Requires [:SOURce<hw>]:BB:LRWPan|HUWB:STD HPRF|EHPRF and
[:SOURce<hw>]:BB[:LRWPan]:HUWB|EMLLd:STS:PC > SPC_2.

Sets an additional gap between payload and STS.
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Parameters:
<AdditionalGap> integer

Range: 0  to  127
*RST: 0

Example: See Example "To configure non-HRP UWB frames"
on page 109.

Manual operation: See "Additional Gap between Payload and STS" on page 42

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:CINDex
<CodeIndex>

Sets the code index.

Parameters:
<CodeIndex> CI_1 | CI_2 | CI_3 | CI_4 | CI_5 | CI_6 | CI_7 | CI_8 | CI_9 |

CI_10 | CI_11 | CI_12 | CI_13 | CI_14 | CI_15 | CI_16 | CI_17 |
CI_18 | CI_19 | CI_20 | CI_21 | CI_22 | CI_23 | CI_24 | CI_25 |
CI_26 | CI_27 | CI_28 | CI_29 | CI_30 | CI_31 | CI_32
*RST: CI_1

Example: See Example "To configure non-HRP UWB frames"
on page 109.

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Manual operation: See "Code Index" on page 31

[:SOURce<hw>]:BB[:LRWPan]:HUWB:FCONfig:CPBurst <ChipsPerBurst>

Sets the chips per burst.

Parameters:
<ChipsPerBurst> CPB_1 | CPB_2 | CPB_4 | CPB_16 | CPB_8 | CPB_32 |

CPB_64 | CPB_128 | CPB_512
*RST: CPB_8

Example: See Example "To configure non-HRP UWB frames"
on page 109.

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Manual operation: See "Chips Per Burst" on page 37
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[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA
<DataSource>

Sets the data source for the payload data in a frame.

Parameters:
<DataSource> PN9 | PN11 | PN15 | PN20 | PN16 | PN21 | PN23 | ONE |

ZERO | DLISt | PATT
PNxx
The pseudo-random sequence generator is used as the data
source. There is a choice of different lengths of random
sequence.
DLISt
A data list is used. The data list is selected with the aid of com-
mand SOURce1:BB:HUWB:DATA DLISt.
ZERO|ONE
Internal 0 or 1 data is used.
PATT
Internal data is used. The bit pattern for the data is defined with
the aid of command SOURce1:BB:HUWB:DATA:PATTern.
*RST: PN9

Example: See Example "To configure non-HRP UWB frames"
on page 109.

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Manual operation: See "Data Source" on page 35

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA:
DSELection <DSelection>

Selects an existing data list file from the default directory or from the specific directory.

The data list is only used, if the DLIS is selected.

Parameters:
<DSelection> string

Example: Load a data list saved in a file from the default directory.
SOURce1:BB:HUWB:FCONfig:DATA DLIS
SOURce1:BB:HUWB:FCONfig:DATA:DSELection
"/var/user/myUWB"

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.
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Manual operation: See "Data Source" on page 35

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA:
PATTern <DPattern>, <BitCount>

Sets the data pattern, if pattern is selected as the data source.

See [:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DATA
on page 118.

Parameters:
<DPattern> numeric

*RST: #H0

<BitCount> integer
Range: 1  to  64
*RST: 1

Example: SOURce1:BB:HUWB:FCONfig:DATA PATT
SOURce1:BB:HUWB:FCONfig:DATA:PATTern #H0,1

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Manual operation: See "Data Source" on page 35

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DR?

Queries the data rate.

In the mode [:SOURce<hw>]:BB:HUWB:STD OQPSK the data rate is set automati-
cally, depending on the selected operating band and SFD.

Example: See Example "To configure non-HRP UWB frames"
on page 109.

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Usage: Query only

Manual operation: See "Data Rate" on page 37

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:DALEngth
<DLength>

Sets the data length of the physical header data in octets.
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Parameters:
<DLength> integer

Range: 0  to  4096
*RST: 20

Example: See Example "To configure non-HRP UWB frames"
on page 109.

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Manual operation: See "Data Length" on page 38

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
DLENgth <DeltaLength>

Sets the delta length.

The length depends on the HRP UWB mode and bandwidth.

Parameters:
<DeltaLength> DL_4 | DL_16 | DL_64

*RST: DL_16

Example: See Example "To configure non-HRP UWB frames"
on page 109.

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Manual operation: See "Delta Length" on page 32

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:FLENgth?

Queries the frame length.

The frame length is the sum of the MAC header length, the MAC frame check
sequence (FCS) field length and the data length of the physical header.

Return values: 
<FrameLength> integer

Example: See Example "To modify and monitor frame lengths"
on page 114.

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.
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Usage: Query only

Manual operation: See "Frame Length" on page 39

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:FPAYload:STATe?

Queries the state of the forward error correction in the payload.

The FEC in payload is enabled or disabled automatically, depending on the selected
operating band and SFD.

Return values: 
<FECInPayload> 1 | ON | 0 | OFF

0
For [:SOURce<hw>]:BB:HUWB:OBANd
OB780|OB868|OB915|OB2380|OB2450.
For [:SOURce<hw>]:BB:HUWB:OBANd OB5800|OB6200 and
[:SOURce<hw>]:BB:HUWB:SFD SFD_0|SFD_2.
1
For [:SOURce<hw>]:BB:HUWB:OBANd OB5800|OB6200 and
[:SOURce<hw>]:BB:HUWB:SFD SFD_1|SFD_3|SFD_4.
*RST: 0

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Usage: Query only

Manual operation: See "FEC in Payload" on page 48

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:FPhr:STATe?

Queries the state of the forward error correction in the PHY header.

Enables or disables the forward error correction in the PHY header automatically,
depending on the selected operating band and SFD.

Return values: 
<FECInPhr> 1 | ON | 0 | OFF

0
For [:SOURce<hw>]:BB:HUWB:OBANd
OB780|OB868|OB915|OB2380|OB2450.
For [:SOURce<hw>]:BB:HUWB:OBANd OB5800|OB6200 and
[:SOURce<hw>]:BB:HUWB:SFD SFD_0.
1
For [:SOURce<hw>]:BB:HUWB:OBANd OB5800|OB6200 and
[:SOURce<hw>]:BB:HUWB:SFD
SFD_1|SFD_2|SFD_3|SFD_4.
*RST: 0
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Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Usage: Query only

Manual operation: See "FEC in PHR" on page 44

[:SOURce<hw>]:BB[:LRWPan]:HUWB:FCONfig:HOPBurst <HopBurst>

Requires [:SOURce<hw>]:BB:LRWPan|HUWB:STD NONHRP|BPRF.

Sets the number of hop bursts.

Parameters:
<HopBurst> HB_2 | HB_8 | HB_32

*RST: HB_2

Example: See Example "To configure non-HRP UWB frames"
on page 109.

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Manual operation: See "Hop Bursts" on page 36

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MCS:STATe
<McsState>

Activates MAC frame check sequence field.

Parameters:
<McsState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "To configure non-HRP UWB frames"
on page 109.

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Manual operation: See "MAC FCS" on page 37

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MDL
<MaxDataLen>

Requires [:SOURce<hw>]:BB:LRWPan|HUWB:STD HPRF|EHPRF|SENS.
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Sets the maximum data length of the physical header.

Parameters:
<MaxDataLen> MDL_1023 | MDL_2047 | MDL_4095

MDL_1023
1023 octets
MDL_2047
2047 octets
MDL_4095
4095 octets
*RST: MDL_1023

Example: See Example "To modify and monitor frame lengths"
on page 114.

Manual operation: See "Maximum Data Length" on page 39

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MFL
<MacFCSLen>

Sets the length of the frame check sequence field.

Parameters:
<MacFCSLen> MFL_2 | MFL_4

MFL_2
Two octets
MFL_4
Four octets
*RST: MFL_2

Example: See Example "To modify and monitor frame lengths"
on page 114.

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Manual operation: See "MAC FCS Length" on page 37

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:MPRF?

Queries the mean pulse repetition frequency (PRF).

Return values: 
<MeanPRF> float

Example: See Example "To configure non-HRP UWB frames"
on page 109.

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.
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Usage: Query only

Manual operation: See "Mean PRF" on page 37

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:PHRBrate?

Queries the bit rate of the physical header.

Example: See Example "To configure non-HRP UWB frames"
on page 109.

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Usage: Query only

Manual operation: See "PHR Bit Rate" on page 38

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:PHRLength?

Queries the length of the PHY header.

The length of the PHY header depends on the selected operating band and SFD.

Return values: 
<phrLength> PHL_2 | PHL_7

PHL_2
For [:SOURce<hw>]:BB:HUWB:OBANd
OB780|OB868|OB915|OB2380|OB2450.
For [:SOURce<hw>]:BB:HUWB:OBANd OB5800|OB6200 and
[:SOURce<hw>]:BB:HUWB:SFD SFD_0.
PHL_7
For [:SOURce<hw>]:BB:HUWB:OBANd OB5800|OB6200 and
[:SOURce<hw>]:BB:HUWB:SFD
SFD_1|SFD_2|SFD_3|SFD_4.
*RST: PHL_2

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Usage: Query only

Manual operation: See "PHR Length" on page 44
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[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
SFDLength?

Queries the symbol length of the start-of-frame delimiter (SFD).

The SFD length depends on the set SFD symbol sequence, see Table 7-5.

In the mode [:SOURce<hw>]:BB:HUWB:STD OQPSK the SFD length is SFDL_2.

Return values: 
<SFDLength> SFDL_8 | SFDL_64 | SFDL_2 | SFDL_4 | SFDL_16 | SFDL_32

*RST: SFDL_64

Example: See Example "To configure non-HRP UWB frames"
on page 109.

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Usage: Query only

Manual operation: See "SFD Length" on page 33

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:SFPAYLoad?

Queries the spreading factor (number of chips per symbol) in PHY header and pay-
load.

The spreading factor depends on the selected operating band and SFD.

Return values: 
<FactorInPayload> SFA_16 | SFA_32 | SFA_8 | SFA_4

SFA_4
For [:SOURce<hw>]:BB:HUWB:OBANd OB5800|OB6200 and
[:SOURce<hw>]:BB:HUWB:SFD SFD_4.
SFA_8
For [:SOURce<hw>]:BB:HUWB:OBANd OB5800|OB6200 and
[:SOURce<hw>]:BB:HUWB:SFD SFD_1|SFD_2.
SFA_16
For [:SOURce<hw>]:BB:HUWB:OBANd
OB780|OB868|OB915.
For [:SOURce<hw>]:BB:HUWB:OBANd OB5800|OB6200 and
[:SOURce<hw>]:BB:HUWB:SFD SFD_3.
SFA_32
For [:SOURce<hw>]:BB:HUWB:OBANd OB2380|OB2450.
For [:SOURce<hw>]:BB:HUWB:OBANd OB5800|OB6200 and
[:SOURce<hw>]:BB:HUWB:SFD SFD_0.
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*RST: SFA_32

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Usage: Query only

Manual operation: See "Spreading factor in PHR and Payload" on page 47

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:SFShr?

Queries the spreading factor (number of chips per symbol) in the synchronization
header.

The spreading factor depends on the selected operating band.

Return values: 
<SFInShr> SFA_16 | SFA_32

SFA_16
For [:SOURce<hw>]:BB:HUWB:OBANd
OB780|OB868|OB915.
SFA_32
For [:SOURce<hw>]:BB:HUWB:OBANd
OB2380|OB2450|OB5800|OB6200.
*RST: SFA_32

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Usage: Query only

Manual operation: See "Spreading factor in SHR" on page 44

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:FCONfig:SYMRate?

Displays the symbol rate of the O-QPSK modulated signal.

The symbol rate depends on the selected operating band and SFD.

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Usage: Query only

Manual operation: See "Symbol Rate" on page 48

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:FCONfig:
SYNLength <SyncLength>

Sets the sync length.

In the mode [:SOURce<hw>]:BB:HUWB:STD OQPSK the sync length is set automati-
cally, depending on the selected operating band and SFD.
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Parameters:
<SyncLength> SL_16 | SL_24 | SL_32 | SL_48 | SL_64 | SL_96 | SL_128 |

SL_256 | SL_1024 | SL_4096
*RST: SL_64

Example: See Example "To configure non-HRP UWB frames"
on page 109.

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Manual operation: See "Sync Length" on page 32

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:FCONfig:VRATe?

Queries the viterbi rate for convolutional coding or the channel code type.

Example: See Example "To configure non-HRP UWB frames"
on page 109.

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Usage: Query only

Manual operation: See "Viterbi Rate" on page 36

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:PHR:DRM <DataRateMode>

Requires [:SOURce<hw>]:BB:LRWPan|HUWB:STD BPRF|HPRF.

Sets the data rate mode of the physical header.

Parameters:
<DataRateMode> BMLP | BMHP | HMLR | HMHR

*RST: BMLP

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Manual operation: See "PHR Data Rate Mode" on page 38
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[:SOURce<hw>]:BB:LRWPan:EMLLd:SFD <SFDIndex>

Sets the start-of-frame delimiter (SFD) symbol sequence.

Option: R&S SMM-K181:

Table 7-1: SFD: indices and lengths

Index SFD_1 SFD_2 SFD_3 SFD_4

SFD 1 2 3 4

SFD length 4 8 16 32

Parameters:
<SFDIndex> SFD_0 | SFD_1 | SFD_2 | SFD_3 | SFD_4 | SFD_5 | SFD_6 |

SFD_7 | SFD_8
*RST: SFD_5

Manual operation: See "SFD" on page 53

[:SOURce<hw>]:BB:LRWPan:MMS:SFD <SFDIndex>

Sets the start-of-frame delimiter (SFD) symbol sequence.

Option: R&S SMM-K181:

Table 7-2: SFD: indices and lengths

Index SFD_0 SFD_1 SFD_2 SFD_3 SFD_4

SFD 0 1 2 3 4

SFD length 8 4 8 16 32

Parameters:
<SFDIndex> SFD_0 | SFD_1 | SFD_2 | SFD_3 | SFD_4 | SFD_5 | SFD_6 |

SFD_7 | SFD_8
*RST: SFD_5

Manual operation: See "SFD" on page 82

[:SOURce<hw>]:BB:LRWPan:OQPSk:SFD <SFDIndex>

Sets the start-of-frame delimiter (SFD) symbol sequence.

Option: R&S SMM-K180:
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Table 7-3: SFD: indices and operating band

Index SFD_0 SFD_1 SFD_2 SFD_3 SFD_4

SFD 0 1 2 3 4

Operating
band

780 MHz

868 MHz

915 MHz

2380 MHz

2450 MHz

5800 MHz

6200 MHz

5800 MHz

6200 MHz

5800 MHz

6200 MHz

5800 MHz

6200 MHz

5800 MHz

6200 MHz

Parameters:
<SFDIndex> SFD_0 | SFD_1 | SFD_2 | SFD_3 | SFD_4 | SFD_5 | SFD_6 |

SFD_7 | SFD_8
*RST: SFD_5

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Manual operation: See "SFD" on page 43

[:SOURce<hw>]:BB:LRWPan:SENS:SFD <SFDIndex>

Sets the start-of-frame delimiter (SFD) symbol sequence.

Option: R&S SMM-K182:

Table 7-4: SFD: indices and lengths

Index SFD_1 SFD_2 SFD_3 SFD_4

SFD 1 2 3 4

SFD length 4 8 16 32

Parameters:
<SFDIndex> SFD_0 | SFD_1 | SFD_2 | SFD_3 | SFD_4 | SFD_5 | SFD_6 |

SFD_7 | SFD_8
*RST: SFD_5

Manual operation: See "SFD" on page 65

[:SOURce<hw>]:BB[:LRWPan]:HUWB:SFD <SFDIndex>

Sets the start-of-frame delimiter (SFD) symbol sequence.

Option: R&S SMM-K149:

The indices represent SFD symbol sequences with SFD lengths as listed in Table 7-5.
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Table 7-5: SFD: indices and lengths

Index SFD_0 SFD_1 SFD_2 SFD_3 SFD_4 SFD_5 SFD_6 SFD_7 SFD_8

SFD 0 1 2 3 4 User1 User2 User3 Legacy

SFD length 8 4 8 16 32 8 16 64 8

Using indices SFD_5, SFD_6 and SFD_7 requires
[:SOURce<hw>]:BB:HUWB:SFD:USRState 1.

Parameters:
<SFDIndex> SFD_0 | SFD_1 | SFD_2 | SFD_3 | SFD_4 | SFD_5 | SFD_6 |

SFD_7 | SFD_8
*RST: SFD_5

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Manual operation: See "SFD" on page 33

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|MMS|EMLLd|SENS:SFD:USRState
<Userstate>

Enables using SFD indices SFD_5, SFD_6 and SFD_7.

Parameters:
<Userstate> 1 | ON | 0 | OFF

*RST: 0

[:SOURce<hw>]:BB:LRWPan:OQPSk:CINDex <ConfigIndex>

Requires [:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk:OBANd OB5800|OB6200.

Sets the configuration index, which determines for example the SYNC length and SFD
length for symbol-to-chip mapping in the selected operating band.

Parameters:
<ConfigIndex> CI1 | CI2 | CI3 | CI4 | CI5 | CI6 | CI7 | CI8

*RST: CI1

Manual operation: See "Config Index" on page 44

[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:DLS <StsDatalist>

Activates the STS source.

If activated, you can select an STS data list from a designated folder to import a user
defined STS sequence.
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Parameters:
<StsDatalist> 1 | ON | 0 | OFF

*RST: 0

Example: Activate the STS source:
SOURce1:BB:HUWB:STS:DLS 1

Manual operation: See "STS Source (MSB is Transmitted First)" on page 40

[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:DATA:DSELection
<StsDlist>

Selects an existing data list file from the default directory or from a specific directory.
The data list is only used, if DLS is activated.

Parameters:
<StsDlist> string

Example: Load a data list saved in a file from the default directory.
SOURce1:BB:HUWB:STS:DLS 1
SOURce1:BB:HUWB:STS:DATA:DSELection
"/var/user/myUWB"

Manual operation: See "STS Source (MSB is Transmitted First)" on page 40

[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:CPARt <CounterPart>

Sets the counter part of the V value. The value is a 32-bit value in hexadecimal repre-
sentation.

Parameters:
<CounterPart> integer

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Manual operation: See "VCounter(hex)" on page 41

[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd|SENS:STS:DLEN?

Queries the delta length of the scrambled timestamp sequence (STS).

The delta length depends on the HRP UWB mode.

Return values: 
<DeltaLength> DL_4 | DL_8

*RST: DL_4

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.
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Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Usage: Query only

Manual operation: See "Delta Length" on page 41

[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:KEY <Key>

Sets the key value of the scrambled timestamp sequence (STS). The value is a 128-bit
value in hexadecimal representation.

Parameters:
<Key> integer

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Manual operation: See "Key(hex)" on page 41

[:SOURce<hw>]:BB[:LRWPan]:HUWB|EMLLd:STS:PC <SPC>

Requires [:SOURce<hw>]:BB:LRWPan|HUWB:STD BPRF|HPRF|EHPRF.

Sets the scrambled timestamp sequence (STS) packet configuration.

Parameters:
<SPC> SPC_0 | SPC_1 | SPC_2 | SPC_3

*RST: SPC_0

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Manual operation: See "STS Packet Configuration" on page 31

[:SOURce<hw>]:BB[:LRWPan]:HUWB|MMS|EMLLd:STS:UPARt <UpperPart>

Sets the upper part of the V value. The value is a 96-bit value in hexadecimal repre-
sentation.

Parameters:
<UpperPart> integer

Example: See Example "To configure HRP UWB 802.15.4z-BPRF frames"
on page 110.

Example: See Example "To configure HRP UWB 802.15.4z-HPRF frames"
on page 111.

Manual operation: See "VUpper96(hex)" on page 41
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[:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:CCT <CCCL>

Requires [:SOURce<hw>]:BB:LRWPan|HUWB:STD EHPRF|SENS.

Sets the channel code type.

The channel code type depends on the selected PHR data rate mode.

Parameters:
<CCCL> CL3 | CL7 | LDPC

*RST: CL3

Manual operation: See "Channel Code Type" on page 56

[:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:FCONfig:PHRO:CWORd?

Requires [:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:PHR:DRM MDR.

Queries the PHR1 codeword in hexadecimal.

Parameters:
<DPattern> numeric

*RST: #H0

<BitCount> integer
Range: 20  to  20
*RST: 20

Usage: Query only

Manual operation: See "PHR1 Codeword(hex)" on page 59

[:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:FCONfig:PHRT:BITRate
<Phr2BitRate>

Requires [:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:PHR:DRM MDR.

Sets the PHR2 bit rate depending on the PHR1 codeword.

Parameters:
<Phr2BitRate> R1M95H | R1M95 | R7M8H | R7M8 | R31M2H | R31M2 |

R62M4H | R62M4 | R124M8H | R124M8
*RST: R1M95H

Manual operation: See "PHR2 Bit Rate" on page 59

[:SOURce<hw>]:BB:LRWPan:EMLLd|SENS:PHR:DRM <DataRateMode>

Sets the data rate mode of the physical header.

Parameters:
<DataRateMode> HM1P95 | HM7P8 | HM31P2 | HM62P4 | HM124P8 | MDR

*RST: HM7P8
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Manual operation: See "PHR Data Rate Mode" on page 58

[:SOURce<hw>]:BB:LRWPan:HUWB|MMS|EMLLd|SENS:SRF <SetRf>

Sets the RF output frequency automatically to the value of the channel center fre-
quency according to the selected channel number.

You can still adjust the RF frequency afterwards.

Parameters:
<SetRf> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "Set RF according to Channel number" on page 27

[:SOURce<hw>]:BB:LRWPan:MMS:MPFormat <MmsPktFormat>

Sets the packet format for multi-millisecond ranging.

Parameters:
<MmsPktFormat> RSF | RIF | BOTH

RSF
The MMS packet composed of ranging sequence fragments
(RSF), consisting of a repetition of a selected multi-millisecond
ranging sequence (MMRS) symbol.
RIF
The MMS packet composed of ranging integrity fragments (RIF),
consisting of a sequence of active scrambled timestamp
sequence (STS) pulses.
BOTH
The MMS packet composed of both ranging sequence frag-
ments and ranging integrity fragments.
*RST: RSF

Manual operation: See "MMS Packet Format" on page 79

[:SOURce<hw>]:BB:LRWPan:MMS:NRIF <RIFNumber>

Sets the number of RIF fragments in the MMS ranging phase.

Parameters:
<RIFNumber> FN0 | FN1 | FN2 | FN4 | FN8

*RST: FN0

Manual operation: See "Number of RIF Fragment" on page 80

[:SOURce<hw>]:BB:LRWPan:MMS:NRSF <RSFNumber>

Sets the number of RSF fragments in the MMS ranging phase.

Frame configuration commands



Remote control commandsR&S®SMM-K149/-K180/-K181/-K182

135User Manual 1179.2083.02 ─ 11

Parameters:
<RSFNumber> FN0 | FN1 | FN2 | FN4 | FN8 | FN16

*RST: FN8

Manual operation: See "Number of RSF Fragment" on page 80

[:SOURce<hw>]:BB:LRWPan:MMS:RIOFfset?

Requires [:SOURce<hw>]:BB:LRWPan:MMS:MPFormat BOTH.

Queries the number of RSTU from the start of the last RSF fragment in the MMS rang-
ing pahse after which the initiator starts to transmit the first RIF fragment into the MMS
ranging phase.

Return values: 
<RifOffset> integer

Range: 2400  to  2400
*RST: 2400

Usage: Query only

Manual operation: See "RIF Offset" on page 80

[:SOURce<hw>]:BB:LRWPan:MMS:ROLE <Role>

Sets the role for the MMS ranging round.

Parameters:
<Role> RESP | INIT

RESP
The responder is the complementary role to the initiator in the
ranging process.
For example, the responder receives requests and generates
and sends responses.
INIT
The initiator controls the ranging process between the devices.
For example, the initiator initiates the ranging process and exe-
cutes distance calculation.
*RST: INIT

Manual operation: See "Role" on page 79

[:SOURce<hw>]:BB:LRWPan:MMS:RPDuration <RPDuration>

Sets the number of slots within the MMS ranging phase.

The available range of the ranging phase duration depends on the MMS packet format
set with [:SOURce<hw>]:BB:LRWPan:MMS:MPFormat.
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Parameters:
<RPDuration> integer

Range: 0  to  4095
*RST: 16

Manual operation: See "Ranging Phase Duration" on page 79

[:SOURce<hw>]:BB:LRWPan:MMS:RSDuration <RSDuration>

Selects the duration of each ranging slot in RSTU (ranging scheduling time unit).

A ranging slot refers to a specific time interval allocated for the transmission and recep-
tion of ranging messages between devices.

Parameters:
<RSDuration> SD3 | SD6 | SD9 | SD12 | SD15 | SD18 | SD21 | SD24

*RST: SD6

Manual operation: See "Ranging Slot Duration" on page 80

[:SOURce<hw>]:BB:LRWPan:MMS:RSF:MCINdex <MmrsCodeIndex>

Sets the code index that determines the multi-millisecond ranging sequence.

Parameters:
<MmrsCodeIndex> CI_9 | CI_10 | CI_11 | CI_12 | CI_13 | CI_14 | CI_15 | CI_16 |

CI_17 | CI_18 | CI_19 | CI_20 | CI_21 | CI_22 | CI_23 | CI_24 |
CI_25 | CI_26 | CI_27 | CI_28 | CI_29 | CI_30 | CI_31 | CI_32 |
CI_33 | CI_34 | CI_35 | CI_36 | CI_37 | CI_38 | CI_39 | CI_40 |
CI_41 | CI_42 | CI_43 | CI_44 | CI_45 | CI_46 | CI_47 | CI_48
*RST: CI_33

Manual operation: See "MMRS Code Index" on page 86

[:SOURce<hw>]:BB:LRWPan:MMS:RSF:MCSZeros <MCSZeros>

Requires [:SOURce<hw>]:BB:LRWPan:MMS:RSF:MCINdex 33 or higher.

Sets the number of zeros for the optional gap in the complementary set of the MMRS
symbol.

Parameters:
<MCSZeros> integer

Range: 0  to  64
*RST: 64

Manual operation: See "MMRS Complementary Set Zeros" on page 86
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[:SOURce<hw>]:BB:LRWPan:MMS:RSF:MSRepetition <MSREpetition>

Sets the number for repetitions of the MMRS symbol in the ranging sequence frag-
ment.

Parameters:
<MSREpetition> SR32 | SR40 | SR48 | SR64 | SR128 | SR256

*RST: SR40

Manual operation: See "MMRS Symbol Repetition" on page 86

[:SOURce<hw>]:BB:LRWPan:MMS:RSOFfset <RsfOffset>

Sets the number of slots after which the initiator starts to transmit the first RSF frag-
ment into the MMS ranging phase.

Parameters:
<RsfOffset> integer

Range: 0  to  15
*RST: 2

Manual operation: See "RSF Offset" on page 80

[:SOURce<hw>]:BB:LRWPan:MMS:RSTU?

Queries the size of the ranging scheduling time unit (RSTU).

Return values: 
<RSTU> integer

Range: 416  to  416
*RST: 416

Usage: Query only

Manual operation: See "RSTU" on page 80

[:SOURce<hw>]:BB:LRWPan:MMS:SSCI <SSCI>

Requires [:SOURce<hw>]:BB:LRWPan:MMS:TFSYnc 1.

Queries or sets the code index used for the SYNC and SFD in the MMS packet,
depending on the MMS packet format.

Parameters:
<SSCI> CI_25 | CI_26 | CI_27 | CI_28 | CI_29 | CI_30 | CI_31 | CI_32

*RST: CI_25

Manual operation: See "Sync Sequence Code Index" on page 80
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[:SOURce<hw>]:BB:LRWPan:MMS:TFSYnc <TimeFreqSync>

Enables a fragment consisting of SYNC and SFD preceding the MMS ranging phase
for initial timing and frequency synchronization.

Parameters:
<TimeFreqSync> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "Timing/Frequency Synchronization" on page 80

[:SOURce<hw>]:BB:LRWPan:SENS:RSTU?

Queries the size of the ranging scheduling time unit (RSTU).

Return values: 
<Rstu> integer

Range: 416  to  416
*RST: 416

Usage: Query only

Manual operation: See "RSTU" on page 63

[:SOURce<hw>]:BB:LRWPan:SENS:SGAP <SilentGap>

Queries or sets the value of the gap before and after the SENS part in the sensing
package.

Setting the value requires [:SOURce<hw>]:BB:LRWPan:SENS:SPC SPCU.

Parameters:
<SilentGap> SG0 | SG1 | SG40

*RST: SG1

Manual operation: See "Silent Gap" on page 73

[:SOURce<hw>]:BB:LRWPan:SENS:SPC <PacketConfig>

Sets the sensing packet configuration.

Parameters:
<PacketConfig> SPC0 | SPC1 | SPC2 | SPCU

SPC0|SPC1|SPC2
Provide the sensing packet format according to P802.15.4ab/
D02.
SPCU
Provides no SYNC and no SFD field. The format provides the
SENS active packet in between two silent gaps.
*RST: SPC0

Manual operation: See "SENS Packet Configuration" on page 63
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[:SOURce<hw>]:BB:LRWPan:SENS:SPDuration <SensPhaseDur>

Sets the sensing phase duration.

You can configure how many sensing slots define a sensing phase.

Parameters:
<SensPhaseDur> integer

Range: 1  to  4095
*RST: 1

Manual operation: See "SENS Phase Duration" on page 63

[:SOURce<hw>]:BB:LRWPan:SENS:SSDuration <SensSlotDur>

Sets the duration of a sensing slot in RSTU (ranging scheduling time unit).

Parameters:
<SensSlotDur> SD3 | SD6 | SD9 | SD12 | SD15 | SD18 | SD21 | SD24

*RST: SD12

Manual operation: See "SENS Slot Duration" on page 63

[:SOURce<hw>]:BB:LRWPan:SENS:SSOFfset <SensStartOffset>

Sets an offset of a defined amount of slots before the sensing phase starts.

Parameters:
<SensStartOffset> integer

Range: 0  to  15
*RST: 0

Manual operation: See "SENS Start Offset" on page 63
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7.3  MAC header commands

Example: To configure MAC header information
SOURce1:BB:HUWB:MACHeader:STATe 0
// Configure frame control field parameters.
SOURce1:BB:HUWB:MACHeader:LFRControl L2
SOURce1:BB:HUWB:MACHeader:CTRL 34913
SOURce1:BB:HUWB:MACHeader:FTYPe 1
SOURce1:BB:HUWB:MACHeader:SEENabled 0
SOURce1:BB:HUWB:MACHeader:FPENding 0
SOURce1:BB:HUWB:MACHeader:AR 1
SOURce1:BB:HUWB:MACHeader:PIDComp 1
SOURce1:BB:HUWB:MACHeader:REServed 0
SOURce1:BB:HUWB:MACHeader:SENSupp 0
SOURce1:BB:HUWB:MACHeader:IEPResent 0
SOURce1:BB:HUWB:MACHeader:DADMode 2
SOURce1:BB:HUWB:MACHeader:FVERsion 0
SOURce1:BB:HUWB:MACHeader:SADMode 2

// Configure sequence number field parameters.
SOURce1:BB:HUWB:MACHeader:LSEQnumber L1
SOURce1:BB:HUWB:MACHeader:SEQNumber 1

// Configure destination PAN ID field parameters.
SOURce1:BB:HUWB:MACHeader:LDEPanid L2
SOURce1:BB:HUWB:MACHeader:DPANid 43981

// Configure destination address field parameters.
SOURce1:BB:HUWB:MACHeader:LDADdress L2
SOURce1:BB:HUWB:MACHeader:DADD 4660

// Configure source PAN ID field parameters.
SOURce1:BB:HUWB:MACHeader:LSOPanid L2
SOURce1:BB:HUWB:MACHeader:SPANid 44015

// Configure source address field parameters.
SOURce1:BB:HUWB:MACHeader:LSADdress L2
SOURce1:BB:HUWB:MACHeader:SADD 22136

// Activate MAC header information.
SOURce1:BB:HUWB:MACHeader:STATe 1

// Query MAC header information.
SOURce1:BB:HUWB:MACHeader:STRing?
// Response: "11 Octets: 8861-01-ABCD-1234-ABEF-5678"

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:AR.....................141
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:CTRL.................142
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DAD2................ 142
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[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DAD3................ 142
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DAD4................ 142
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DADD................142
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DADMode.......... 142
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DPANid..............143
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:FPENding.......... 143
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:FTYPe...............143
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:FVERsion.......... 144
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:IEPResent..........144
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:LDADdress........ 144
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:LDEPanid.......... 145
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:LFRControl........ 145
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:LSADdress.........145
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:LSEQnumber..... 146
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:LSOPanid.......... 146
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:PIDComp........... 147
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:REServed.......... 147
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SAD2.................147
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SAD3.................147
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SAD4.................147
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SADD................ 147
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SADMode.......... 148
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SEENabled........ 148
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SENSupp...........148
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SEQNumber.......149
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SPANid..............149
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:STATe................149
[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:STRing?............ 150

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:AR
<AR>

Sets the bit in the AR field.

The bit specifies if an acknowledgment is required from the recipient device on receipt
of a data frame or MAC command.

Parameters:
<AR> integer

Range: 0  to  1
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "AR" on page 75
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[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:CTRL
<FrameControl>

Sets the input value of the frame control field. The value is an 8-bit or 16-bit value in
hexadecimal representation.

Parameters:
<FrameControl> integer

Range: 0  to  65535
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Frame Control" on page 74

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DAD2
<DestAddr2>

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DAD3
<DestAddr3>

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DAD4
<DestAddr4>

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DADD
<DestinationAddr>

DADD requires destination address length of two or eight octets.

DAD2, DAD3 and DAD4 require destination address length of eight octets. See [:
SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
LDADdress on page 144.

Sets the first, second, third and fourth input value of the destination address field.

Parameters:
<DestinationAddr> integer

Range: 0  to  65535
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Destination Address" on page 77

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
DADMode <DestAddrMode>

Requires frame control length of two octets. See [:SOURce<hw>]:BB[:LRWPan]:
HUWB|OQPSk|EMLLd|SENS:MACHeader:LFRControl on page 145.

Sets bits of the destination addressing mode.
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Parameters:
<DestAddrMode> integer

Range: 0  to  3
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Destination Addressing Mode" on page 76

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:DPANid
<DestinationPanI>

Sets the length and the input value of the destination PAN ID field.

Parameters:
<DestinationPanI> integer

Range: 0  to  65535
*RST: 0

Manual operation: See "Destination PAN ID" on page 76

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
FPENding <FramePending>

Sets the bit in the frame pending field.

Parameters:
<FramePending> integer

Range: 0  to  1
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Frame Pending" on page 75

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:FTYPe
<FrameType>

Sets the bits in the frame type field. The value is a 3-bit value.

Parameters:
<FrameType> integer

Range: 0  to  7
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Frame Type" on page 74
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[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
FVERsion <FrameVersion>

Requires frame control length of two octets. See [:SOURce<hw>]:BB[:LRWPan]:
HUWB|OQPSk|EMLLd|SENS:MACHeader:LFRControl on page 145.

Sets the bits in the frame version field. The value is a 2-bit value.

Parameters:
<FrameVersion> integer

Range: 0  to  3
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Frame Version" on page 76

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
IEPResent <IePresent>

Requires frame control length of two octets. See [:SOURce<hw>]:BB[:LRWPan]:
HUWB|OQPSk|EMLLd|SENS:MACHeader:LFRControl on page 145.

Sets the bit in the information element (IE) present field.

Parameters:
<IePresent> integer

Range: 0  to  1
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "IE Present" on page 75

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
LDADdress <LenDestAddr>

Sets the length of the destination address field. You can set lengths of zero octets, two
octets or eight octets.

Parameters:
<LenDestAddr> L0 | L2 | L8

L0
Sets destination address length to zero octets.
L2
Sets destination address length to two octets.
L8
Sets destination address length to eight octets.
*RST: L0
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Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Destination Address" on page 77

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
LDEPanid <LenDestPanId>

Sets the length of the destination PAN ID field. You can set lengths of zero octets or
two octets.

Parameters:
<LenDestPanId> L0 | L2

L0
Sets destination PAN ID length to zero octets.
L2
Sets destination PAN ID length to two octets.
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Destination PAN ID" on page 76

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
LFRControl <LenFrameControl>

Sets the length of the frame control field. You can set lengths of one octet or two
octets.

Parameters:
<LenFrameControl> L1 | L2

L1
Sets frame control length to one octet.
L2
Sets frame control length to two octets.
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Frame Control" on page 74

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
LSADdress <LenSrcAddress>

Sets the length of the source address field. You can set lengths of zero octets, two
octets or eight octets.

Parameters:
<LenSrcAddress> L0 | L2 | L8
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L0
Sets source address length to zero octets.
L2
Sets source address length to two octets.
L8
Sets source address length to eight octets.
*RST: L0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Source Address" on page 77

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
LSEQnumber <LenSeqNumber>

Sets the length of the sequence number field. You can set zero octets or one octet.

Parameters:
<LenSeqNumber> L0 | L1

L0
Sets the sequence number length to zero octets.
L1
Sets the sequence number length to one octet.
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Sequence Number" on page 76

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
LSOPanid <LenSourcePanId>

Sets the length of the source PAN ID field. You can set lengths of zero octets or two
octets.

Parameters:
<LenSourcePanId> L0 | L2

L0
Sets source PAN ID length to zero octets.
L2
Sets source PAN ID length to two octets.
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Source PAN ID" on page 77
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[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
PIDComp <PanIdCompress>

Sets the bit in the PAN ID compression field.

Parameters:
<PanIdCompress> integer

Range: 0  to  1
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "PAN ID Compression" on page 75

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
REServed <Reserved>

Sets a reserved bit for future use.

Parameters:
<Reserved> integer

Range: 0  to  1
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Reserved" on page 75

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SAD2
<SourceAddress2>

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SAD3
<SourceAddress3>

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SAD4
<SourceAddress4>

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SADD
<SourceAddress>

SADD requires source address length of two or eight octets.

SAD2, SAD3 and SAD4 require source address lengths of eight octets.

See [:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
LSADdress on page 145.

Sets the first, second, third and fourth input value of the source address field.

Parameters:
<SourceAddress> integer

Range: 0  to  65535
*RST: 0
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Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Source Address" on page 77

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
SADMode <SrcAddrMode>

Requires frame control length of two octets. See [:SOURce<hw>]:BB[:LRWPan]:
HUWB|OQPSk|EMLLd|SENS:MACHeader:LFRControl on page 145.

Sets the bits in the source addressing mode field. The value is a 2-bit value.

Parameters:
<SrcAddrMode> integer

Range: 0  to  3
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Source Addressing Mode" on page 76

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
SEENabled <SecurityEnabled>

Sets the bit in the security enabled field.

Parameters:
<SecurityEnabled> integer

Range: 0  to  1
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Security Enabled" on page 75

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
SENSupp <SeqNumbSuppr>

Requires frame control length of two octets. See [:SOURce<hw>]:BB[:LRWPan]:
HUWB|OQPSk|EMLLd|SENS:MACHeader:LFRControl on page 145.

Sets the bit in the sequence number suppression field.

Parameters:
<SeqNumbSuppr> integer

Range: 0  to  1
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.
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Manual operation: See "Sequence Number Suppression" on page 75

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
SEQNumber <SequenceNumber>

Sets the input value of the sequence number field.

The value is in hexadecimal representation.

Parameters:
<SequenceNumber> integer

Range: 0  to  65535
*RST: 0

Manual operation: See "Sequence Number" on page 76

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:SPANid
<SourcePanId>

Sets the input value of the source PAN ID field. The value is a 16-bit value in hexadeci-
mal representation.

Parameters:
<SourcePanId> integer

Range: 0  to  65535
*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Manual operation: See "Source PAN ID" on page 77

[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:STATe
<State>

Activates or deactivates MAC header information.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "To configure MAC header information"
on page 140.

Example: See Example "To configure and monitor 802.15.4-O-QPSK/ab-
NB frames" on page 113.

Manual operation: See "MAC Header" on page 74
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[:SOURce<hw>]:BB[:LRWPan]:HUWB|OQPSk|EMLLd|SENS:MACHeader:
STRing?

Queries the length of the MAC header and the MAC address in hexadecimal format.

Return values: 
<String> string

Example: See Example "To configure MAC header information"
on page 140.

Usage: Query only

Manual operation: See "MAC Header" on page 37

7.4  Impairments commands

Example: To impair an HRP UWB signal
// Configure symbol timing error in ppm.
SOURce1:BB:HUWB:IMPairments:STERror 10
// Configure frequency offset in Hz.
SOURce1:BB:HUWB:IMPairments:FOFFset 25000
// Activate impairing the signal.
SOURce1:BB:HUWB:IMPairments:STATe 1

[:SOURce<hw>]:BB:LRWPan|HUWB:IMPairments:CCERror..............................................150
[:SOURce<hw>]:BB:LRWPan|HUWB:IMPairments:FOFFset.............................................. 150
[:SOURce<hw>]:BB:LRWPan|HUWB:IMPairments:STATe..................................................151

[:SOURce<hw>]:BB:LRWPan|HUWB:IMPairments:CCERror <STError>

Sets the chip clock error of the impairment symbols.

Parameters:
<STError> integer

Range: -300  to  300
*RST: 0

Example: See Example "To impair an HRP UWB signal" on page 150.

Manual operation: See "Chip Clock Error" on page 29

[:SOURce<hw>]:BB:LRWPan|HUWB:IMPairments:FOFFset <FOffset>

Sets the frequency offset.

Parameters:
<FOffset> integer

Range: -200E3  to  200E3
*RST: 0
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Example: See Example "To impair an HRP UWB signal" on page 150.

Manual operation: See "Frequency Offset" on page 29

[:SOURce<hw>]:BB:LRWPan|HUWB:IMPairments:STATe <State>

Sets the impairments state.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "To impair an HRP UWB signal" on page 150.

Manual operation: See "State" on page 29

7.5  Filter commands

Example: To configure filter settings
// ******************************************************************
// Configure filter type, roll-off factor, oversampling and output 
// sample rate.
// ******************************************************************
SOURce1:BB:HUWB:FILTer:TYPE RCOS
SOURce1:BB:HUWB:FILTer:ROFactor 0.5
// Set an oversampling factor of 1.
SOURce1:BB:HUWB:FILTer:OSAMP OS_1
SOURce1:BB:HUWB:FILTer:SRATe:VARiation?
// Response in Hz: 499200000
SOURce1:BB:HUWB:FILTer:OSAMP OS_2
SOURce1:BB:HUWB:FILTer:SRATe:VARiation?
// Response in Hz: 998400000

// ******************************************************************
// Configure an LTE filter.
// ******************************************************************
SOURce1:BB:HUWB:FILTer:TYPE LTEF
SOURce1:BB:HUWB:FILTer:PARameter:LTE:OPTimization EVM
// LTE filter is optimized for EVM performance.
SOURce1:BB:HUWB:FILTer:PARameter:LTE:COFFactor 0.1
SOURce1:BB:HUWB:FILTer:PARameter:LTE:ROFactor -0.2
// Change LTE filter optimization for ACP performance.
SOURce1:BB:HUWB:FILTer:PARameter:LTE:OPTimization ACP
SOURce1:BB:HUWB:FILTer:PARameter:LTE:COFS 0.34
// Check, if the internal filter is active.
SOURce1:BB:HUWB:FILTer:AUTO?
// Response: 0
// The internal filter is not active.
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// ******************************************************************
// Configure a user-defined filter.
// ******************************************************************
SOURce1:BB:HUWB:FILTer:TYPE USER
// Load the file, that specifies the filter. You can load files with
// extension *.dat or *.vaf.
SOURce1:BB:HUWB:FILTer:PARameter:USER "/var/user/my_filter"
// Loads a user-defined filter as defined in file "my_filter.dat".
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Example: To configure O-QPSK filter settings
Option: R&S SMM-K180
This example shows you how using the O-QPSK filter affects the output of the sample
rate variation.

// General settings
SOURce1:BB:HUWB:STD OQPSK
SOURce1:BB:HUWB:FILTer:TYPE OQPSK

// Example settings for changing the operating band
SOURce1:BB:HUWB:SFD SFD_0 
SOURce1:BB:HUWB:FILTer:OSAMpling OS_1 

// Change the operating Band and check the sample rate of the signal
SOURce1:BB:HUWB:OBANd OB915
SOURce1:BB:HUWB:SRATe:VARiation?
// Response in Hz: 1000000
SOURce1:BB:HUWB:OBANd OB6200
SOURce1:BB:HUWB:SRATe:VARiation?
// Response in Hz: 2000000

// Example settings for changing the oversampling factor of the signal
SOURce1:BB:HUWB:SFD SFD_0
SOURce1:BB:HUWB:OBANd OB780

// Change the oversampling factor and check the sample rate of the signal
SOURce1:BB:HUWB:FILTer:OSAMpling OS_1
SOURce1:BB:HUWB:SRATe:VARiation?
// Response in Hz: 1000000
SOURce1:BB:HUWB:FILTer:OSAMpling OS_6
SOURce1:BB:HUWB:SRATe:VARiation?
// Response in Hz: 6000000

// Example settings for changing the SFD
SOURce1:BB:HUWB:OBANd OB6200
SOURce1:BB:HUWB:FILTer:OSAMpling OS_1

// Change the SFD and check the sample rate of the signal
SOURce1:BB:HUWB:SFD SFD_3
SOURce1:BB:HUWB:SRATe:VARiation?
// Response in Hz: 2000000
SOURce1:BB:HUWB:SFD SFD_4
SOURce1:BB:HUWB:SRATe:VARiation?
// Response in Hz: 8000000
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[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:TYPE............................................................154
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:OSAMpling....................................................154
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:APCo25.......................................154
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:COSine........................................154
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:GAUSs........................................ 155
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:LPASs......................................... 155
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:LPASsevm................................... 155
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:PGAuss....................................... 155
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:RCOSine..................................... 155
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[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:TYPE <Type>

Selects the baseband filter type.

Parameters:
<Type> RCOSine | COSine | GAUSs | LGAuss | CONE | COF705 |

COEQualizer | COFequalizer | C2K3x | APCO25 | SPHase |
RECTangle | USER | PGAuss | LPASs | DIRac | ENPShape |
EWPShape | LTEFilter | LPASSEVM | APCO25Hcpm |
APCO25Lsm | HRP | OQPSK | SENS | CCC0 | CCC2
*RST: HRP

Example: See Example "To configure filter settings" on page 151.

Manual operation: See "Filter" on page 88

[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:OSAMpling <OverSampling>

Sets the oversampling factor of the generated waveform.

A reduced sample rate saves significantly the amount of memory or allows an
increased signal cycle time, and vice versa.

Parameters:
<OverSampling> OS_1 | OS_2 | OS_3 | OS_4 | OS_5 | OS_6 | OS_7 | OS_8

*RST: OS_1

Example: See Example "To configure filter settings" on page 151.

Manual operation: See "Oversampling" on page 92

[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:APCo25 <Apco25>
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:COSine <Cosine>
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[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:GAUSs <Gauss>
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:LPASs <LPass>
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:LPASsevm

<CutoffFrequency>
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:PGAuss <PGauss>
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:RCOSine <RCosine>
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:SPHase <SPhase>
Sets the filter parameter.

Filter type Parameter Parameter name Min Max Incre-
ment

Default

APCO25 Rolloff factor <Apco25> 0.05 0.99 0.01 0.2

COSine Rolloff factor <Cosine> 0 1 0.01 0.1

GAUSs BxT <Gauss> 0.15 2.5 0.01 0.5

LPASs Cutoff frequency <LPass> 0.02 2 0.01 0.34

LPASSEVM Cutoff frequency <CutoffFrequency> 0.05 2 0.01 0.29

PGAuss BxT <PGauss> 0.15 2.5 0.01 0.5

RCOSine Rolloff factor <RCosine> 0 1 0.01 0.22

SPHase BxT <SPhase> 0.15 2.5 0.01 2

Parameters:
<SPhase> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 2

Example: See Example "To configure filter settings" on page 151.

Manual operation: See "Roll Off Factor or BxT" on page 90

[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:LTE:COFFactor
<CutoffFactor>

Sets the cut-off frequency factor for the LTE filter type.

Parameters:
<CutoffFactor> float

Range: 0.02  to  2
Increment: 0.001
*RST: 0.34

Example: See Example "To configure filter settings" on page 151.

Manual operation: See "Cut Off Frequency Factor" on page 91
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[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:COSine:COFS <Cofs>
[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:LTE:COFS

<CutOffFreqShift>
Sets the cut-off frequency shift of the applied filter.

Parameters:
<CutOffFreqShift> float

Range: -1  to  1
Increment: 0.01
*RST: -0.2

Example: See Example "To configure filter settings" on page 151.

Manual operation: See "Cut Off Frequency Shift" on page 91

[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:LTE:OPTimization
<Optimization>

Defines the applied LTE filter.

Parameters:
<Optimization> EVM | STD | ACP | ACPN | BENU

*RST: EVM

Example: See Example "To configure filter settings" on page 151.

Manual operation: See "Optimization" on page 88

[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:LTE:ROFactor
<RollOffFactor>

Sets the roll-off factor for the LTE filter type.

Parameters:
<RollOffFactor> float

Range: 0  to  1
Increment: 0.01
*RST: 0.1

Example: See Example "To configure filter settings" on page 151.

Manual operation: See "Roll Off Factor or BxT" on page 90

[:SOURce<hw>]:BB:LRWPan|HUWB:FILTer:PARameter:USER <Filename>

Loads the file from the default or the specified directory.

Loaded are files with extension *.vaf or *.dat.

Parameters:
<Filename> string

Example: See Example "To configure filter settings" on page 151.
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Manual operation: See "Load User Filter" on page 89

[:SOURce<hw>]:BB:LRWPan|HUWB:SRATe:VARiation <SymRateVar>

Sets the sample rate of the signal.

A variation of this parameter affects the ARB clock rate; all other signal parameters
remain unchanged. When changing values of the affecting parameters, the sample
rate is reset.

Parameters:
<SymRateVar> float

Range: 400  to  3.19488E10
Increment: 1E-3
*RST: 9.984E8

Example: See Example "To configure filter settings" on page 151.

Manual operation: See "Sample Rate Variation" on page 92

7.6  Clipping commands

Example: To configure clipping settings
// Selects the absolute maximum of all the I and Q values as the
// reference level.
SOURce1:BB:HUWB:CLIPping:MODE SCAL
// Set the limit for level clipping to 80% of this maximum level.
SOURce1:BB:HUWB:CLIPping:LEVel 80PCT
// Activate level clipping.
SOURce1:BB:HUWB:CLIPping:STATe 1

[:SOURce<hw>]:BB:LRWPan|HUWB:CLIPping:LEVel....................................................... 157
[:SOURce<hw>]:BB:LRWPan|HUWB:CLIPping:MODE...................................................... 158
[:SOURce<hw>]:BB:LRWPan|HUWB:CLIPping:STATe.......................................................158

[:SOURce<hw>]:BB:LRWPan|HUWB:CLIPping:LEVel <Level>

Sets the limit for level clipping.

Parameters:
<Level> integer

Range: 1  to  100
*RST: 100

Example: See Example "To configure clipping settings" on page 157.

Manual operation: See "Clipping Level" on page 93
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[:SOURce<hw>]:BB:LRWPan|HUWB:CLIPping:MODE <Mode>

Sets the method for level clipping.

Parameters:
<Mode> VECTor | SCALar

*RST: VECTor

Example: See Example "To configure clipping settings" on page 157.

Manual operation: See "Clipping Mode" on page 93

[:SOURce<hw>]:BB:LRWPan|HUWB:CLIPping:STATe <State>

Activates level clipping (Clipping). The value is defined with the command
[:SOURce:]BB:EUTRa:CLIPping:LEVel, the mode of calculation with the com-
mand [:SOURce:]BB:EUTRa:CLIPping:MODE.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "To configure clipping settings" on page 157.

Manual operation: See "Clipping State" on page 92

7.7  Trigger commands

Example: To configure an external trigger
SOURce1:BB:HUWB:TRIGger:SEQuence AAUT
SOURce1:BB:HUWB:TRIGger:SOURce EGT
SOURce1:BB:HUWB:TRIGger:EXTernal:SYNChronize:OUTPut 1
SOURce1:BB:HUWB:TRIGger:EXTernal:INHibit 100
SOURce1:BB:HUWB:TRIGger:DELay:UNIT SAMP
SOURce1:BB:HUWB:TRIGger:EXTernal:DELay 10
SOURce1:BB:HUWB:TRIGger:EXTernal:RDELay?
// Response: 0.00000065
SOURce1:BB:HUWB:TRIGger:DELay:UNIT TIME
SOURce1:BB:HUWB:TRIGger:EXTernal:TDELay 0.00001
SOURce1:BB:HUWB:TRIGger:EXTernal:RDELay?
// Response: 0.00001
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Example: To configure an internal trigger
// ******************************************************************
// Configure trigger in single mode. Set trigger source to internal,
// signal duration unit and duration.
// ******************************************************************
SOURce1:BB:HUWB:TRIGger:SEQuence SING
SOURce1:BB:HUWB:TRIGger:SOURce INT
SOURce1:BB:HUWB:TRIGger:SLUNit SEQ
SOURce1:BB:HUWB:TRIGger:SLUNit FRAMe
SOURce1:BB:HUWB:TRIGger:SLENgth 2
// ******************************************************************
// Alternatively, configure trigger in armed retrigger mode. Set
// trigger source to internal.
// Enable Bluetooth, start the trigger - signal generation starts.
// Stop signal generation and wait for a trigger event to restart
// signal generation.
// Query the current trigger signal generation status.
// ******************************************************************
SOURce1:BB:HUWB:TRIGger:SEQuence ARETrigger
SOURce1:BB:HUWB:TRIGger:SOURce INT
SOURce1:BB:HUWB:STATe 1
SOURce1:BB:HUWB:TRIGger:EXEcute
SOURce1:BB:HUWB:TRIGger:ARM:EXECute
// Trigger event restarts signal generation.
SOURce1:BB:HUWB:TRIGger:RMODe?
// Response: 1
// Trigger is running.
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[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:ARM:EXECute

Stops signal generation; a subsequent trigger event restarts signal generation.

Example: See Example "To configure an internal trigger" on page 159.

Usage: Event

Manual operation: See "Arm" on page 96

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:DELay:UNIT <TrigDelUnit>

Sets the units in that the trigger delay is expressed.

Parameters:
<TrigDelUnit> SAMPle | TIME

*RST: SAMPle

Example: See Example "To configure an external trigger" on page 158.

Manual operation: See "(External) Delay Unit" on page 98

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:TIME[:STATe] <State>

Activates time-based triggering with a fixed time reference. If activated, the
R&S SMM100A triggers signal generation when its operating system time matches a
specified time.

Specify the trigger date and trigger time with the following commands:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME:DATE
SOURce<hw>:BB:<DigStd>:TRIGger:TIME:TIME
<DigStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See example "Configure a time-based trigger signal" in the sub-
chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMM100A user manual.

Manual operation: See "Time Based Trigger" on page 95

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:TIME:DATE <Year>, <Month>,
<Day>

Sets the date for a time-based trigger signal. For trigger modes single or armed auto,
you can activate triggering at this date via the following command:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME:STATe
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<DigStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Year> integer

Range: 1980  to  9999

<Month> integer
Range: 1  to  12

<Day> integer
Range: 1  to  31

Example: See example "Configure a time-based trigger signal" in the sub-
chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMM100A user manual.

Manual operation: See "Trigger Time" on page 95

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:TIME:TIME <Hour>, <Minute>,
<Second>

Sets the time for a time-based trigger signal. For trigger modes single or armed auto,
you can activate triggering at this time via the following command:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME:STATe
<DigStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Hour> integer

Range: 0  to  23

<Minute> integer
Range: 0  to  59

<Second> integer
Range: 0  to  59

Example: See example "Configure a time-based trigger signal" in the sub-
chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMM100A user manual.

Manual operation: See "Trigger Time" on page 95

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:EXECute

Executes a trigger.

Example: See Example "To configure an internal trigger" on page 159.

Usage: Event

Manual operation: See "Execute Trigger" on page 96
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[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:EXTernal:RDELay?

Queries the time (in seconds) of an external trigger event is delayed for.

Return values: 
<ResExtDelaySec> float

Range: 0  to  688
Increment: 250E-12
*RST: 0

Example: See Example "To configure an external trigger" on page 158.

Usage: Query only

Manual operation: See "Actual Trigger Delay/Actual External Delay" on page 98

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:EXTernal:TDELay <TrigExtTimeDel>

Specifies the trigger delay for external triggering. The value affects all external trigger
signals.

Parameters:
<TrigExtTimeDel> float

Range: 0  to  688
Increment: 250E-12
*RST: 0

Example: See Example "To configure an external trigger" on page 158.

Manual operation: See "(Specified) External Delay/(Specified) Trigger Delay"
on page 98

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OBASeband:DELay <Delay>

Specifies the trigger delay (expressed as number of samples) for triggering by the trig-
ger signal from the other path (two-path instruments only).

Parameters:
<Delay> float

Range: 0  to  2147483647
Increment: 0.01
*RST: 0

Example: See Example "To configure an internal trigger" on page 159.

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OBASeband:INHibit <Inhibit>

For triggering via the other path, specifies the number of samples by which a restart is
inhibited.

Trigger commands



Remote control commandsR&S®SMM-K149/-K180/-K181/-K182

163User Manual 1179.2083.02 ─ 11

Parameters:
<Inhibit> integer

Range: 0  to  67108863
*RST: 0

Example: See Example "To configure an internal trigger" on page 159.

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OBASeband:RDELay?

Queries the actual trigger delay (expressed in time units) of the trigger signal from the
second path.

Return values: 
<IntOthRDelaySec> float

Range: 0  to  688
Increment: 250E-12
*RST: 0

Example: See Example "To configure an external trigger" on page 158.

Usage: Query only

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OBASeband:TDELay
<IntOthDelaySec>

Specifies the trigger delay (expressed in time units) for triggering by the trigger signal
from the other path.

Parameters:
<IntOthDelaySec> float

Range: 0  to  688
Increment: 250E-12
*RST: 0

Example: See Example "To configure an internal trigger" on page 159.

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:RMODe?

Queries the signal generation status.

Return values: 
<RMode> STOP | RUN

*RST: STOP

Example: See Example "To configure an internal trigger" on page 159.

Usage: Query only

Manual operation: See "Running/Stopped" on page 96
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[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:SLENgth <SLength>

Defines the length of the signal sequence that is output in the SINGle trigger mode.

Parameters:
<SLength> integer

Range: 1  to  dynamic
*RST: 1

Example: See Example "To configure an internal trigger" on page 159.

Manual operation: See "Signal Duration" on page 96

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:SLUNit <SLUnit>

Defines the unit for the entry of the signal sequence length.

Parameters:
<SLUnit> SEQuence | SAMPle

*RST: SEQ

Example: See Example "To configure an external trigger" on page 158.

Example: See Example "To configure an internal trigger" on page 159.

Manual operation: See "Signal Duration Unit" on page 96

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:SOURce <Source>

Selects the trigger signal source and determines the way the triggering is executed.
Provided are the following trigger sources:
● INTernal: Internal manual triggering of the instrument
● External trigger signal via one of the local or global connectors:

– EGT1|EGT2: External global trigger
– EGC1|EGC2: External global clock

● For secondary instruments (SCONfiguration:MULTiinstrument:MODE SEC),
triggering via the external baseband synchronization signal of the primary instru-
ment:
SOURce1:BB:ARB:TRIGger:SOURce BBSY

● OBASeband|BEXTernal|EXTernal: Setting only
Provided only for backward compatibility with other Rohde & Schwarz signal gener-
ators. The R&S SMM100A accepts these values and maps them automatically as
follows:
OBASeband = INTA, BEXTernal = EGT2, EXTernal = EGT1

Parameters:
<Source> INTernal|EGT1|EGT2|EGC1|EGC2|EXTernal|BBSY

*RST: INTernal

Example: See Example "To configure an external trigger" on page 158.
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Example: See Example "To configure an internal trigger" on page 159.

Manual operation: See "Trigger Source" on page 96

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger[:EXTernal]:DELay <Delay>

Sets the trigger delay.

Parameters:
<Delay> float

Range: 0  to  2147483647
Increment: 0.01
*RST: 0

Example: See Example "To configure an external trigger" on page 158.

Manual operation: See "(Specified) External Delay/(Specified) Trigger Delay"
on page 98

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger[:EXTernal]:INHibit <Inhibit>

Specifies the number of symbols by which a restart is inhibited.

Parameters:
<Inhibit> integer

Range: 0  to  21.47*symbRate
*RST: 0

Example: See Example "To configure an external trigger" on page 158.

Manual operation: See "External / Trigger Inhibit" on page 98

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger[:EXTernal]:SYNC:OUTPut <Output>

Enables signal output synchronous to the trigger event.

Parameters:
<Output> 1 | ON | 0 | OFF

*RST: 1

Example: See Example "To configure an external trigger" on page 158.

Manual operation: See "Sync. Output to External Trigger/Sync. Output to Trigger"
on page 97

[:SOURce<hw>]:BB:LRWPan|HUWB[:TRIGger]:SEQuence <Sequence>

Selects the trigger mode:
● AUTO = auto
● RETRigger = retrigger
● AAUTo = armed auto
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● ARETrigger = armed retrigger
● SINGle = single

Parameters:
<Sequence> AUTO | RETRigger | AAUTo | ARETrigger | SINGle

*RST: AUTO

Example: See Example "To configure an external trigger" on page 158.

Example: See Example "To configure an internal trigger" on page 159.

Manual operation: See "Trigger Mode" on page 95

7.8  Marker commands

Example: To configure and enable standard marker signals
// Configure marker 1 settings.
SOURce1:BB:HUWB:TRIGger:OUTPut1:MODE REST
SOURce1:BB:HUWB:TRIGger:OUTPut1:ROFFset 1
SOURce1:BB:HUWB:TRIGger:OUTPut1:FOFFset 1
SOURce1:BB:HUWB:TRIGger:OUTPut1:DELay 10
SOURce1:BB:HUWB:STATe 1

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OUTPut<ch>:MODE................................... 166
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OUTPut<ch>:DELay................................... 166
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OUTPut<ch>:ROFFset................................167
[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OUTPut<ch>:FOFFset................................ 167

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OUTPut<ch>:MODE <Mode>

Defines the signal for the selected marker output.

Parameters:
<Mode> RESTart

*RST: RESTart

Example: See Example "To configure and enable standard marker signals"
on page 166.

Manual operation: See "Marker Mode" on page 99

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OUTPut<ch>:DELay <Delay>

Defines the delay between the signal on the marker outputs and the start of the sig-
nals.
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Parameters:
<Delay> float

Range: 0  to  16777215
Increment: 1E-3
*RST: 0

Example: See Example "To configure and enable standard marker signals"
on page 166.

Manual operation: See "Marker x Delay" on page 100

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OUTPut<ch>:ROFFset
<MarkRiseOffs>

[:SOURce<hw>]:BB:LRWPan|HUWB:TRIGger:OUTPut<ch>:FOFFset
<MarkFallOffs>

Sets the rise/fall offset.

Parameters:
<MarkFallOffs> integer

Range: -640000  to  640000
*RST: 0

Example: See Example "To configure and enable standard marker signals"
on page 166.

Manual operation: See "Rise/Fall Offset" on page 100

7.9  Clock commands

Example: To configure clock settings
SOURce1:BB:HUWB:CLOCk:SOURce?
// Response: INT

SOURce1:BB:HUWB:CLOCk:SOURce EXT
SOURce1:BB:HUWB:CLOCk:MODE SAMP
CLOCk:INPUt:FREQuency?
// Response in Hz: 1000000

[:SOURce<hw>]:BB:LRWPan|HUWB:CLOCk:MODE.........................................................167
[:SOURce<hw>]:BB:LRWPan|HUWB:CLOCk:SOURce......................................................168

[:SOURce<hw>]:BB:LRWPan|HUWB:CLOCk:MODE <Mode>

Sets the type of externally supplied clock.

Parameters:
<Mode> SAMPle | MSAMple | CSAMple

*RST: SAMPle

Clock commands
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Example: See Example "To configure clock settings" on page 167.

Manual operation: See "Clock Mode" on page 101

[:SOURce<hw>]:BB:LRWPan|HUWB:CLOCk:SOURce <Source>

Selects the clock source:
● INTernal: Internal clock reference
● ELCLock: External local clock
● EXTernal = ELCLock: Setting only

Provided for backward compatibility with other Rohde & Schwarz signal generators

Parameters:
<Source> INTernal

*RST: INTernal

Example: See Example "To configure clock settings" on page 167.

Manual operation: See "Clock Source" on page 101

Clock commands
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Glossary: Specifications and references
I

IEEE Std 802.15.4™-2020: IEEE Standard for Low‐Rate Wireless Networks

IEEE Std 802.15.4z™‐2020: IEEE Standard for Low‐Rate Wireless Networks
Amendment 1: Enhanced Ultra Wideband (UWB) Physical Layers (PHYs) and Associ-
ated Ranging Techniques

P
P802.15.4™ab/D02: Draft Standard for Low‐Rate Wireless Networks
Amendment 1: Enhanced Ultra Wideband (UWB) Physical Layers (PHYs) and Associ-
ated Medium Access and Control (MAC) Sublayer Enhancements
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